The ICR
SmartActuator which
uses this software is
a DISCONTINUED
Tolomatic Product.
This manual is
made available for
use with legacy ICR.

CME 2 User Guide

Copley
@mntrols
Corp.

P/N 95-00454-000



CME 2 User Guide



TABLE OF CONTENTS

ADOUL THIS IMANUAL ......eeeeeeeeeinssasesasasasnsssasnsssnsasssssssssnsssssssssssssnsssssssssssssssssnsssssssnsssssnssnssnnssnsssnsnsssnnssnsssnssssnnnsnnssnssnnsnnsnnnnnnnnnne 5

1:

10:

11:

12:

13:
14:

Introduction .........ccccceviiiiiiinnnnns w7
1.1: Host Computer Requirements ........... ...8
1.2: Amplifier Commissioning Software ........... .10
1.3: Servo Operating Modes and CONIOI LOOPS ......ceiiaiiiiiiiiiiae ettt e e e e ettt ee e e e e e bte et e e e e e s aebeeeaeaeaansbeeeeeaeaannsseeeaeaaaansneeeeaeeaannes 11
Installation, Startup, and INterface TOU ...t e s sssr e s s s s s sner e e s se s s s snn e e e eesasssannneessassssnnneenessnssnnnnnnns 13
2.1: Install CME 2 Software .
2.2: SHArT CIME 2 SOFIWAIE ...ttt oottt e e e ook h ettt e e e e e bt et eeee e e e aasbeeeeee e e e nneseeeaaaeansbeeeeaeeaannsseeaaaaeannnseeeeassennsban
2.3: Configure Serial POrt PArameEters ..........oouuiiiiiiiiiiiii ettt e h et et e et ettt e e at e T
2.4: Configure CAN Network Parameters .
2.5: Connect to an Amplifier in CME 2...... .
2.6: RENAME @N AMIPITIEI ..ttt ettt e e e e ettt et e e e e s aasbeeeeeeeaanntneeaaaeasansneneeaesasannsnneessessfTnes aieeeannnnes
2.7: CME 2 INTEITACE TOU ..ttt e ettt e et e e st e e et e e e sbteesasteeeannneeesneeesnnneee e e £ B e s ritee e
Ampilifier Setup Procedure.. .
3.1: Warnings @nd NOLES ........ueiiiiii et e ettt e e e e e s ate et e e e e e esnnneeeeaeesaannssseaasssannnnsneeeesssneddohees Henunreeeeaeeaanneeeeas
IS T (N o 3N Yo=Y U - SR SUSPURRR
Basic Setup........cceceeueeenniinnns .
4.1: Change Basic Setup Settings
4.2: Motor Options..............
4.3: Feedback Options ..........
4.4: Operating Mode Options. .
4.5: MiSCElIaNEOUS OPHIONS. ...ciiiiiiitiiiiie et e ettt e e e et ee e e e e s sineeeeaeeessnsnseeeeeesannnses ShressPausseeeeasesannseeeeaeeaaanneseeeaaaeaannneneaaaeann
B TS T Yo X U oY= T =T (1] o SRR
Motor/Feedback.........c.cccoeeeiuerrniiiiinnns .
5.1: Motor/Feedback Screen Overview
5.2: Load Motor/Feedback/Brake Settings from a File.....
5.3: Rotary Motor Setup Parameters ............c.ccoooiieeenn.
5.4: Linear Motor Setup Parameters .
5.5: Feedback Parameters, ROAry ............ooooiiiiiiiiieiiiiereeeniee i sttt ettt e e e ettt e e e e e e nnbee e e e e e eannnes
5.6: Feedback Parameters, LINEar..........oouiii i e ifmme e sn B 0Tttt ettt ettt e ettt et e e et e e e nbe e e
5.7: Feedback Notes ..........c.cccc....
5.8: Brake/Stop Parameters ..
5.9: Brake/Stop Notes ...........
5.10: The Calculate Function.
Digital Inputs and Outputs.. .
6.1: DiIgital INPULS.....cooeiiiiie e e 02T ettt e e ettt e e e et e e e e e e e nnbe e e e e e e eaane
6.2: DIgital OULPULS .....oouiiiiiiiiieiiiiee e o0 e ettt bt e sttt e st e e bttt e et e e nab e e e s nee e e aanns
6.3: Synchronizing PWM Switching Frequency ... .
(o741 0 F= T T I 14 o 10 PP
7.1: ANAlog COMMEANG SEINGS ....eentieei i et e ettt ettt ettt et e e a et e e bt e e ea b et e e oa bt e e o b bt e e ea b e e e e ea b et e eas bt e e aabe e e e enbe e e sbbeeeanteeens
7.2: PWM Input Settings............... .
7.3: Digital Position Input Settings
CAN Network Configuration .....

9.1: Fault Configuration Parameters ...x, .
LI - T | I (ot g g T T A0 (T PPV PPPP
9.3: Position and VeloCity, EITOrINOIES ..ottt st e e e e e e e e eaee e e
Motor Phasing .......5 0 e e e

10.1: Phase Motor with Auto.Rhase
10.2: Guidelines for Choosing Auto Phase Current and Increment Rate Values................coiiiiiiiiiiiiiiic e 84
10.3: Trouble/Shoot the Auto Phase ProCess............ccovovveiiiicieeieciiiece e

10.4: Phase Motor Manually .............ccccoeeiiiiiiniiiiiiieee,
10.5: Trouble Shoot Manual Phase w/ Encoder and Halls ..
(0o 1011 o] B I o T o o = N
11{1*Currentlloop Setup and Tuning.... .
TA32: CUITENE LOOP AULO TUNE «...eiiiiiie e ettt ee e ettt e e e e e ettt e e e e sttt e e e e e s e seaeeeeaeeeassseaeeaeeeasnsssaeeeeee s sssesseaeeaanssnseeeeeesnnssanenaeenannnes
11.3:.Notes on the Current Mode and CUITENE LOOP ........oiiiiiiiiiiie ettt et e st e st e e
11.4: Velocity Loop Setup and Tuning ..........ccccceeenee.
11.5: Notes on the Velocity Mode and Velocity Loop...
11.6: Position Loop Setup and Tuning..........cccceeenneee.
11.7: Notes on the Position Mode and Position Loop...
11.8: Auto Tune all Loops for Linear Motors ................ .
E53 =T o o =T 0 11 L=
L2 S G- o] o 1= T 1Y o] (o GRS ¥ o] o Lo o (TP EPOT PRSP
12.2: Position Limits (Stepper Amplifier)...
12.3: Encoder Correction.............ccceeeueeee.
12.4: Detent Compensation Gain..

14.1: Control Panel Overview ....

Copley Controls Corp. 3



Table of Contents CME 2 User Guide

15:

16:

me W23

14.2: Status INAICAtOrs @Nd IMESSAGES ........uuiiiiiiiiiiiiiiae ettt e e e e e e ettt e e e e e aeeeeeaa e e e st beeeeae e e e nsbaeeeaeaeaannsbeeeaeeaaannesseeaeeeaannnneeaaeaaan 124
14.3: Control Panel MoNItOr CRANNELS ..........o.iiiiiiiiiiie et e et e e e e st e e e e e e st aeeeaeesanstaaaaeeaesassseeaeaeesasssssaeeeeeannssnnenaeenas 125
T4.4: CONLIOL FUNCHIONS ...ttt s nan 126
LT Lo To 1Y oo [PPSR UPRPTRPPPPN 127
15T 07 o 1= I e Yo ) 129
15.71: SCOPE TOOI OVEIVIEW........nieieeiiiee ettt ee e e ettt e e oottt et e e e e e e e bee e e e e e e e naeeeeeaa e e e nebee e e e e a2 annnbe e e e e e e e e nnbeeeeaeeeaannssseeaeeeaannnnneaaaeaan 130
15.2: Function Generator and Profile TabS ........couuiiiiii ettt e e e e s e e e e e e s s eaeeessntaaeeeeeeennnnaneeaeeeas 131

15.3: Trace Channel Variable ParameEters...... ... .uiiiiiiiiiie ettt e e e ettt e e e e e e nbb e e e e e e e s e nneeeeeaeeeaannnneeaaeeaas 132
LS T I e T T RS 1T (1 o PSR TPRPTRPPPPN 133
15.5: Trace Time, Sample Rate and SiNGIE TraCe .......ccouiuiiiiiii ettt e et e e e e e s e e e e e e e e snsneeeeaeeeannnneeeeeeeid 134
15.6: SCOPE DiSPIay PAr@MELETS .........eiiiiiiiiiiiiie ettt oot e bttt e sttt e e h bt e e sb et e e aabe e e e ab e e e nbe e e e ante e e pane 134
ST A XU (o3RS = U] o PO SSUPTOURTRPSRPPIN S 135
15.8: MEASUIEMENT TAD ....iiiiiiiiiiiiiie ettt e e e e ettt e e e e e e ettt e e e e e e s nntsaeaeaeesnsssseaeaeesannsssneaeesssasnssnenaeesannnsnseeeesssnnsfedie iFannn 136
15.9: Control Loop Parameters in SCOPE TFACES ......ccciuiiiiiiuiieeiiiieiiiee et e e eitee e et eeeeteeesenseaeaneeeeaanneeesnnseeeaneeeesnneeessahe NaTaeeeanns 137
15102 SCOPE FilES....eeeeeie ettt e et e bttt e st et e e e ab et e e bttt e s be e e e ean et e nnee e e enteee e s Ty e et e e ene 139

Data, FIrmware, and LOGS .......cccuiuueiiiriiiissinssinssssssss s snsssssss s s sa s sss e s s sassna s s sass s smnssasssassssnnnnsssssnsssnnnssnasbntfonnnnnnnssnnsnnns 141
16.1: Amplifier RAM and FIash MEMOTY .......ooiiiiiiiiiiie ettt e e e e e e e s sneeeeeae e e ssnnneeees sfhan s e e e e e e e enbeeeeaeeeas 142
16.2: Disk Storage of Amplifier and Motor Data Files .............ooiiiiiiiiiiiiiie e e et
16.3: Data Management TOOIS ..........ccooiiiieeieeriniiiieeneenn.

16.4: Amplifier Firmware
16.5: Error LOg .....cceveeeeiiiiieeenennn.
16.6: Communications Log....
Virtual Amplifier...................
Copy Amplifier Data...
Lock/Unlock CME 2 Controls.

12T Time Limit Algorithm ...........

C1 T AIGOMIIAM ... eeee s seeee e seen s sesesee s sheseDone et e s ee s s eee s e s s e eeneenesean
VeloCity LOOP Filters .......coiiiiiiiiiiiiiiniss s s s s s e e e e s e nn e
Homing Methods..........c..cccueenneee

E.1: Homing Methods Overview

E.2: Legend to Homing Method DeSCrIPtONS.......coooiuiiiireiiiiiiieeeee e ittt e e e e e e e e e e e e e nnee s 164
E.3: Homing Method DESCIIPIONS .....cccuuviiiiiiiiiiiei it afnmr e ns B« S0ttt ettt e ettt e et e e bt e e anb et e et e e nnb e e e aneeee s 165
Regen Resistor Configuration ... i e s b b rssnr s s ann e e aan e e 179
ASCIl Commands/Serial CoONtrol ... e e s s s 183
G.1: COPIEY ASCI INTEITACE ...coii i I T ettt e e e ettt e e e e e s aa et e e e e e e s nnteeeaaeeaansbeeeaaeeaannnes 184
G.2:  CME 2 ASCIl Command Line Interface Tool ........¢0 T e b s e 184
G.3:  Single-Axis Serial CONNECHON ......oooiiiiiiee e S i e et e e e et e e e e e e 185
G.4:  Multi-Drop Serial CONNECON .......cviiiiieieiee e e e T ettt ettt e e e ettt e e e e e e st eeeeeeeeesassaaeeeaeesasntaeeaeeaesasssseeeaeesannes 185
(=TT RS Lo 3 1= LT o ' N 187
H.1: Configure Gain SChEAUING ......coooiiii e he e ettt oottt e e e ettt e e e e e e bttt e e e e e e e nbeeeeeaaeaaanbteeeaeeaaaneneeeaaaeaannnneeeas 188
H2: Set Up the Gain Scheduling Table(S) .t . e o ettt ettt et e bt e e aabe e e e ebe e e sbreeeanens 189
H.3:  Gain Scheduling Table GUIAEIINES 5. k..o e ettt ettt e ettt e e e e e e aab e e e e e e e e nee e e e e e e e aannbeeeeaaeeaasnneeeaaeeaannnreeeas 193

Copley Controls Corp.



ABOUT THIS MANUAL

Overview and Scope

This manual describes the installation and use of Copley Controls Corporation’s CME 2
software.

Related Documentation
CANopen-related documents:

e CANopen Programmer’s Manual

e CML Reference Manual

e Copley Motion Objects Programmer’s Guide
DeviceNet-related:

o Copley DeviceNet Programmer’s Guide
Also of related interest:

e Copley Indexer 2 Program User Guide (describes use-of Indexer 2 Program to create
motion control sequences)

o Copley ASCII Interface Programmer’s Guide (describes how to send ASCII format
commands over an RS232 serial bus to control one or more amplifiers)

e Copley Camming User Guide (describes.the use of the Copley Controls Camming
feature, and its setup through CME 2)

Links to these publications, along with hardware manuals and data sheets, can be found
under the Documents heading at:
http://www.copleycontrols.com/Motion/Downloads/index.html

Copley Controls software and related information can be found at:
http://www.copleycontrols.com/Motion/Products/Software/index.html

Comments

Copley Controls Corporation‘'welcomes your comments on this manual. See
http://www.copleyeentrols;com for contact information.

Copyrights

No part of this document may be reproduced in any form or by any means, electronic or
mechanical, including photocopying, without express written permission of Copley
Controls Corporation.

Xenus, Accelnet, Stepnet, Accelus, and Junus are registered trademarks of Copley
Controls-Corporation.

CME'2 is a registered trademark of Copley Controls Corporation.

Windows NT, 2000, XP, and Vista are trademarks or registered trademarks of the
Microsoft Corporation.

Document Validity

We reserve the right to modify our products. The information in this document is subject
to change without notice and does not represent a commitment by Copley Controls
Corporation. Copley Controls Corporation assumes no responsibility for any errors that
may appear in this document.

Copley Controls Corp. 5



About this Manual

CME 2 User Guide

1.1.1: Product Warnings

Observe all relevant state, regional, and local safety regulations when installing and using
Copley Controls amplifiers. For safety and to assure compliance with documented system
data, only Copley Controls Corporation should perform repairs to amplifiers.

DANGER

Hazardous voltages.

Exercise caution when installing and adjusting Copley amplifiers.

Risk of electric shock.

On some Copley Controls amplifiers, high-voltage circuits are connected to mains
power. Refer to hardware documentation.

Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifierre=enables the PWM
output stage without operator intervention. In this case, motion may re-start
unexpectedly. Configure faults as latched unless a specific situation calls for non-
latched behavior. When using non-latched faults, be sure,to safeguard against
unexpected motion.

Latching an output does not eliminate the risk-of unexpected motion with non-
latched faults.

Associating a fault with a latched, custom=configured output does not latch the fault
itself. After the cause of a non-latched-fault is\Corrected, the amplifier re-enables
without operator intervention. In this.case, motion may re-start unexpectedly.

For more information, see Faulfs'(p. 69):
When operating the amplifier as a.CAN or DeviceNet node, the use of CME 2 or

ASCI| serial commands may affect operations in progress. Using such commands to
initiate motion may cause network operations to suspend.

Operation may restart unexpectedly when the commanded motion is stopped.
Use equipment as-described.

Operate amplifiers within the specifications provided in the relevant hardware manual
or data sheet:

FAILURE.TO HEED THESE WARNINGS CAN CAUSE EQUIPMENT DAMAGE,
INJURY; OR DEATH.

1.1.2: Revision History

Revision | Date DECO # | Applies to Comments
1 February CME 2 Software version 4.1. Initial publication. Adapted from
2006 Firmware version 4.66 or higher. Xenus User’s Guide v2.0.
2 August 2006 CME 2 Software version 4.2. Various changes.
Firmware version 5.04 or higher.

3 June 2007 15383 CME 2 Software version 5.0. Changes include the new feature
Auto Tune all Loops for Linear Motors
(p. 111), a new way to Change Basic
Setup Settings (p. 32), and a
modified Control Panel (p. 123).

4 June 2008 16709 CME 2 Software version 5.1. Changes include the new scope tool
Measurement Tab (p. 136), Gain
Scheduling (p. 187), and Velocity
Gains Shift (p. 103).

6 Copley Controls Corp.




CHAPTER

1: INTRODUCTION

This chapter describes the basic functions and operational theory of CME 2. Topics
include:

v’ Host Computer Requirements (p. 8).
v Amplifier Commissioning Software (p. 10).

v’ Servo Operating Modes and Control Loops (p. 11).

Copley Controls Corp. 7



Introduction CME 2 User Guide

1.1:
1.1.1;

1.1.2:

1.1.3:

Host Computer Requirements
Computer and Operating System

Minimal hardware requirements:
e CPU: 400 MHZ.

¢ RAM: 128 MB.

Operating Systems Supported: Windows NT, 2000, XP.
Vista users see Special Notes for Vista Users (p. 8).
Special Notes for Vista Users

Windows Vista is supported in this version of CME 2.

Note that when the installer starts, a message will be displayed statingdthat an unidentified
program is trying to access the computer. Click the button to allow the installer to
continue, and CME 2 will be installed properly.

On previous versions of Windows, the user data for CME 2 (like'ccx, ccm, files, etc.) were
stored in C:\Program Files\Copley Motion\CME 2. Because:of Windows Vista security,
the CME 2 user files are stored on Vista systems in C:\Users\Public\Public
Documents\Copley Motion\CME 2.

Software

Copley Controls CME 2 software, Version 5.1 or’ higher.

Copley Controls Corp.



CME 2 User Guide Introduction

1.1.4: Amplifier Support and Firmware Requirements
Firmware requirements are described below:

Amplifier Model Recommended Minimum Firmware
Version
ACK/R23
ACM/R22
5.46*
ACJ(S)

Accelnet | R21(S)
Series ACP

AMP
AEP 1.36
ADP / R20
XSL(R) 5.46*
Xenus XTL(R/S)
) 1.36
Series R11(R/S)
XSJ(R/S)
STL
Stepnet 5.46*
) STM
Series
STP
Accel ASC 3.50
ccelus ASP .
Junus | JSP | 3.54
Notes:

* Accelnet_X.XX.cff or Devicenet X.XX.cff firmware files are common and can be used
with any drive in this family.
1.1.5: Serial Communications
For each PC-tozamplifier connection via serial port:
e One standard RS-232 serial port.
¢ Onefserial communication cable. See amplifier data sheet for part numbers.
1.1.6: CAN\,Communications

(Xenus{ Accelnet, and Stepnet only.)

e .One Copley Controls CAN PCI network card (part number CAN-PCI-02).
CME 2 also supports CAN network cards made by these manufacturers: KVaser,
Vector, and National Instruments.

¢ One PC-to-amplifier CANopen network cable. See amplifier data sheet for part
numbers.

See the amplifier data sheet for CAN network wiring instructions.

Copley Controls Corp. 9
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1.2: Amplifier Commissioning Software

10

Copley Controls CME 2 software allows fast and easy commissioning of Copley Controls
amplifiers. It provides access to all amplifier configuration controls. It supports all Copley
Controls amplifiers, including Copley’s CANopen amplifier lines and stepper amplifiers.

CME 2 communicates with amplifiers via RS-232 or CAN connections. On Xenus,
Accelnet, and Stepnet amplifiers, the multi-drop feature allows CME 2 to use a single RS-
232 serial connection to one amplifier as a gateway to other amplifiers linked together by
CAN bus or DeviceNet connections.

Motor data can be saved as .ccm files. Amplifier data is saved as .ccx files that.contain all
amplifier settings plus motor data. This makes it possible to quickly set up amplifiers by
copying configurations from one amplifier to another.

CME 2 also provides access to Copley Virtual Machine (CVM), a program that is set up in
CME 2 and downloaded to the amplifier to provide on-board control."When a CVM
program is running, the amplifier receives its input commands frem.the CVM program. For
more information, see the Copley Indexer 2 Program User’s Guide.

NOTE: The feature descriptions in this manual may not apply to all Copley Controls
amplifiers under all configurations. Significant differences.between amplifier models are
noted. See the relevant hardware manual or data sheet,for more information.

Copley Controls Corp.
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1.3: Servo Operating Modes and Control Loops

Target
Position

Copley Controls amplifiers use up to three nested control loops - current, velocity, and
position - to control a motor in three associated operating modes. (Stepper amplifiers
operated in stepper mode function as traditional open position loop stepper drives.)

Control Loops Model

In position mode, the amplifier uses all three loops. As shown in the typical system
illustrated below, the position loop drives the nested velocity loop, which drives the nested
current loop.

Limits
Position Velocity Limited Current Limited PWM
v Command Command Velocity Command ¢ Current Command
Trajectory . Position ' Vglqcity ' ;E Velocity E; ' Ct.Jrr.ent : Current ' Motor/
Generator Loop Limiter @ . Loop @ Limiter Loop Sensors
’_A:tual Position ’_;erived Velocity ’_:\ctual Current

In velocity mode, the velocity loop drives the currentlooep. In current mode, the current
loop is driven directly by external or internal current commands.

Basic Attributes of All Servo Control Loops
These loops share several common attributes:

Loop Description

Attribute

Command Every loop is given a valueto whichyit-will attempt to control. For example, the velocity loop
input receives a velocity command that'is'the desired motor speed.

Limits Limits are set on each-loop to protect the motor and/or mechanical system.

Feedback The nature of servo'controtloops is that they receive feedback from the device they are
controlling. Forexample; the position loop uses the actual motor position as feedback.

Gains These are constantwalues that are used in the mathematical equation of the servo loop. The
values of'these_.dains can be adjusted during amplifier setup to improve the loop
performance.’Adjusting these values is often referred to as tuning the loop.

Output The loop generates a control signal. This signal can be used as the command signal to
another control loop or the input to a power amplifier.

For moreTinformation on using CME 2 to set up and tune control loops, see
ControhLoops-(p. 91).

Copley Controls Corp. 11
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CHAPTER

2. INSTALLATION, STARTUP, AND
INTERFACE TOUR

This chapter shows how to install, start, and set up communications for CME 2.:Perform
the steps outlined below. Details follow in the chapter.

1 Verify that the system on which you will install CME 2 meets the
Host Computer Requirements (p. 8).
NOTE: Vista users see Special Notes for Vista Users (p. 8).

2 Install CME 2 Software (p. 14).

Start CME 2 (p. 15).

Configure Serial Port Parameters (p. 16) or Configure CAN Network Parameters (p. 18).

(To set up for DeviceNet control, see the Copley Controls Copley DeviceNet
Programmer’s Guide.)

The chapter also includes CME 2 Interface Tour (p. 20) and describes how to Connect to
an Amplifier in CME 2 (p. 19) and-Rename an Amplifier (p. 19).

Copley Controls Corp. 13
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2.1: Install CME 2 Software

Optionally download software from the Web

1 Choose or create a folder where you will download the software installation file.

2 In aninternet browser, navigate to:
http://www.copleycontrols.com/Motion/Downloads/index.html

Under Software Releases, click on CME 2.

4 When prompted, save the CMEZ2.zip file to the folder chosen or created in'Step 1.
The folder should now contain a file named CMEZ2.zip.

5 Extract the contents of the zip file to the same location.
The folder should now contain the files CMEZ2.zip and Setup.exe.

6 If desired, delete CMEZ2.zip to save disk space.

Install CME 2 Software

1 If installing from a CD, insert the CD (Copley Controls part number CME2).
Normally, inserting the CD causes the installation-script to launch, and a CME 2
Installation screen appears. If so, skip to,Step 3.

2 |If the software installation file is on-a.hard drive, navigate to the folder and then double-
click on Setup.exe
OR
if you inserted the CD and the'CME 2 Installation screen did not appear, navigate to the
root directory of the installation CD and then double-click on Setup.exe.

3 Respond to the prompts on the CME 2 Installation screens to complete the installation.
We recommend accepting-all default installation values.
NOTE: Vista users se€ Special Notes for Vista Users (p. 8).

14 Copley Controls Corp.
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2.2: Start CME 2 Software

Double-click the CME 2 shortcut icon on the Windows desktop to start CME 2,

2 If communications were set up If communications were not set up..:
already...
...the CME 2 Main Screen opens. If there are ...see the screen below:

;netljletgileedpaosrtssﬁ g:;n%%%a Neighborhood root will be =

Select device: &

File amplifier Tools Help {*" Serial Ports

IJ_IE . m . g € CAN Metwork é

Select the desired amplifier. For instance: In this case, proceed to Configure Serial Port
~ - Parameters (p. 16) or Configure CAN Network
E_ 4 Copley Meighborha Paraméters (p. 18).
BB virtual Ampli

If the amplifier is to run under DeviceNet control,
select Serial Ports. For more information, see the
Copley DeviceNet Programmer’s Guide.

=B comg
s e

See Connect to an Amplifier (p. 19).

After an amplifier has been selected, the.CME 2 Main, Screen looks similar to this:
(XSL-230-40 Xenus 1) 10l x|

File F\mphﬁer Tools  Help

&7 & BB E lﬁ@@?ﬂ{ﬂ

B J Copley Neighborhood CP® ork ress: o State: Pre-operational
R = —- | V|rtuaIAran|f|er

n ;}a’{put

\@’M Contral Program I
L NN
P | |

-
CAN Configuration |—} F Loap I—’ W Loop I—} | Loop I—} hotonF eedback |

L
Home | Configure Regen | Configure Faults |

|5ine Commutation |R0tary IMotor |.0.m|:| Under CAM Control F1Z2 To Disable

If the Basic Setup options have not been chosen, the Basic Setup screen opens.

Copley Controls Corp. 15
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2.3: Configure Serial Port Parameters

One or more serial ports on a PC can be used to connect amplifiers. Use the following
instructions to add ports for amplifiers, to choose baud rates for those ports, and to
remove ports for amplifiers.

Also use this procedure if the amplifier is to run under DeviceNet control. For more
information, see the Copley Controls Copley DeviceNet Programmer’s Guide.

Double-click the CME 2 shortcut icon on the Windows desktop tosstart CME 2.

If a serial or CAN port has not been selected, the Communications Wizard Select device
screen appears.

E Communications Wiz x|

Select device:

=" Serial Ports
AN Netwark

Ced> Cancel |

2 If the CME 2 Main screen appears instead of Select Device,
choose Tools>Communications Wizard.

3 Choose Serial Ports and click Next to open'the Communications Wizard Select
Ports/Serial Ports screen.

@Enmmunicatinns Wizard 8 El

Select Ports

To add serial ports, select themfrom thestvailable Ports list, then press Add.

To remove serial ports,Eelect them frarm the Selected Ports list, then press Remaove.

Available Forts Selected Ports:

COhd4
COhdS

= Remaove |

= Back | [ et = | Cancel |

4 From the Available Ports list, choose the serial ports that will be used for amplifiers.

= To allow an amplifier to connect through a port, select the port name and click Add.
= To remove a port from Selected Ports, select the port name and click Remove.

Continued...
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...Configure Serial Port Parameters, continued:

5 Click Next to save the choices and open the Communications Wizard Configure Serial
Ports screen.

@ Communications Wizard 5'

Configure Serial Ports

Select one or mare serial ports from the list, then selectthe baud rate.

Selected Ports:

COMS
Baud Rate: |1152DD 'I

= Back | CFinish Cancel

6 Configure the desired ports.

= Highlight a port in the Selected Ports list:
= Choose a Baud Rate for that port.
= Repeat for each selected port.

7 Click Finish to save the choices.

Copley Controls Corp.
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2.4: Configure CAN Network Parameters

A CAN port can be used to connect the host PC to one or more amplifiers. Use the
following instructions to configure CAN network settings.

Double-click the CME 2 shortcut icon on the Windows desktop to start CME 2.

If communications have not been set up, the Communications Wizard Selectcdevice
screen appears.

Etommunications Wiza x|

Select device:
% Serial Ports
{7 Cab Metwork

Chests Cancel |

2 If the CME 2 Main screen appears choose Tools=>Communications Wizard.

3 Choose CAN Network.
x|

Select device:

" Serial Ports

4 Click Next to open the . Gommunications Wizard Configure CAN Network screen.
@Eummunicatinns Wizard ‘\7 il

Configure CAN Network

CAN Card: ICDpIey LI

_hannel: I 0
Bit Fake: Ileit,l's 'I

<pack | [ TEiEh cancel |

5 Choose the appropriate CAN Card, Channel, and Bit Rate, and click Finish.
NOTES:
1) The CAN Card list shows the manufacturer names of all supported CAN cards that
have been connected to the PC and for which drivers have been installed.
2) All amplifiers must be set to the same bit rate (default is 1 Mbit/s).

18 Copley Controls Corp.
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2.5: Connect to an Amplifier in CME 2

Choose an amplifier by clicking on its name in the Copley Neighborhood. The
neighborhood organizes amplifiers according to the connection method.

One amplifier: Multiple amplifiers on serial:

RACME 2 ¥3.1  (X5L-230-4 WG CME 2 ¥3.2 Beta 2 Engine

File  Amplifier Tools He

File  Amplifier Tools He

= .
A7 | | £ B [ Ay | | B8 B
:‘J Copley Heighbarhood l‘J Copley Heighborhoaod
- Virtual Amplifier BB vitual Amplifier
O W b enus o COME: X Axis

- COMS: Y Axis

L KPR COMS: T Asis

CAN network: Multi-drop: CAN ar DeviceNet:
S CME 2 ¥4.2 Beta 2 Engineering Release S CME 2 ¥4.0 (STP-075-07 ST
Eile  amplifier Tools Help File: .ﬁ.m [iFi r Tools  Help

&E OB e

EI—_J Copley Heighbarhood

v =B virtual Amplifier

BB comi: ACP
BB Hode 1: ACW
BB Hode 2: XEL1
L===WHode 2: STP
BB Hode 10: X512

When there is only one amplifier-available for connection, the software will connect
automatically on startup:

2.6: Rename an Amplifier

Each amplifierrepresented in the Copley Neighborhood amplifier tree has a name. The
default name for-amamplifier is unnamed. Use this procedure to rename an amplifier.

1 Choose Main Menu Amplifier>Rename to open the Rename Ampilifier screen.

Y x
y @

riker the new name!

oK | Cancel |

2 Enter the new name and click OK to close the screen.

Copley Controls Corp. 19
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2.7: CME 2 Interface Tour

CME 2 features are called out in the diagram below. Screen details vary depending on
amplifier model and mode selection. Details follow in the chapter.

Copley —P»
Neighborhood
Tree

Status g |sine Cammutation

Bar

CME 2 User Guide

A7 el 23 [V EE E] B | qafl < ol <

B cME 2 v5.0 {XSL-230-40 Xenus 1) N ] 4]
File Amplfier Tools Help <@ Main Menu
Tool Bar

[Z}-4 Copley Heighborhood
o BB irual Amplifier
[ - 115

CAN Mebwork:

Zenus 1

................ Address | 13 e hniSeriation

Input # Output |

CWhi Control Program I

— 1

1 ICAN orDeviceNet

&
o
&0\ i
E Functional
i Diagram

-~
aop I—} W Laop | Loop I?Mrﬁeedback |

F1Z To Disable

2.7.1: Tool Bar Overview
Click on any of the tools in the toolbat 1o access the tools described below.

Icon Name Description For More Information
ﬂ Basic Setup Opens Basic Setup screen. Basic Setup (p. 31)
e Control Panel Opens Control Panel. Control Panel (p. 123)
+#
:3 Auto Phase Opens Auto Phase tool. Motor Phasing (p. 75)
Auto.Tune Opens Auto Tune for Linear Auto Tune all Loops for
Servo Motors. Linear Motors (p. 111)
Scope Opens Scope. Scope Tool (p. 129)
Error Log Opens Error Log. Error Log (p. 146)

Amplifier Properties

Displays basic amplifier
properties.

Save amplifier data to disk

Saves contents of amplifier
RAM to a disk file.

Restore amplifier data from disk

Restores an amplifier file
from disk to amplifier RAM.

Save amplifier data to flash

Saves contents of amplifier
RAM to flash memory.

Restore amplifier data from flash

Restores contents of flash
memory to amplifier RAM.

Data, Firmware, and Logs
(p. 141)

20
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2.7.2: Main Menu Overview

Installation, Startup, and Interface Tour

The CME 2 Main Menu choices are described below.

Menu Selection Description For More Information
File Save Amplifier Saves contents of amplifier RAM Data, Firmware, and Logs (p. 141)
Data to a disk file.
Restore Amplifier Restores contents of an amplifier
Data file from disk to amplifier RAM.
Restore CVM Prompts for a Copley Virtual Copley Indexer 2 Program User
Control Program Machine program file. The Guide.
program in this file will replace
the current program in flash.
This procedure also results in the
setting of the Indexer 2 Program
option Enable Control Program
on Startup. This configures the
program to auto start when the
amplifier is powered up or reset.
Restore Cam Prompts for a saved Cam Table See Copley Camming Users
Tables file (.cct file). All tables in Guide.
amplifier flash will be replaced by
the ones in this file.
Exit Closes CME 2.
Amplifier | Basic Setup Opens Basic Setup 'screen: Basic Setup (p. 31)
Control Panel Opens Control Panel. Control Panel (p. 123)
Auto Phase Opens Auto'Phase tool. Motor Phasing (p. 75)
Scope Opens Scope. Scope Tool (p. 129)
Error Log Opens-Error-Log:. Error Log (p. 146)
Amplifier Displays-basic amplifier
Properties properties.
Network Opens the CAN or DeviceNet CAN: CAN Network Configuration
Configuration Configuration screen. (p. 67).
DeviceNet: Copley DeviceNet
Programmer’s Guide.
Rename Prompts for new amplifier name. Rename an Amplifier (p. 19)
Auto Tune Opens Auto Tune for Linear Servo | Auto Tune all Loops for Linear
Motors. Motors (p. 111)
Gain,Scheduling Opens Gain Scheduling screen. Gain Scheduling (p. 187).
Continued...

Copley Controls Corp.
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...Main Menu Choices, continued:

Menu Selection Description For More Information
Tools Communications Starts sequence of prompts to set | Configure Serial Port Parameters
Wizard up communications. (p. 16) and Configure CAN
Network Parameters (p. 18).
Communications Opens Communications Log. Communications Log (p. 147).
Log
Download Starts prompts to download Download Firmware to the
Firmware firmware from disk to amplifier. Amplifier (p. 144).
Download CPLD Starts prompts to download PLD
Program code from disk to amplifier.
Manual Phase Opens Manual Phase tool. Phase Motor Manually (p. 85).
View Scope Files Opens Trace Viewer window. Scope Files (p. 139).
I/O Line States Opens I/O Line States window, Digital Inputs and Outputs (p. 49).
showing high/low status of the
amplifier’s inputs and outputs.
CME 2 Opens screen for locking and Lock/Unlock CME 2 Controls
Lock/Unlock unlocking CME 2 functionality. (p. 1563).
ASCIl Command Opens screen to accept ASCII CME 2 ASCII Command Line
Line format commands. Interface Tool (p. 184).
Help CME 2 User Guide Opens this manual.
All Documents Opens the Doc folderin the’CME 2 installation folder
(typically c://Program Files/Copley Motion/CME 2/Doc).
This folder contains all'of the related documents that were installed with
CME 2.
Downloads Web Opens; default web browser with pages from Copley Controls’ website.
Page
Software Web
Page
View Release Opens latest CME 2 release notes in a text viewer.
Notes
About Displays CME 2 version information.

Copley Controls Corp.
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2.7.3: Functional Diagram
The functional diagram, shown below, provides button-click access to most of the screens

used to configure an amplifier. It also indicates the flow of control from input, across all

active control loops, to motor/feedback. Only those control loop buttons that are
appropriate to the amplifier and operational mode appear on the diagram.

Control Loops

Input f Cutput |

]

CWid Control Frogram I
_I_I
'
r F Loop I—b W Loop |—b | Loop
'

A | ________ |

Home | Configure Regen |

Configure Faults |

Name Description For More Information
Input/ Opens Input/Output screen. Digital Inputs and Outputs (p. 49)
Output
CVM Opens Copley Virtual Machine screen. Copley Indexer Program User’s
Control Guide.
Program
Input Opens screen for configuring the input.command. Command Inputs (p. 59)
Command | Button label varies depending‘on the;selected control

loop input.
Control Each opens a controlloep configuration screen. Control Loops (p. 91)
Loops
Motor/ Opens the Motor/Feedback screen. Motor/Feedback (p. 39)
Feedback
Home Configure'and testhoming. Homing (p. 121)
Configure | Opens Regen Resistor screen. Regen Resistor Configuration
Regen (p-179)
Configure _|~Opens Fault Configuration screen. Faults (p. 69)
Faults
Encoder (Stepper amplifier with encoder only.) Opens Encoder Correction (p. 119)
Carrection | Encoder Correction screen.
Detent (Stepper amplifier only). Opens stepper amplifier Detent Compensation Gain

Advanced Tuning screen. (p. 120)
Position (Stepper amplifier with encoder only.) Opens Position | Position Limits (Stepper Amplifier)
Limits Limits screen. (p- 118)

Copley Controls Corp.
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2.7.4: CAN or DeviceNet Information and Status Bar

CAN or DeviceNet Information

The Main screen displays the basic CAN or DeviceNet information. The example below
shows CAN information:

CAN Metwork:  Address: 1 State: Pre-operational

The Address field shows the amplifier's present CAN or DeviceNet address. For more
information, see CAN Network Configuration (p. 67) or the Copley DeviceNet
Programmer’s Guide. When the Position Loop Input is set to CAN, the State field-shows
the state of the amplifier's CANopen state machine (for more information, see Copley
Control’'s CANopen Programmer’s Manual).

Status Bar

The status bar describes the present commutation mode, motor type,cand amplifier
control status as shown below. It also includes a reminder that pressing the F12 function
key while CME 2 is running disables the amplifier.

[Sinusoidal Commutation Rotantioter OSSO DS |
| .
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CHAPTER

3: AMPLIFIER SETUP PROCEDURE

Perform the steps listed below, in the order presented, to set up and tune an
amplifier/motor pair. Details follow in the chapter.

Prepare for setup (p. 27).

Start CME 2 and enter Basic Setup parameters (p. 27).
Enter Motor/Feedback/Brake Stop parameters (p. 28).

Use Calculate to automatically set initial gains and limits (p.:28).
Configure digital 1/0 (p. 28).

Configure the command input (p. 28).

Configure faults (p. 29).

Configure an optional regen resistor (p-29).

Phase and jog the motor (p. 29).

Tune the control loops (p. 29)-

Set gains and limits for stepper-mode (stepper only) (p. 29).
Configure Homing (p."29):

Test with load:attached (p. 30).

NOTES:ServoFube motor setup steps are included within this procedure.
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3.1: Warnings and Notes

NOTE: To immediately software disable the amplifier at any time while running CME 2,
press function key F12. Also, the amplifier's enable input can be used to disable the

amplifier.

DANGER: Hazardous voltages.
Exercise caution when installing and adjusting.
Do not make connections to motor or drive with power applied.

DANGER _ o _
Risk of unexpected or uncontrolled motion with CME 2 in CAN or
DeviceNet mode.
CME 2 can be used while the amplifier is under CAN or DeviceNet'control.
However, some extreme changes made with CME 2 could cause unexpected
or uncontrolled motion.
Failure to heed these warnings can cause equipment damage, injury, or
death.
Spinning motor with power off may damage ampilifier.
Do not spin motors with power off. Voltages'generated by a motor can
damage an amplifier.
Failure to heed this warning can cause equipment damage.

WARNING
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3.2: Setup Procedure

1 Prepare for setup

= Understand this procedure’s Warnings and Notes (p. 26).

= Verify that amplifier power is OFF.

. Verify wiring and connections.

= Make sure motor is securely fastened with no load connected.
= Apply power to the amplifier.

For Xenus amplifiers apply 24V only.
For Accelnet, or Stepnet: amplifiers apply AUX HV only.

2 Start CME 2 and enter Basic Setup parameters

Double-click CME 2 icon on the Windowsdesktop to start CME 2.

. If necessary, Connect to an Amplifier (p. 19) from thedist in the Copley Neighborhood
tree.

= |ﬂ If the Basic Setup screen doés not appear, click the Basic Setup button.

Choose:

In most cases, click Change Settings to Change Basic Setup
e St Settings“(p. 32).
M Then proceed to Step 3 of this Setup Procedure,
Enter Motor/Feedback/Brake Stop parameters (p. 28).

R To load a .ccx file that was prepared for the amplifier/motor
OR Loadggxﬁé | combination, see Copy Amplifier Data (p. 151). Then proceed to
Step 13 of this Setup Procedure, Test with load attached (p. 30).

To complete the setup for a ServoTube motor, click ServoTube

OR ) Ser Setup
Setup and see ServoTube Setup (p. 36).

Continued. ..
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...Setup Procedure, continued:

3

OR

Enter Motor/Feedback/Brake Stop parameters

M Click Motor/Feedback to open the Motor/Feedback screen.

To optionally load data from an existing motor data file,
see Load Motor/Feedback/Brake Settings from a File (p. 41) and then skip to
Step 4, Use Calculate to automatically set initial gains and limits (p. 25).

On the Motor tab, modify the appropriate Rotary Motor Setup Parameters (p. 42) or
Linear Motor Setup Parameters (p.43).

On the Feedback tab, as appropriate for each encoder or resolver, verify the parameters
described in Feedback Parameters, Rotary (p. 44) or
Feedback Parameters, Linear (p. 45).

If using a brake, click the Brake/Stop tab to verify Brake/Stop Parameters (p. 46).
Use Calculate to automatically set initial gains and limits

! oo Calculatel

Click Calculate to have the software calculate'and display initial loop gains and limits.
See The Calculate Function (p. 48):

Load the calculated values inte-amplifier RAM by clicking OK.
Configure digital 1/0

Input # Output |

Click Input/Output-on the_Main screen to open the Input/Output screen.
Verify the 1/0O_settingsdescribed in Digital Inputs and Outputs (p. 49).

On the Input/Output screen, click Close.
Configure the command input

Aralog Command | Pk Command l Digital Position Inputs CAN Configuration
or or

Click-the appropriate button to configure the amplifier's command input.

For more information see Command Inputs (p. 59).

NOTE: If the amplifier is to run CVM programs or in Camming mode see the relevant
documents.

After setting command input parameters, Click Close.

Continued...

28

Copley Controls Corp.



CME 2 User Guide Amplifier Setup Procedure

...Setup Procedure, continued:

7 Configure faults

- Configure Faults |

Click Configure Faults to open the Fault Configuration screen and set latching faults as
needed. See Faults (p. 69).

- Click OK to close the Fault Configuration screen.

8 Configure an optional regen resistor

- Configure Regen |

If the amplifier is equipped with a regen resistor, click Configure Regen to open the
Regen Resistor screen. See Regen Resistor Configuration (p. 179) for regen resistor
parameters.

. Click OK to close the Regen Resistor screen.

9 Phase and jog the motor
= Apply AC or HV power.

m Phase Motor with Auto Phase (p.76).

. To verify Auto Phase results, PhaséMotor Manually (p. 85).

= Run a move in jog mode (p. 127) to verify that the amplifier can drive the motor.

10  Tune the control loops

. Starting with the Current'Loop;set up and tune all applicable Control Loops (p. 91).
If you are setting up a'linear. motor, you can optionally Tune All Loops with Auto Tune
(Linear Motors) (p.»111)‘instead.

11  Set gains:and.limits for stepper mode (stepper only)

= If tuning'a’ stepper amplifier in stepper mode:

= Set Position Limits in Stepper Mode (p. 118).
=_'_If using’'Encoder Correction, Set Encoder Correction Gain (p. 119).
= Tune Stepper Detent Gain (p. 120).

12 Configure Homing
. Configure Homing (p. 121).

Continued...
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...Setup Procedure, continued:

13 Test with load attached

Iﬂl On the CME 2 Main screen, click Save to Flash.
= Remove amplifier power.

. Attach load.

= Reconnect amplifier power.

= If necessary, re-tune velocity and position loops.
Iﬂl On the CME 2 Main screen, click Save to Flash.

ﬂ On the CME 2 Main screen, click Save to Disk(for backup or duplication).
= The amplifier tuning procedure is complete.

NOTE: To copy the results of this setup to other amplifiers,
see Copy Amplifier Data (p. 151).
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CHAPTER

4: BASIC SETUP

This chapter describes the Basic Setup screen. Perform the basic steps outlined below, to
access and enter the Basic Setup options. Details follow in the chapter.

ﬁ Click to open the Basic Setup screen.
2 x|

Setkings

motor Farmily: Brushless

Matar Type: Linear

Hall Type: Analog

Hall Phase Correction: On

lJse Halls farvelocityPasition:  Off

lse Back EMF for Yelocity: Off <
hotor Encoder: Lowy Freguency Analog @
Multi-maode Encoder Port: Buffared Matar Encader .\% (
Dperating Mode: Pasition, Analog Input :a Q

\
O Q)
2 NN
Change Settings | Load ccx File | . ;&DTUIJQ gﬁ: | Cancel |
A [ -

3 Review settings.

4 Choose:

rem—— E \ If necessary, click Chang_e Settings to
Change Basic Setup Settings (p. 32).

OR L:;gc'cx F“eg If you have a .ccx file that was prepared for the amplifier/motor
combination, click Load ccx File and see Copy Amplifier Data (p. 151).

OR o To change Basic Setup settings for a ServoTube motor, click
_Sinseny | ServoTube Setup and see ServoTube Setup (p. 36).

OR Cancel | To accept the displayed settings, click Cancel.
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4.1: Change Basic Setup Settings

1 Change Settings | On the Basic Setup screen, click Change Settings to start the Basic
Setup wizard. Use the Back and Next buttons to navigate screens.
Screen details vary depending on amplifier model and mode selection:

2 setMotor Options (p. 33). A
Motor Options O((\
AN
Mokor Family: &O

{* Brushless ¢ Brush

Mator Type: 0@

f* Rotary Linear

@ Q~. Back Mext = | Cancel |
9

3 SetFeedback Options (p. 34). T |
@back Options
%)

\ Hall Type: IDigitaI - I

[¥ Hall Phase Correction

Motar Encader: IPrimary Incremental LI

Pasition Encader: ISecondar\; Incremental LI

Position Encoder Type:
{* Rotary  Linear

[~ Use Position Encoder In Passive (Monitor) Mode

<Back || Mext> i|  Cancel

Continued.:.
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...Change Basic Setup Settings, continued:

4 Set Operating Mode Options (p. 35). x
Operating Mode Options
Qperating Mode: IPosition vI Q
Command Source: - é\

Digital Input Source \O
{+ High Speed Inputs &O
(= Mulki-mode Fork

é - « Back | Mext = | Cancel |
(&)

5 Set Miscellaneous Options (p. 35). x|

Miscellaneous Options

o Q&
Corﬁh&ion@
&% Sinus ihf‘ Trapezaidal ( Estimated Sinusaidal
/
» N

[y ack EME For Yelacity
Halls For Velatity
\

\

Multi-rnode Part: IDiFFerentiaI Input ;I

<Back || Finsh |  Cancel

6 When satisfied with the settings, click Finish on the final screen.

4.2: Motor:Options

View of'change the settings described below. Options vary with amplifier model.
Setting Description
Motor Family Select motor family: Brushless, Brush, or Three Phase Stepper.

(Three Phase Stepper configures the ampilifier to operate as an open-loop
stepper drive for three-phase stepper motors.)

Motor Type Select motor type: Rotary or Linear.
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4.3: Feedback Options

View or change the settings described below. Options vary with amplifier model.

34
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Setting Description

Hall Type Select Hall type: None, Digital, or Analog (Analog is used with Copley
Controls ServoTube motors).

Hall Phase If selected, will enable error checking between Hall switches and encoder

Correction based phase angle. See Faults (p. 69).

Motor Encoder

Select type and source of motor feedback.
¢ None: No motor encoder.

e Primary Incremental: Incremental encoder on primary feedback
connector.

e Secondary Incremental: Incremental encoder on multi-mode port.
e Analog: Analog encoder on primary feedback connector.,

o Low Frequency Analog: Copley ServoTube motor on.ptimary feedback
connector.

o Resolver (Resolver version only): Resolver on primary feedback
connector.

Position Encoder

Select type and source of Position (load) feedback.
o None: No position encoder

e Primary Incremental: Incremental encoder on primary feedback
connector.

e Secondary Incremental: Incremental encoder on multi-mode Port.

e Analog: Analog encoder on primary feedback connector.

Position Encoder
Type

Select the type of Position (load) encoder:
e Rotary.

e Linear.

Use Position
Encoder in
Passive (Monitor)
Mode

When this is’checked, the position of the position encoder will be reported
by the-passivedoad position variable but it will not be used to control the
position of the\axis.

Stepper Amplifiers Only

Motor Encoder

Select'the encoder type:
¢ 'None

e Primary incremental

Run.in'Servo

(With encoder only.) Amplifier operates as a true, closed loop, servo

Mode amplifier controlling a stepper motor.
Enable Encoder (With encoder only.) Amplifier runs as a stepper drive; encoder feedback is
Correction used to correct positional errors. See Encoder Correction (p. 119).

For more information see Motor/Feedback (p. 39).
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Basic Setup

4.4: Operating Mode Options

View or change the settings described below. Options vary with amplifier model.

Setting

Description

Operating Mode

Choose the mode of operation: Current, Velocity, or Position.
See Servo Operating Modes and Control Loops (p. 11).

Command Source

Choose the command input source:

e Analog Command: Analog voltage provides command input.
See Command Inputs (p. 59).

¢ PWM command (current and velocity mode only): Digital pulse-width
modulated signal provides command input.
See Command Inputs (p. 59).

e Function Generator: Internal function generator provides command
input.

o Software Programmed: The amplifier is controlled by software
commands from either the Copley Virtual Machine (CVIM)_or an external
source. See Copley Indexer Program User’s Guide orithe Copley ASCII
Interface Programmer’s Guide.

o Camming: Amplifier runs in Camming Mode. See Copley Camming User
Guide.

o Digital Input: Command input is provided-via.the Input Source selected
from the choices described below. See.Digital Position Input Settings (p.
64).

e CAN: Command input is providedrover the CANopen network. See the
CANopen Programmer’s Guide:

Input Source

Choose the input source for PWM or Digital input commands:

¢ Single-ended Inputs: Command.input is provided via two of the
amplifier's programmable’ digitalinputs.

e Multi-mode Port: Command(input is provided via differential inputs on the
amplifier's multi<-moede port.

o Differential. Inputs: Command is provided via the amplifier’s differential
inputs.

4.5: Miscellaneous,Options

View or change the settings described below. Options vary with amplifier model.

Setting

Description

Commutation

Select commutation method: Sinusoidal, Trapezoidal, or Estimated
Sinusoidal.

Use back"EMF for
Velocity

If selected, will use the motor's measured back EMF to determine motor
velocity. Recommended only for medium- to high-speed. Accuracy
depends on the accuracy of the programmed Back EMF value, and may
be affected by factors such as cable resistance.

Use Halls-for
Velocity and
Position

If selected, will use transitions of the Hall switches to determine motor
velocity and position. Recommended only for medium- to high-speed
applications (may run roughly at low speeds).

Multi-mode Port

Selects the mode for the amplifier's multi-mode port:

o Buffered Motor Encoder. The multi-mode port functions as a buffered
digital encoder output based on the digital encoder input.

o Emulated Motor Encoder. The multi-mode port functions as an emulated
digital encoder output based on the motor analog encoder or motor
resolver.

o Emulated Position Encoder. The multi-mode port functions as an
emulated digital encoder output based on the position analog encoder.

o Differential Input. The multi-mode port functions as a differential
command input.

Copley Controls Corp.
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4.6: ServoTube Setup

The ServoTube Setup tool sets up the amplifier for use with the chosen ServoTube motor.
After the user selects the motor series and model, CME 2 performs the following actions:
e Sets motor-specific values for all feedback options in the Basic Setup screen.

Phases the motor.
Saves all values to flash.

CME 2 User Guide

Provides motor-specific values for all settings in the Motor/Feedback screens.
Performs the Calculate function to set initial gains and limits.
Sets the appropriate programmable digital input as Motor Over Temperature.

Opens the Control Panel so the user can Run a move in jog mode (p. 127):

Set Up a ServoTube Motor

stz | On the Basic Setup screen, Click ServoTube Setup to'start the Basic
Setup wizard. Use the Back and Next to move from screen to screen as needed.

Choose the appropriate Series and
Model. Optionally choose to Invert
Motor Direction. Optionally choose
the Additional Encoder Option
(available with certain motor series)
and choose the appropriate
resolution for the optional encoder (1
um or 5 um).

Set Operating Moade Options (p. 35).

Continued...
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Motor Options

Series: ISM r I

[ Inbeett Mokar Direction

< Back | Mexk =

Cancel |

x|
Operating Mode Options

Operating Mode: IPDsition hd I

Command Source: ISthware Programmed LI

D =hack i MNext: Cancel
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...Set Up a ServoTube Motor, continued:

4 Set Miscellaneous Options (p. 35).

Basic Setup

Basic Setup

Miscellaneous Options

Commutation Mode:

{* Sinusoidal = Trapezoidall ) Estimated Sinuscidal 0\\'CJ
) Use Back EMF Far, Yelocity: @
" Use Halls for Yelocity: and Position 0

G (S teta LTl | LfFered Primary Encoder

Q)
R
= Back Finish Cancel

O\

5 When satisfied with the settings, click Finish.

The control panel opens.

6 To test basic move capabilities, Run a moverin jog.mode (p. 127).

7 Test with load attached (p. 30).

Copley Controls Corp.
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Basic Setup
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CHAPTER

5: MOTOR/FEEDBACK

This chapter describes motor, feedback, and brake parameters, and the Calculate
function. Access these features as described below. Details follow in the chapter.

M Click Motor/Feedback to open the Motor/Feedback screen.

ﬂ Load Motor/Feedback/Brake Settings from a File (p. 41).

Enter settings manually:

hotor |
Click the Motor tab to view or change Rotary Motor Setup Parameters (p. 42)

or Linear Motor Setup Parameters (p. 43 ).
Feedback |

Click the Feedback tab to view or ,change Feedback Parameters, Rotary (p.44) or
Feedback Parameters, Linear (p.45). Read the Feedback Notes (p. 46) for important
related information.

Brake\=top |

Click the Brake/Stop tab'to view or change Brake/Stop Parameters (p. 47). Read the
Brake/Stop Notes (p-47) for important related information.

M Use’The Calculate Function (p. 48) to calculate initial gains and limits.

Iﬂl On the Main screen, click Save to Flash to avoid losing the changes.

Copley Controls Corp. 39
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5.1: Motor/Feedback Screen Overview

A typical Motor/Feedback screen is shown below. Parameters vary with amplifier model.

Motor/Feedback - Rotary Motor x|
fotar | Feedbackl Brake\.‘s‘topl
Manufacturer.  |Copley Urits
{ = e [ ienaien <« Choose default units for sereen.
Mocel Mumber: ICBL341 FE-001
Motor Inertia:
011976 Jkgem® 7|
Targue Constart:
L TR l—4 | 0140 femispk v | - Choose specific units for field.
Back emf Constant:
Peak Torgue: I 14.687 I\-’Jkrpm LI
| 19546 Jum 7| Resistance:
Continuous Torgue: =27 R
[ oessz wm 7] Inductanice:
523 mH
Welocity Limnit:
B4 rprm
e e e 1
' '
! ﬂ ﬂ E:Hl ﬁl ! ﬁ Calculate el Cancel
!

R 4

Motor Data Controls Calculate-Function

The Calculate function is described-in The-Calculate Function (p. 48).

Data on the Motor/Feedback-screen-can be saved to and restored from disk files using
the controls described below.

Name Description
Save motor.data to Saves motor/feedback/brake settings from PC to a disk file with .ccm
disk name extension.

Restore motor,data Restores contents of a .ccm file from disk to PC.
from disk

Save-motor data to Saves motor/feedback/brake settings from PC to amplifier permanent
flash flash memory.

BaE

'
"
\

Restore motor data Restores motor/feedback/brake settings from flash memory to the
from flash PC.

u

For more information see Data, Firmware, and Logs (p. 141).
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5.2: Load Motor/Feedback/Brake Settings from a File

1 If needed, download the motor data file from the Copley Controls website:

= In an internet browser, navigate to
http://www.copleycontrols.com/Motion/Downloads/motorData.html

= Click on the appropriate motor name.

=  When prompted, save the file to the MotorData folder in the CME 2 installation
folder.

= (The default installation folder is
C:\Program Files\Copley Motion\CME 2\MotorData.)

= Extract the contents of the zip file to the same location.

= The folder should now contain the new motor data file (with a .ccm filename
extension).

= [f desired, delete the .zip file to save disk space.

2 Load the motor data into the amplifier:

. '—l'"mmem“k Click Motor/Feedback to open the Motor/Feedback screen.

. Iﬂl On the Main screen, click Save to Flash.to avoid losing the changes.

= On the Motor/Feedback screen, click Restore Motor Data from Disk.
When prompted, navigate to the folder,containing the file,
then click on the file name, and then click Open.

Calculat
et El Calculate initial gains'and limits with

The Calculate Function (p..48).

= |ﬂ| On the Main screen, click Save to Flash to avoid losing the changes.
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5.3: Rotary Motor Setup Parameters

View or change the settings described below. Options vary with amplifier model. Metric
units are shown here.

42

Setting Description

Manufacturer Motor manufacturer's name. Saved for reference in the motor data file.

Model Number Motor model number. Saved for reference in the motor data file.

Units Selects whether the parameters entered in this screen are in Metric or English units.
Motor Inertia The rotor inertia of the motor. Used for calculating initial velocity loop tuning values.

Range: 0.00001 to 4,294 kg cm?. Default: 0.00001 kg-cmz'

Number of Poles

(Brushless only.) The number of magnetic poles in the motor. Required.for correct
commutation of the motor. If the number of poles is not known,
Verify the motor’s pole count (p. 90). Range: 2 to 200. Default: 4-

Peak Torque The peak torque that the motor can produce. Peak Torque divided by torque constant =
motor’s peak current limit. Range: 0.001 to 2,100 Nm. Default:'0.0001 Nm.

Continuous The continuous torque that the motor can produce. Used with the torque constant to

Torque calculate continuous current. Range: 0.001 to 1,000'Nm. Default: 0.0001 Nm.

Velocity Limit Maximum speed of the motor. Used to calculate-the velocity and acceleration limits for

the velocity loop. Range dependent on encoderresolution.

Torque Constant

Relates the motor's input current to torque_produced. Sometimes abbreviated as Kit.
Range: 0.001 to 1,000 Nm/Apk. Default0.001 Nm/Apk.

Back emf Relates the motor's input voltage to speed. Sometimes abbreviated as Ke. Used for
Constant calculating the maximum velocity for‘a given amplifier bus voltage.
Range: 0.01 to 21,000,000 V/Krpm. Default: 0.01 V/Krpm.
Resistance Motor resistance line-to-line¢ Used for calculating the initial current loop tuning values.
Range: 0.01 to 327 Q. Default: 0.01,Q.
Inductance Motor inductance line-to-line. Used for calculating the initial current loop tuning values.

Range: see the hardware doecumentation.

Stepper Amplifiers Only

Rated Torque

Motor’s rated-operating. torque. Min: .001. Max: 1000.

Rated Current

Motor’s rated continuous current. Min: 0.001. Max: 1000.

Basic Step Angle

Fundamental-stepper motor step, in degrees. Min: 0.225. Max: 22.5. Default 1.8.

Microsteps/Rev

Number of microsteps per revolution of the motor.
Min: 4 “Max: 100,000,000. Default 4000.

Full Steps/Rev

This'read-only value can be used after entering Basic Step Angle to cross-check
against motor data sheet.

Copley Controls Corp.
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5.4: Linear Motor Setup Parameters

View or change the settings described below. Options vary with amplifier model. Metric
units are shown here.

Setting Description
Manufacturer Motor maker’'s name. Saved in the motor data file. Choose from list or enter manually.
Model Number Motor model number. Saved in the motor data file. Choose from list or enter manually.
Units Selects whether the parameters entered in this screen are in Metric or English units.
Mass The mass of the motor. Used for calculating initial velocity loop tuning values,

Range: .0001 Kg to 100,000 Kg. Default: .0001 Kg.
Peak Force The peak force that the motor can produce. Peak Force divided by Force Constant =

motor’s peak current limit. Range: 0.00001 to 2,000 N. Default: 0.00004 N.

Continuous Force | The continuous force that the motor can produce. Used with the force constant to
calculate continuous current. Range: 0.00001 to 1,000 N. Default: 0.00001 N.

Velocity Limit Maximum speed of the motor. Used to calculate the velocity.and acceleration limits for
the velocity loop. Range dependent on encoder resolution.

Force Constant Relates the motor's input current to force produced:Sometimes abbreviated as Kf.
Range: 0.00001 to 2,000 N/Amp. Default: 0.00004"N/Amp.

Back emf Relates the motor's input voltage to speed. Someétimes abbreviated as Ke. Used for

Constant calculating maximum velocity for a given_amplifier voltage. Range: 0.01 to 1,000
V/M/Sec. Default: 0.01 V/M/Sec.

Resistance Motor resistance line to line. Used for, calculating the initial current loop tuning values.
Range: 0.01 to 327 Q. Default: 0,01 Q.

Inductance Motor inductance line to line. Used for,_calculating the initial current loop tuning values.
Range: see the hardware dacumentation.

Magnetic Pole The length of a pair of magnets which equals the distance moved in one electrical

Pair Length cycle of the motor.

Stepper Amplifiers Only

Rated Force Motor’s rated aperating‘force. Min .001 N. Max 1000 N.

Rated Current Motor’s rated continuous current. Min: 0.01 A. Max 1000 A.

Full Step Fundamental stepper motor step distance. Min: 0.0001mm. Max: 5000 mm.

Microsteps/ Number of microsteps per full step. Min: 1. Max: 100,000,000.

Full Step
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5.5: Feedback Parameters, Rotary

As appropriate for each encoder or resolver, enter the parameters described here.
Options vary with amplifier model.

44

Feedback | Parameters/Actions
Type
Incremental | In the Motor Encoder lines or Position Encoder lines field, enter the number of encoder
lines (see encoder or motor data sheet). As indicated by the counts field, the number of
encoder counts per revolution is equal to 4 x the number of lines.
I 1000 lines = I 4000 courts
Analog In Fundamental Lines, enter the number of fundamental encoder lines (see-encoder or
motor data sheet). As indicated by the Fundamental Counts field, the number of
fundamental encoder counts per revolution is equal to 4 x the numberof Fundamental Lines.
Optionally modify the encoder resolution by changing the Interpolation value. The
interpolated resolution (Interpolated Counts Per Rev) is the product of Fundamental Counts
value and the Interpolation value.
Fundamental Lines I 1000 = 4000 Fundamental Caurte
Interpolation |1 &~ l
Interpolated Counts Per Rew. 4000
Resolver Optionally modify the feedback resolutionby changing the value in Counts Per Rev.
Default: 16384.
Resolver—————————
’7 I 4000 Courts Per Rew
Halls With amplifier set to Use Halls for Velocity/Position, optionally increase the counts per rev
ratio by incrementing the Halls Count Multiplier.
Hall Court hultipliers |1 'I
Counts per Rey: 12
Default |

If two feedback devices ‘are installed, verify that the values of Motor Turns to Position
Turns correctly-represent the ratio of motor encoder turns to position encoder turns.

Ratio
dator Turns

Positan Turns

10

o
po
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CME 2 User Guide

Motor/Feedback

5.6: Feedback Parameters, Linear

As appropriate for each encoder installed, enter the parameters described below. Options
vary with amplifier model.

Feedback

Parameters/Actions

Type
Incremental

Choose units and then enter the Encoder Resolution (see encoder or motor data sheet):

Encader Resolution: I 1 Comm Coam # um

Analog

Enter the Fundamental Pitch (distance between encoder lines; see encoder or-motor data
sheet). As indicated by the Fundamental Resolution field, Fundamental Pitch.divided by four
gives Fundamental Resolution. The interpolated resolution is the dividend.of-Fundamental
Resolution value/Interpolation value. Optionally modify the Interpolated-Resolution by
changing the Interpolation value.

Fundamental

Fundamental Pitch I 4 um = 1 um 5
Rezolution
Interpolation |1 = I

Interpolated Resolution 1 U

Low
Frequency
Analog

(Normally used with ServoTube) Pole Pitch is the-distance between poles in a poll pair, as
entered in the Magnetic Pole Pair Length field-on'the Motor tab. The interpolated resolution
is the dividend of Pole Pitch/Counts per pole value, expressed in micrometers. Optionally
modify the resolution by changing the Counts/Pole value. Click Restore Default to restore

default Counts/Pole.

FPole Fitch 512 fmm
CourtzsPaole I 4000 Festare Default |

Interpolated Resalution 128 - um

Copley Controls Corp.
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5.7:
5.7.1:

5.7.2:

46

Feedback Notes

Encoder and Resolver Support

Some Copley Controls amplifiers are offered in two versions to support encoder or
resolver feedback. The encoder versions support digital quadrature or analog sin/cos
encoders. These versions normally require Hall switches for the commutation of brushless
motors. The resolver versions support standard, single speed, transmit-type resolvers.

Dual Feedback Amplifiers

Some Copley Controls amplifiers can receive position feedback from sensors on'the
motor, the load, or both, through the Primary Feedback channel, a Secondary.Feedback
channel (multi-mode port) or both. (Some amplifiers can also operate in certain modes
without encoders or resolvers.)

When the amplifier is configured with a multi-mode port (see Feedback Options, p. 34) the
multi-mode port can:

¢ Provide a buffered digital encoder output based on the digital encoder input.

e Provide an emulated digital encoder output based on the.analog encoder or resolver
input.

e Provide a second digital encoder input to be used-in the dual encoder position mode.
In this mode, an encoder attached to the load‘provides position loop feedback, and
the motor encoder or resolver provides velocity loop feedback.

A dual-feedback setup is shown below. The amplifier receives feedback from an

incremental motor encoder through the Primary feedback channel. Position (load)

encoder feedback comes through the multi-mode port. The ratio of motor turns to position

encoder turns is 1 to 10.

Motor /Feedback - Rotary Motor ) \QVJ 1[

motor  Feedback I |

I 1000 lifigs-= I 4000  counts

"Mutor Primary Incremefital

i+ Positionfsecondary Incremental

I 1000 lines = I 4000 counts

Ratio

Mator Turns I 1
Positon Turns I 1EI|

ol <all ol S < oo

Ok Cancel
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5.8: Brake/Stop Parameters

Enter the following parameters as appropriate.

Parameter Description
Brake/Stop Delay Time Range of accepted values: 0 to 10,000 mSec

Brake Activation Velocity | Range of accepted values: 0 to 183,105 rpm (mm/s for linear motor)

PWM Delay Brake/Stop Range of accepted values: 0 to 10,000 mSec
Response Time

5.9: Brake/Stop Notes

Many control systems employ a brake to hold the axis when the ampilifier is disabled. On
brake-equipped systems, disabling the amplifier by a hardware or software:command
starts the following sequence of events.

¢ The motor begins to decelerate (at Abort Deceleration rate in position mode or Fast
Stop Ramp rate in velocity mode). At the same time, the Brake/Stop Delay Time count
begins. This allows the amplifier to slow the motor before’applying the brake.

¢ When the motor slows to Brake/Stop Activation Velogity OR the Brake/Stop Delay
Time expires, the brake output activates and PWMDelay Brake/Stop Response Time
count begins.

¢ When response time has passed, the amplifier’s/output stages are disabled. This
delay ensures the brake has tlme to lock in before, disabling the power section.

Enhle Input =y -'I—I'- Brake/Stop dE}ﬂ?ﬂ”R()‘(‘

‘

Speed
™, t@akeﬂ\@%wmmn welocity

XN

Brake Ouptput 5\'\0\ &s\\

N

&

\{a O

Enabile . e Pt clelays
Povver Sed@(\ @\V

L

-

This sequence is-not available in the current mode of operation. Instead, in current mode,
the amplifier output turns off and the brake output activates immediately when the disable
command is received.

Brake!=top rezponze time
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5.10: The Calculate Function

48

1

The Calculate function uses programmed motor and encoder values to calculate initial
gains and limits. These can be modified to fine-tune the amplifier. Follow the steps below:

Calculat
Sl S Cjick calculate to calculate and display the settings.

x|

Current Loop Cp Gain: 1639 =
Current Loop Ci Gain: a3
FPeak Current Limit: 13.95 A
Continuous Current Limit: 468 A
[FT Tirme Limit: 1000 o
Welocity Loop Vp Gain: 13312
Welocity Loop Wi Gain: 2948
Welocity Loop Welocity Limit: 3000 Fam =
Welocity Loop Accel, Decel., Fast Stop: 1000 rps®
Welocity Tracking Window B00 rpm
Welocity Tracking Time: Ton ms
Position Loop Proportional Gain Pp 1000
Fositon Loop Velocity Feedforward Wif 16324
FPosition Loop Following Error 4000 Coun

Kl | ;IJ

Cancel |

2 Verify the peak current-limit, continuous current limit, and velocity loop velocity limit.

If one or more of these values seems inappropriate, click Cancel and check: Peak
Torque (or Force),.Continuous Torque (or Force), Velocity Limit, and Torque (or Force)
Constant. Correct themvif needed. See Rotary Motor Setup Parameters (p. 42)

or Linear Metor Setup Parameters (p. 43).

If the Motor/Feedback values were correct but the peak current limit, continuous current
limit;.or velocity loop velocity limit values are not optimal for the application, change
these limits during the tuning process.

Load the values into amplifier RAM by clicking OK.

NOTE: When loading motor data from a file, if the motor wiring configuration in the motor
file does not match the configuration currently stored in the amplifier, CME prompts for
verification on which configuration to use. Select the file configuration by clicking Yes.
The configuration will be tested as part of Motor Phasing (p. 75).

ot |
On the Main screen, click Save to Flash to avoid losing the changes.
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CHAPTER

6: DIGITAL INPUTS AND OUTPUTS

This chapter shows how to configure the amplifier’s digital inputs and outputs. Perform the
steps outlined below. Details follow in the chapter.

(o]
Click Input/Output to open the Input/Output screen.

As needed, set Digital Inputs (p. 50).

As needed, set Digital Outputs (p. 52).

Click Close to close screen and save changes to amplifier)RAM.

a A~ O DN

Iﬂl On the Main screen, click Save to Flash to.avoid losing the changes.
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6.1: Digital Inputs

6.1.1: Digital Inputs Screen Overview

50

A typical Input/Output screen is shown below. (Features vary with amplifier model and
configuration.)

Red light: inhibited motion or active input, depending on input function.
Grey light: motion not inhibited.
No light: not configured.

Lo/Hi: Indicates state of input.

Qo Limix
. \¥
Digital Inputs 1-5 | pigital Inputs 6-12 | Digital Outputs | A0
Debounce ;i@ CAN address
v
[IN1] |Amp Enable-Lo Enables with Clear Faulks - 0y Yms Lo =
{* Pull up +5¥ I —I )
\
= Pull down [IN2] |N0t Configured ﬂ&l p ms Lo BITO
N
[IN3] |not Configured | | 0 ms Lo BIT 1
NS
{\\‘9
N/
& pulupssy N4 fMat Configured N o] 0 oms BIT 2
q)f"'" o (11 E] B Mok Configured i BIT 3

Restore Defaulks

Close |

Y ad P

&y O

[~ *Hald @@Dn wl@%it sibeh is active
~ <

Indicates input is used as a CAN address bit.
Hold)position setting

Parameter Description
Pull up/+5 V Pulls up the group of inputs up to internal +5 V.
Pulldown Pulls the group of inputs down to internal signal ground.

Debounce Time

Specifies how long an input must remain stable at a new state before the amplifier recognizes the
state. Increase to prevent multiple triggering caused by switch bounce upon switch closures.
Range: 0 to 10,000 mSec.

Debounce does not affect inputs that have been configured as PWM, Pulse and Direction, or
Quadrature control inputs.

IN1-IN12 Select the function for the input. See Digital Input Functions (p. 51) for input function descriptions.
*Hold position Available in position mode when one or more inputs are configured as a limit switch (NEG Limit-HI
when limit Inhibits, NEG Limit-LO Inhibits, POS Limit-HI Inhibits, or POS Limit-LO Inhibits). The *Hold

switch is active

position option prevents any motion while a limit switch is active. This option uses the Abort
Deceleration rate to stop the motor as described in Trajectory Limits (p. 109).

CAUTION: If the amplifier is switched back to current or velocity mode with this option selected,
the limit switches will no longer function.

Restore Defaults restores all inputs and outputs to factory defaults. Close button closes the screen.
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6.1.2: Digital Input Functions

Digital Inputs and Outputs

The digital input functions are described below.

Input Function

Description

LO Enables with reset

AMP Enable- A low input will enable the amplifier.

LO Enables with clear faults Any transition will clear latched faults and outputs.
AMP Enable- A high input will enable the amplifier.

HI Enables with clear faults Any transition will clear latched faults and outputs.
AMP Enable- A low input will enable the amplifier.

A low to high transition will reset the amplifier.

AMP Enable-
HI Enables with reset

A high input will enable the amplifier.
A high to low transition will reset the amplifier.

AMP Enable-LO Enables

A low input will enable the amplifier.

AMP Enable-HI Enables

A high input will enable the amplifier.

Not Configured

No function assigned to the input.

NEG Limit-HI Inhibits*

A high input will inhibit motion in negative.direction.

NEG Limit-LO Inhibits*

A low input will inhibit motion in negative direction.

POS Limit-HI Inhibits*

A high input will inhibit motion_in positive direction.

POS Limit-LO Inhibits*

A low input will inhibit motien‘in/positive direction.

Reset on LO-HI Transition

A low to high transition-of the input will reset the amplifier.

Reset on HI-LO Transition

A high to low transition of the input will reset the amplifier.

Motor Temp HI Disables

A high input will generate“a’Motor Over Temperature fault.

Motor Temp LO Disables

A low input willbgenerate-a Motor Over Temperature fault.

Home Switch Active HI

A high inputjindicates,the home switch is activated.

Home Switch Active LO

A low input indicates the home switch is activated.

Motion Abort Active HI

A high input.causes the amplifier to stop motion, using the Abort
Deceleration rate described in Trajectory Limits (p. 109). The amplifier
remains.enabled.

Motion Abort Active LO

A low input causes the amplifier to stop motion, using the Abort
Deceleration rate described in Trajectory Limits (p. 109). The amplifier
remains enabled.

Hi Res Analog Divide Active HI

A high input causes the firmware to divide the level of the analog input
signal by 8.

Hi Res Analog Divide Active LO

A low input causes the firmware to divide the level of the analog input
signal by 8.

High Speed-Position*Capture on
LO-HI Transition

Position will be captured on the low to high transition of the input.

High Speed Position Capture on
HI-LO Transition

Position will be captured on the high to low transition of the input.

PWM Sync Input

PWM synchronization input. See Synchronizing PWM Switching
Frequency (p. 58). (For high-speed inputs only.)

6,1.3: Standard Input Function Assignments

Enable Input: On most Copley Controls amplifiers, IN1 is dedicated to the enable
function. Accelus uses IN2 for the enable function.

Other inputs can be programmed as additional enables. If there is more than one input
programmed as an enable then all the inputs must be in the enabled state before the
amplifier PWM output stage will be enabled.

Motor Over Temperature: On most Copley Controls panel amplifiers, IN5 is located on
the motor feedback connector and is intended to be used for Motor Over Temperature.
Other: Other inputs may have predefined functions depending on mode of operation.

Copley Controls Corp.
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6.2: Digital Outputs

6.2.1: Screen Overview
A typical Digital Outputs screen is shown below. Options vary with amplifier.

Elnput,.-"l]utput

~=101]

CME 2 User Guide

Hi/Lo state of output

Digital Inputs 1-5| Digital Inputs 6-12 ~ Digital Outputs | %
rey light:
[out [T Ll = - Grey. g .
Output is not active
Canfigure Custonm |
O
[OUT2] [Mot Configured =] Hi - &
Configure Custom | %Q
[OUT3] [nok Configured [ I ,&\%
Canfigure Custonm | ‘ :
[OUT4] [Brake-active High =] hl e 1,~OC) Red ||ght: .
\X Output is active
Canfigure Custonm | Q
N
s

[~ |* Hold |pasition wher limit switch is active

sp

Close |

4

Parameter

. &t I ??E |
Description

Configure Custom

Opens screen to display custom digital output settings.
Available only whenfunction is set to Custom.

Restore Defaults

Restores all inputs and outputs to factory defaults.

Close

Closes screen and saves changes to amplifier RAM.

6.2.2: Standard Output Functions
The standard output functions are described below. Custom output functions follow.

Output Function

Description

Not Configured

No function. Output remains high.

Fault Active High

Output goes high when one or more faults are detected.
See Faults(p. 69).

Fault-Active Low

Output goes low when one or more faults are detected.

Brake-Active’High

Output goes high to activate the brake.
See Brake/Stop Parameters (p. 47).

Brake-Active Low

Output goes low to activate the brake.
See Brake/Stop Parameters (p. 47).

PWM Sync Output (OUT1
only)

The PWM synchronization output.
See Synchronizing PWM Switching Frequency (p. 58).

Custom Event

See Custom Digital Output Settings: Custom Event (p. 53).

Custom Trajectory Status

See Custom Digital Output Settings: Custom Trajectory Status (p. 56).

Custom Position Triggered
Output

See Custom Output Settings: Position Triggered Output (p. 57).

Program Control Active High

Output state controlled by CVM or external program.

Program Control Active Low

Output state controlled by CVM or external program

52
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Digital Inputs and Outputs

6.2.3: Custom Digital Output Settings: Custom Event

Any of the amplifier’s digital outputs can be programmed to respond to a combination of

events including faults, warnings, and status indications. The output goes active when one
or more of the selected events take place.

Configure a Custom Event output

[oUT2]

(Custom Event

Configure Custom |

Hi

Choose Custom Event for an output and then click Configure Custom to.open the

Event Configuration screen.
[~ amplifier Faulk -
[~ amp Over Temperature
[~ Makar Phasing Errar
[~ Feedback Errar
[~ Makar Cver Temp
[~ Under volkage
™ over volkage
[~ shart Circuit

[~ Current Limiked

[~ “altage Limited =
1| | »

7 Qukpuk Active High

% Cukput Sckive Lo

Cancel |

[ Lakch Oukpok

Clear |

x|

Help |

2 Select one or more Custont Event Functions (p. 54).
Multiple functions are OR’ed.together, so any event activates the output.

3 Choose Output Active High to have the output go high when active or Output Active
Low to have the-output go low when active.

4 To latch the output; set the Latch Output option.
The Clear button clears all check marks.

Latching an output does not eliminate the risk of unexpected motion with

non-latched faults.

Associating a fault with a latched, custom-configured output does not latch the
fault itself. After the cause of a non-latched fault is corrected, the ampilifier re-
enables without operator intervention. In this case, motion may re-start

DANGER  unexpectedly.
Failure to heed this warning can cause equipment damage, injury, or death.
5 Click OK to save changes to amplifier RAM and close the screen.

Copley Controls Corp.
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Custom Event Functions
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Select any combination of events to configure a custom event output:

Event

Description

Amplifier Fault

A latched fault is active.

Amp Over Temperature

Motor Phasing Error

Feedback Error

Motor Over Temperature

Under Voltage

Over Voltage

Short Circuit

For descriptions of these fault events, see
Fault Configuration Parameters (p. 70).

Current Limited

The current output is being limited by the 1°T algorithmior a latched current
fault has occurred. See Limits (p. 98.)

Voltage Limited

Current loop is commanding the full bus voltage.in an attempt to control
current. Commonly occurs when the motor.js running as fast as the
available bus voltage will allow.

Positive Limit Switch

Axis has contacted positive limit switch.

Negative Limit Switch

Axis has contacted negative limit-switch.

Amp Disabled by Hardware

Amplifier enable input(s) is not active.

Amp Disabled by Software

Amplifier is disabled by a software command.

Attempting to Stop Motor

The ampilifier, while in velocity or position mode, has been disabled.

In velocity mode, amplifier’is using the Fast Stop Ramp described in
Velocity Loop Limits.(p» 102). In position mode, the amplifier is using the
Abort Deceleration-rate deseribed in Trajectory Limits (p. 109).

The output remains active until the amplifier is re-enabled.

Motor Brake Active

Motor brakesactivated:.See Brake/Stop Notes (p. 47).

PWM Outputs Disabled

The amplifier's PWM outputs are disabled.

Positive Software Limit

Actualposition-has exceeded the positive software limit setting.
See Homing (p. 121).

Negative Software Limit

Actual position has exceeded the negative software limit setting.
See Homing (p. 121).

Following Error

Following error has reached programmed fault limit.
Seg Following Error Fault Details (p. 73).

Following Warning

Following error has reached programmed warning limit.
See Following Error Fault Details (p. 73).

Position has Wrapped

The position counters have exceeded the maximum range of
23"~ 2%.1 and have wrapped. Normal amplifier operation is not affected.

Velocity Limited

The velocity command (from analog input, PWM input, or position loop)
has exceeded the velocity limit. See Velocity Loop Limits (p. 102).

Acceleration Limited

In velocity mode, motor has reached an acceleration or deceleration limit
that was set as described in Velocity Loop Limits (p. 102).

PositionQutside of Tracking
Window

The following error has exceeded the programmed value.
See Tracking Window Details (p. 74).

Home Switch is Active

Axis has contacted the home limit switch.

In“Motion

The motor is moving, or it has not yet settled after a move. The amplifier is
settled when it comes within the position tracking window and stays there
for the tracking time at the end of a move. Once this bit is set, it remains
set until a new move is started.

Velocity Outside of Tracking
Window

Difference between target and actual velocity has exceeded the window.
See Tracking Window Details (p. 74).

Phase not Initialized

Amplifier is using Phase Initialization function and phase is not initialized.

Command Input Fault

See Fault Configuration Parameters (p. 70).

Copley Controls Corp.




CME 2 User Guide Digital Inputs and Outputs

Non-Latched vs. Latched Custom Event Digital Outputs
Like an amplifier fault, a custom-configured output can be non-latched or latched.

If a non-latched, custom-configured digital output goes active, it goes inactive as soon as
the last of the selected events is cleared.

If a latched output goes active, it remains active until at least one of the following actions
has been taken:

Power-cycle the amplifier

or cycle (disable and then enable) an enable input that is configured as
Enables with Clear Faults or Enables with Reset.

or @

Access the CME 2 Control Panel and press Clear Faults or.Reset.

Custom Event Output Fault Handling vs. Overall Fault-Handling

A fault on an output programmed for Custom Event is separate from a fault on the

amplifier. For instance, suppose:

e OUT3 has a Custom Event configuration. Only.the Under Voltage fault condition is
selected, and the output is latched.

e Under Voltage is not latched on the Configure Faults screen.

An under voltage condition occurs, and the‘amplifier goes into fault condition, output
stages are disabled, and faults are reported. At the same time, OUT3 goes active.

The under voltage condition is corrected, and:

e The amplifier fault is cleared. ©utput stages are enabled.
e OUTS3 remains active.
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6.2.4: Custom Digital Output Settings: Custom Trajectory Status

Any of the amplifier’s digital outputs can be programmed to respond to a combination of
amplifier trajectory status conditions. The output goes active when one or more of the
conditions is met.

Configure a Custom Trajectory Status output

(LoLU) 24 W (ustom Trajectory Status Hi

Configure Custom |

Choose Custom Trajectory Status for an output and then click Configure-Custom to
open the Trajectory Status Configuration screen.

x|

[~ Harming Ervar

™ Referenced (Homed)
[ Harning In Progress
[ Mave Abarted

[~ Trajectory Generakor FOnning

[ Camrming Buffer Error

£ Cukput Active High (¢ Qubput Ackive Lo

Cancel |

2 Select one or more trajectory status conditions described below.
Multiple functions are OR’ed together, so-any status match activates the output.

Trajectory Status Functions
Status Description
Homing Error Activate output if an error occurred in the last homing attempt.

Referenced Activate output if-the most recent homing attempt was successful.
(Homed)

Homing in Activate output when a homing move is in progress.

Progress

Move Aborted Activate output if move is aborted.

Trajectory Activate output while trajectory generator is generating a move.
Generator

Running

Camming A camming buffer error has occurred.

Buffer.Efror

3 Choose Output Active High to have the output go high when active or Output Active
Low to have the output go low when active.

4 Click OK to save changes to amplifier RAM and close the screen.
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6.2.5: Custom Output Settings: Position Triggered Output

Any of the amplifier’s digital outputs can be programmed to respond in certain ways to the
position of the controlled axis. The output goes active when the axis position meets the
specified criteria.

Configure a Position Triggered output

(L0 L) 1d B Customn Position Triggered Qutput Hi

Configure Custom |

Choose Custom Position Triggered Output for an output and then click Configure
Custom to open the In Position Configuration screen.

Position Triggered Outpuk ll

Configuration
¥ In Position Window

" Trigger Ak Position

" Trigger Positive Mation
" Trigger Megative Mation

 Qukput Active High % Qukput Ackive Lo

Upper Position: I 0 counks
Lower Position: I 0 counts

(% Use Actual Position
(! Use Limited Fosition

Cancel |

2 Select one of the configurations described below and enter appropriate values for the
parameters.

Configuration | Description and Parameters

In Position Activates.the output while the axis is in the window between the programmed Upper and
Window Lower, positions.

Trigger at Activates the output for the programmed Time when the axis travels through the
Position programmed Position.

Trigger Positive | |CActivates the output for the programmed Time when the axis travels in the positive
Motion direction through the programmed Position.

Trigger Activates the output for the programmed Time when the axis travels in the negative
Negative-Motion | direction through the programmed Position.

3 Choose Output Active High to have the output go high when active or Output Active Low
to’have the output go low when active.

4 In stepper mode with no encoder, choose Use Limited Position. Otherwise choose Use
Actual Position.

5 Click OK to save changes to amplifier RAM and close the
Custom Output Configuration screen.
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6.3: Synchronizing PWM Switching Frequency

In some situations, such as when sampling small analog signals, it is desirable to
synchronize the PWM switching frequency among multiple amplifiers. In these cases, one
amplifier serves as a master for one or more slave amplifiers. The PWM sync output of
the master sends a signal that is received as a PWM sync input by each slave.
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CHAPTER

7: COMMAND INPUTS

This chapter shows how to configure the amplifier's command inputs. Perform the basic
steps outlined below. Details follow in the chapter.

- - - - .\
1 Analog Command Pk Command Digital Poszition Inputs CAN Configuration | CAI‘?O&&tion
or or or r

Click to open the loop command input settings screen.

2 Change/verify command input parameters as described in the following sections:

Analog Command Settings (p. 60)
PWM Input Settings (p. 62)

Digital Position Input Settings (p. 64) or
CAN Network Configuration (p. 67)
Copley Camming User Guide

3 Click Close to close screen and save changesto amplifier RAM.
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7.1:

7.1.1:

60

Analog Command Settings

View or change the settings described below.

Parameter Description

Scaling Current mode: output current produced by +10 Vdc of input.

Range: 0 to 10,000,000 A. Default: Peak Current value.

Velocity mode: output velocity produced by +10 Vdc of input.

Range: 0 to 100,000 rpm (mm/sec).

Default: Maximum Velocity value.

Position mode: position change (counts or mm) produced by +10 Vdc of input.
Range: 0 to 1,000,000,000 counts.

Default: 1 Revolution of a rotary motor or 1 pole pair distance for a.linear motor.
For more information, see Scaling (p. 60).

Dead Band Sets dead band. Range: -10,000 to 10,000 mV. Default: 0.
For more information, see Dead Band (p. 61).

Invert Command Inverts polarity of amplifier output with respect to input signal.

Offset (Current and Velocity modes only.) Used to offset«input voltage error in an open
loop system. Not recommended for use when the.amplifier is part of a closed loop
system.

Range: -10,000 to 10,000 mV. Default: 0. Forimore information, see
Offset (p. 61).

For more information, see Analog Command Notes, (p. 60).

In position mode, set the Trajectory Limits described<below:

Parameter Description

Max Velocity Maximum trajectory velocity. Max value may depend upon the back EMF and the
Max feedback count:"Min:0¢Befault: 0.25 x motor velocity limit.

Max Accel Maximum trajectory acceleration. Max value may depend upon the load inertia and
peak current-Min:0. Default: 0.5 x velocity loop Accel. Limit value.

Max Decel Maximum.trajectory.deceleration. Max value may depend upon the load inertia and
peak current. Min:0. Default: 0.5 x velocity loop Accel. Limit value.

Abort Decel Deceleration’rate used by the trajectory generator when motion is aborted. Min:0.
Default: 0.5/ velocity loop Accel. Limit value.

Note that setting limits to zero disables the trajectory generator so that the command input
is not limited by.the generator. Velocity is only limited by the Velocity Limit set in the
Velocity Loop.

Analog Command Notes

The amplifier;ean be driven by an analog voltage signal through the analog command
input-“The-amplifier converts the signal to a current, velocity, or position command as
appropriate for current, velocity, or position mode operation, respectively.

The analog input signal is conditioned by the scaling, dead band, and offset settings.
Scaling

The magnitude of the command generated by an input signal is proportional to the input
signal voltage. Scaling controls the input-to-command ratio, allowing the use of an optimal
command range for any given input voltage signal range.

For example, in current mode, with default scaling, +10 Vdc of input generates a
command equal to the amplifier's peak current output; +5 Vdc equals half of that.

Scaling could also be useful if, for example, the signal source generates a signal range
between 0 and +10 Vdc, but the command range only requires +7.5 Vdc of input. In this
case, scaling allows the amplifier to equate +7.5 Vdc with the amplifier's peak current (in
current mode) or maximum velocity (in velocity mode), increasing the resolution of control.

Copley Controls Corp.



CME 2 User Guide Command Inputs

Dead Band

To protect against unintended response to low-level line noise or interference, the
amplifier can be programmed with a “dead band” to condition the response to the input
signal voltage. The amplifier treats anything within the dead band ranges as zero, and
subtracts the dead band value from all other values. For instance, with a dead band of
100 mV, the amplifier ignores signals between —100 mV and +100 mV, and treats 101 mV
as 1 mV, 200 mV as 100 mV, and so on.

200
100 Dead Band
3 o v v
5
(o]
-100
-200
-200 -100 0 100 200
Input
Offset

To remove the effects of voltage offsets between the controller and the amplifier in open
loop systems, CME 2 provides an -Qffset parameter and a Measure function. The Measure
function takes 10 readings>of the‘analog input voltage over a period of approximately 200
ms, averages the readings, and‘then displays the results. The Offset parameter allows the
user to enter a corrective offset to be applied to the input voltage.

The offset can also set up the amplifier for bi-directional operation from a uni-polar input
voltage. An example ‘of'this would be a 0 to +10 Vdc velocity command that had to control
1000 rpm CCW to41000 rpm CW. Scale would be set to 2000 rpm for a +10 Vdc input and
Offset set\to -5V, After this, a 0 Vdc input command would be interpreted as -5 Vdc, which
wouldproduce\1000 rpm CCW rotation. A +10 Vdc command would be interpreted as +5
Vdeand produce 1000 rpm CW rotation.

Monitoring the Analog Command Voltage
The analog input voltage can be monitored in the Control Panel and in the Scope Tool.
The voltage displayed in both cases is after both offset and deadband have been applied.

Analog Command in Position Mode

The Analog Position command operates as a relative motion command. When the
amplifier is enabled the voltage on the analog input is read. Then any change in the
command voltage will move the axis a relative distance, equal to the change in voltage,
from its position when enabled.

To use the analog position command as an absolute position command, the amplifier
should be homed every time it is enabled. The Homing sequence may be initiated by
CAN, ASCII serial, DeviceNet, or CVM Indexer program commands.
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7.2: PWM Input Settings

View or change the settings described below.

Parameter Description

Scaling Current mode: output current at 100% duty cycle.
Range: 0 to 10,000,000 A. Default: Peak Current value.

Velocity mode: output velocity at 100% duty cycle.
Range: 0 to 100,000 rpm (mm/sec).
Default: Maximum Velocity value.

PWM Input Type | One wire 50% or two wire 100% with direction.
Options Invert PWM input: Inverts the PWM logic.

Allow 100% output: Overrides the 100% command safety measure!
See Failsafe Protection from 0 or 100% Duty Cycle Commands (p=.63).

Invert Sign Input: In 100% duty cycle mode, inverts the polarity of the directional
input.

For more information, see PWM Input Notes (p. 62).

7.2.1: PWM Input Notes

Two Formats

The amplifier can accept a pulse width modulated signal (PWM) signal to provide a
current command in current mode and a velocity command in velocity mode. The PWM
input can be programmed for two formats: 50% duty cycle (one-wire) and 100% duty cycle
(two-wire).

50% Duty Cycle Format (One-Wire)

The input takes a PWM waveform of fixed frequency and variable duty cycle. As shown
below, a 50% duty cycle produces zero output from the amplifier. Increasing the duty
cycle toward 100% commands apositive~output, and decreasing the duty cycle toward
zero commands a negative output.

—-——  Decreasing‘Duty Cycle Increasing Duty Cycle

e I

50 % Duty Cycle

Amplifier Output 0 A cccccccccecccececcccccccccacanns

Max -

The'command can be inverted so that increased duty cycle commands negative output
and vice versa.
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100% Duty Cycle Format (Two-Wire)

One input takes a PWM waveform of fixed frequency and variable duty cycle, and the
other input takes a DC level that controls the polarity of the output. A 0% duty cycle
creates a zero command, and a 100% duty cycle creates a maximum command level. The
command can be inverted so that increasing the duty cycle decreases the output and vice

versa.

100%

100%
Duty Cycle

Duty Cycle

ui R A N RS

Direction Input

Amplifier Output 0

Min -

Failsafe Protection from 0 or 100% Duty Cycle Commands

In both formats, the amplifier can be programmed 1o interpret O or 100% duty cycle as a
zero command, providing a measure of safety in-case of controller failure or cable break.
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7.3:

7.3.1:
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Digital Position Input Settings

View or change the settings described below.

Parameter Description

Control Input Pulse and Direction: One input takes a series of pulses as motion step commands,
and another input takes a high or low signal as a direction command.

Pulse Up / Pulse Down: One input takes each pulse as a positive step command,
and another takes each pulse as a negative step command.

Quadrature: A/B quadrature commands from a master encoder (via two inputs)
provide velocity and direction commands.

Increment position Rising Edge: Increment position on the rising edge of the input pulse.

on Falling Edge: Increment position on the falling edge of the input pulse,
Stepping Input Pulses: Number of Input Pulses required to produce output counts.
Resolution Range: 1 to 32,767. Default: 1.

Output Counts: Number of Output Counts per given number<f input pulses.
Range: 1 to 32,767. Default: 1.

Invert Command When selected, inverts commanded direction.

For more information, see Digital Position Input Notes (p. 64).

In position mode, set the Trajectory Limits described below;

Parameter Description For More Information

Max Velocity Maximum trajectory velocity. Max value may Notes on the Position Mode and
depend upon the back EMF and the Max Position Loop (p. 109)
feedback count. Min:0. Default: 0.25xX motor
velocity limit.

Max Accel Max trajectory acceleration. Max value may

depend on load inertia and peak-current, Min:O0.
Default: 0.5 x velocity loop Aecel. Limit-value.
Max Decel Maximum trajectory deceleration.-Max value
may depend upon the load inertia-and peak
current. Min:0 (disables limit):\Default: 0.5 x
velocity loop Accel. Limitvalue:

Abort Decel Deceleration rate-used-by the trajectory See Brake/Stop Notes (p. 47).
generator when motion'is aborted. Min:0
(disables«limit). Default: 0.5 x velocity loop
Accel.Limit value.

Optionally use Clear Limits to set Velocity, Acceleration, and Deceleration limits to zero
and use Set Defaults’to restore these limit values to defaults.

Note that settinglimits to'zero disables the trajectory generator so that the command input
is not limited by'the generator. Velocity is only limited by the Velocity Limit set in the
Velocity Loop.

Digital Position Input Notes

Three, Formats

In‘position‘mode, the amplifier can accept position commands using one of these signal
formats: pulse and direction, count up/count down, and quadrature.

In all. three formats, the amplifier can be configured to invert the command.

Pulse Smoothing

In digital position mode, the amplifier’s trajectory generator can be used to create
trapezoidal profiles, with programmed acceleration, deceleration and velocity, from a
simple pulse train or burst of pulses

To bypass the trajectory generator while in digital or analog position modes, set the
maximum acceleration to zero. The only limits in effect will now be the velocity loop
velocity limit and the current limits. (Note that leaving the maximum acceleration set to
zero will prevent other position modes from operating correctly.)
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Pulse and Direction Format
In pulse and direction format, one input takes a series of pulses as motion step
commands, and another input takes a high or low signal as a direction command, as

shown below.

B

Pulse Input

Direction Input

Velocity /
Command  =d = = = = m e m e m e e ———— e e R = e == e == /7

The amplifier can be set to increment position on the(ising or falling edge of the signal.
Stepping resolution can be programmed for electronic gearing.
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Count Up/Count Down Format

In the count up/count down format, one input takes each pulse as a positive step
command, and another takes each pulse as a negative step command, as shown below.

Up Input \|—|_|—|_|—|/

Velocity /
Command = = = = & = & & f e e = - - - - - == - /7

The amplifier can be set to increment position on the rising-or falling edge of the signal.
Stepping resolution can be programmed for electronic_gearing.

Quadrature Format

In quadrature format, A/B quadrature commands-froma-master encoder provide velocity
and direction commands, as shown below.

Alnput

B Input

Velocity /
Command B

The ratio.can be programmed for electronic gearing.
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CHAPTER

8: CAN NETWORK CONFIGURATION

A CANopen network can support up to 127 nodes. Each node must have a unique and
valid seven-bit address (Node ID) in the range of 1-127. (Address 0 should only be-used
when the amplifier is serving as a CME 2 serial port multi-drop gateway.)

If the amplifier is under DeviceNet control, see Copley DeviceNet Programmer’s Guide.

Configure a CAN interface

Verify that the CAN network has been cabled and terminated as-per amplifier documents.

Ml Click CAN Configuration to open the CAN Configuration screen. (If CAN is not
the Position Loop Input, choose Amplifier>Network Configuration instead.)

CAN Configuration x|

~Input Mapping————— (

Bit Rate: |G Mumber of Inputs: |4 = I 3 \%
~Address Configuration &Q
Bit O IIN2 - I S
[~ Use Switch ) O
[¥ Use Inputs Bit: 1: IIN3 gi Ob
)

¥ Use Programmed Yalue Bit 2: m\ M <
Siibch Yalue; Bit !4IN5 v.[

Input Lines Yl 14 5%\9 . W
NPUE Lines ¥alue; . -~ 3
B [ronES

Programmed Yalue; I 1 ’
Q1 et @y ~
Mews Resulking Address; 153 =
Q\) < ﬁt t|Mone -
’\C) ~
The amplifiermust be reset For the new settings to take affect,

N 00

$a@& Rﬁ(s rr Save & Close | Cancel | Help |
[ O\

3 Choose a Bit Rate and choose any combination of address sources (Switch, Inputs, and
Programmed Value). The address is the sum of the values from these sources.

(Note that options may vary based on
amplifier model and configuration.)

-V N

4 For.each source selected, perform the additional steps described below.

Source Additional Steps

Use Switch Verify the S1 switch setting. (Assigns values for Bit 0 — Bit 3 of CAN address.)
Use Inputs Enter Number of inputs. Choose an input to represent each CAN address bit.
Use Programmed Value | Enter the Programmed value.

5 Click Save & Reset to save changes to amplifier flash, close the screen, and reset the
amplifier. Click Save & Close to save changes to amplifier flash without resetting.
NOTE: CAN address and bit rate changes take effect only after power-up or reset.
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CAN Network Configuration
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CHAPTER

9: FAULTS

This chapter shows how to configure the amplifier’s fault latching. Perform the basic steps
outlined below. Details follow in the chapter:

1 Senter=T ) Click Configure Faults to open Faults Configuration screen.

Fault Configuration x|

rLatch Fault

[¥ Short Circuit

¥ &mp Over Temperature
¥ Maokor Owver Temp

[~ Cwer volkage

™ Under Valkage

¥ Feedback Errar

[~ Makar Phasing Errar

[+ Fallawing Errar

[~ Command Input Fault

~Cptional Faults

[~ Crver Current (Latched)

Restore Defaults |

Cancel | Help l
(%o

2 Select the faults to'latch. See Fault Configuration Parameters (p. 70).

Click OK to close screen and save changes to amplifier RAM.

Iﬂl On the\Main screen, click Save to Flash to avoid losing the changes.

Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifier re-enables
the PWM output stage without operator intervention. In this case, motion
may re-start unexpectedly. Configure faults as latched unless a specific
situation calls for non-latched behavior. When using non-latched faults, be
sure to safeguard against unexpected motion.

DANGER Failure to heed this warning can cause equipment damage, injury, or
death.
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9.1: Fault Configuration Parameters

70

CME 2 User Guide

Each of the following faults can be latched by selecting it on the Fault Configuration
screen. For more information on latching, see Fault Latching Notes (p. 71). For details on
limits and ranges, see the amplifier documentation.

Note: The list of faults may vary with amplifier model.

Fault Description

Fault Occurs When...

Fault is Corrected When...

*Amp Over
Temperature

Amplifier's internal temperature
exceeds specified temperature.

Amplifier’s internal temperature falls
below specified temperature.

Motor Phasing Error

Encoder-based phase angle does not
agree with Hall switch states. This
fault can occur only with brushless
motors set up using sinusoidal
commutation. It does not occur with
resolver feedback or with Halls
correction turned off.

Encoder-based phase angle agrees
with Hall switch states. See Trouble
Shoot Manual Phase'w/ Encoder and
Halls (p. 90).

*Feedback error

Over current condition detected on
output of the internal +5 Vdc supply
used to power the feedback.

Resolver or analog encoder not
connected or levels out of tolerance.

Differential signals from incremental
encoder not connected.

Encoder.power returns to specified
voltagewrange.

Feedback signals stay within
specified levels.

Differential signals connected.

*Motor Over Temp

Motor over-temperature switch
changes state to indicate an-overs
temperature condition.

Temperature switch changes back to
normal operating state.

Under Voltage Bus voltage falls below specified Bus voltage returns to specified
voltage limit. voltage range.
Over Voltage Bus voltage exceeds specified voltage | Bus voltage returns to specified

limit.

voltage range.

*Following Error

User set\following-error threshold
exceeded.

See Position and Velocity Error Notes
(p- 72).

*Short Circuit Detected

Output to-output, output to ground,
internal PWM bridge fault.

Short circuit has been removed.

Command Input Lost

PWM.or other command signal not
present.

Command signal restored.

Over Current (Latched)

Output current I°T limit has been
exceeded.

Amplifier is reset and re-enabled.

*Latched by default:
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9.2:
9.2.1:

9.2.2:

9.2.3:

Fault Latching Notes

Clearing Non-Latched Faults

The amplifier clears a non-latched fault, without operator intervention, as soon as the fault
condition is corrected.

Risk of unexpected motion with non-latched faults.

After the cause of a non-latched fault is corrected, the amplifier re-enables the PWM
output stage without operator intervention. In this case, motion may re-start
unexpectedly. Configure faults as latched unless a specific situation calls for non-
latched behavior. When using non-latched faults, be sure to safeguard against

DANGER unexpected motion.

Failure to heed this warning can cause equipment damage, injury; or death.

Clearing Latched Faults

A latched fault is cleared only after the fault has been corrected.and at least one of the
following actions has been taken:

o Power-cycle the amplifier

e Cycle (disable and then enable) an enable input that-is configured as
Enables with Clear Faults or Enables with Reset

o Access the CME 2 Control Panel and press Clear Faults or Reset
o Clear the fault over the CANopen networkZer serial bus

Example: Non-Latched vs. Latched Faults

For example, the amplifier temperature‘\reachessthe fault temperature level and the
amplifier reports the fault and disables the PWM output. Then, the amplifier temperature
is brought back into operating range. If the/Amp Over Temperature fault is not latched,
the fault is automatically cleared,and.the amplifier's PWM outputs are enabled. If the fault
is latched, the fault remains active and the amplifier's PWM outputs remain disabled until
the faults are specifically cleared-(as described above).
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9.3:
9.3.1:

9.3.2:

9.3.3:

9.3.4:
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Position and Velocity Error Notes

Error-Handling Methods

In position mode, any difference between the limited position output of the trajectory
generator and the actual motor position is a position error. The amplifier’s position loop
uses complementary methods for handling position errors: following error fault, following
error warning, and a position-tracking window.

To set position error handling parameters for servo amplifiers, see
Enter basic Position Loop settings (p. 104). For stepper amplifiers, see
Set Position Limits in Stepper Mode (p. 118).

Likewise, in velocity or position mode, any difference between the limited velocity
command and actual velocity is a velocity error. The amplifier's velocity-loop uses a
velocity tracking window method to handle velocity errors. (There is no velocity error fault.)

To set parameters for velocity error handling, see

Enter basic Velocity Loop settings (p. 100).

Following Error Faults

When the position error reaches the programmed fault threshold, the amplifier
immediately faults. (The following error fault can be disabled.)

For detailed information, see Following Error FaultDetails (p. 73).

Following Error Warnings

When the position error reaches the programmed. warning threshold, the amplifier
immediately sets the following error warning bit in the status word. This bit can be read
over the CAN network. It can also be used to-activate a digital output.

Position and Velocity Tracking Windows

When the position error exceeds the programmed tracking window value, a status word
bit is set. The bit is not resetwuntil the position error remains within the tracking window for
the programmed tracking time.

A similar method is used-to handle velocity errors.
For detailed information, see Tracking Window Details (p. 74).
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9.3.5: Following Error Fault Details

Position Error Reaches Fault Level

As described earlier, position error is the difference between the limited position output of
the trajectory generator and the actual position. When position error reaches the
programmed Following Error Fault level, the amplifier faults (unless the following error
fault is disabled.) As with a warning, a status bit is set. In addition, the fault is recorded in
the error log. See Error Log (p. 146).

Additional responses and considerations depend on whether the fault is non-latched-or
latched, as described below.

Amplifier Response to Non-Latched Following Error Fault

When a non-latched following error fault occurs, the amplifier drops into_velocity mode
and applies the Fast Stop Ramp deceleration rate to bring the motor to-a’halt. The
amplifier PWM output stage remains enabled, and the amplifier haolds'the velocity at zero,
using the velocity loop.

Resuming Operations After a Non-Latched Following Error-Fault

The clearing of a non-latched following error depends on the amplifier's mode of
operation. Issuing a new trajectory command over the. CAN bus, the ASCII interface, or
DeviceNet will clear the fault and return the amplifier.to -normal operating condition.

If the amplifier is receiving position commands from.the digital or differential inputs, then
the amplifier must be disabled and then re-enabled using the amplifier’s enable input or
though software commands. After re-enabling,-the(amplifier will operate normally.

Amplifier Response to a Latched Following Error Fault

When a latched following error fault eccurs,.the amplifier disables the output PWM stage
without first attempting to apply a deceleration rate.

Resuming Operations After a-Latched Following Error Fault

A latched following error fault.can be cleared using the steps used to clear other latched
faults:

e Power-cycle the amplifier

¢ Cycle (disableland then enable) an enable input that is configured as
Enables with-Clear-Faults or Enables with Reset

e Access the CME.2 Control Panel and press Clear Faults or Reset
e Clearthe fault-over the CANopen network or serial bus
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9.3.6: Tracking Window Details

Proper Tracking Over Time

As described earlier, position error is the difference between the limited position output of
the trajectory generator and the actual position. Velocity error is the difference between
commanded and actual velocity.

When the position or velocity error exceeds the programmed fracking window value, a
status word bit is set. The bit is not reset until the error remains within the tracking window
for the programmed tracking time.

Velocity Tracking lllustration

The following diagram illustrates the use of tracking window and time settings,in velocity
mode.

Actual Velocity

Limited Velocity + Tracking Window

Tracking Window
Output
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CHAPTER

10: MOTOR PHASING

This chapter shows how to phase the motor using the Auto Phase or Manual Phase.tool.
Perform the basic steps outlined below. Details follow in the chapter.

Use the procedure described in this chapter to
Phase Motor with Auto Phase (p. 76).

OR

Use the procedure described in this chapter to
Phase Motor Manually (p. 85).
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10.1:

10.1.1:

1
2

Phase Motor with Auto Phase

Choose the appropriate procedure:

Auto Phase Example: Servo Amplifier (p. 76)

Auto Phase Example: Stepper Amplifier, No Encoder (p. 80)

Auto Phase Example: Stepper Amplifier with Encoder, in Stepper Mode (p. 81)

Auto Phase Example: Stepper Amplifier with Encoder, in Servo Mode (p. 82)

NOTE: The examples in this chapter show particular amplifier operating modes and motor
feedback configurations. Some screens and choices may vary from those described here.
Auto Phase Example: Servo Amplifier

Perform the following steps to Auto Phase a servo amplifier.

NOTE: The following steps show Auto Phase with a brushless rotary motor,digital Halls,
and an incremental quadrature encoder. Screens vary for other configurations.

Verify that the Enable Input is not activated and that HV or AC power is applied.

EI Click Auto Phase to open the Auto Phase Motof Direction Setup screen.
Enutu Phase x|

Motor Direction Setup

Move the motar in the direction that you want
to he positive. Press MNextwhen dane.

Mokor Actual Position: 0 counts

Release Brake | Dbt = Skip = | Eancel |

Move the motor in the direction to be-considered positive

OR if you cannot move the-motor; click Skip (you will confirm motor direction later).
NOTE: If an output is configured as a brake you can temporarily release the brake by
holding down the Release Brake button. The brake will be reactivated when you
release the button.

Click Next to-opencthe Auto Phase Motor Wiring Setup screen:
husorhase T S/, x
MotorWiring Setup Commanded Motor Phase Angle
The software will figw micro step the motor in Tr S o

the positive direciton. Make sure the motor is
free to move, “Press Start when ready.

120 o]
AltaPhase Current:l 0.47 A 210 ‘ 230

240 300

270
Increment Rate: I 890 elec deglfsec

Actual Position: 0 counts

Sl I iy | Feady

150 30

= Back Cancel

Continued...
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...Continued:

Activate the Enable Input.

Click Start to begin the motor wiring setup.

The message area displays messages: Configuring Initial Settings, Microstepping, Test

Complete, Motor Wiring has been configured.

During microstepping, a current vector is applied to the motor windings and
microstepped through an electrical cycle at a set rate, causing the motor to.move.

If you chose to Skip the motor direction setup step, Auto Phase will prompt for
confirmation of correct motor direction.

If the step fails see Motor wiring setup problems (p. 84).
NOTE: If incorrect values were entered for inductance and-resistance, the calculated
Cp and Ci values may produce current loop oscillation, evidenced by an audible high

frequency squeal during auto phasing.

7 Click Next to open the Auto Phase Phase Count Test screen.

p.
*
Phase Count Test Commangd r@a)e Angle
The software will now micro step the motor in & an
the negative direciton. Make sure the motor is @ 123 &0
free to maove. Press Start when reacdy. @ 154 30
s\ ‘.180 / i

Auta Phase Current:l 147 & N %% Q\TID 230
NN

*
240 270 200
Increment Fate: I 80 elec da@ $

@6 ®Ac‘tual Matar Position: 0 counts

e o | X 0%
. . . 0 & Ready
Configurstion Settings
counts per rey 4000 s\o
‘\f\\ \@
Pz N XD = Back | Skip = | Cancel |
N\O
8 Click Start'to begin the Phase Count Test. Observe status messages. See the prompt:
Phase Counts x|
~ O

hserve motor mation and werify
that it rmowes 1 full turn.

Continued...
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10

11

12

...Continued:

When you are ready to observe motion, click OK. See the prompt:

Phase Counts |

@ Did matar move 1 full turn?
1w |

If motor did not turn 1 full turn, click No and see Phase count test problems-(p- 84).

If motor turned 1 full turn, click Yes.
The message area displays progress and completion messages.

For a resolver (—R) version of a Copley Controls amplifier, skip.to Step 13 (p. 79).
For a non-resolver amplifier, click Next to open the Hall Wiring Setup screen.
X

Hall Wiring Setup Commanded Motar Phase Angle
& Hall State

The software will now micro step the motaor. N

Make sura the matar is free to maove. . . Q
60 \

4

Fress Startwhen ready. 120

Pizo s C
Auto Phase Currant: I 1.2 A \
Increment Rate: I 490 elec degisec . .\)%

Stop |

Hall Offset: 0 deg ’\(O
%,

5" ¥
,.Q ;‘es_ck | Eirish | Cancel |

Click Startto begin.the Halls wiring setup. The message area displays the messages:
Microstepping..-Test Complete. Motor has been properly phased.

Feady A

During microstepping, a current vector is applied to the motor windings and
microstepped through an electrical cycle at a set rate, causing the motor to move. As
the motor moves the Hall lines are decoded for proper commutation.

Ifthe step fails, see Halls wiring setup problems (p. 84).

Continued...

78
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Motor Phasing

...Continued:
13 For a resolver (-R) version of a Copley Controls amplifier, click Next to open the
Resolver Phase Angle Setup screen.
x|
Resolver Phase Angle SetuP Resolver angle inred. Commanded
Fosition your motar in center of its range. motor phase angle in hlack
The software will now micro step the motar.
Make sure the motar is free to move.
Fress Start when ready. 490 &0
Auto Phaze Currert: I TE A 180 L o
Start | 240 300
Oftset 0 deg
Rezolver Angle 119 deg Testing Phasze ingle
tdator Actusl Position: -11 counts
= Back | Einizh | Cancel |
14 Click Start to start the resolver phase angle setup. The message area displays status
messages.
15 Click Finish to close the screen and savevalues to flash memory
OR to close the screen without saving ‘changes, click Cancel.

Phase Current and Increment

If the Auto Phase algorithm-does notproduce desired results, try adjusting the Auto

Rate values, using the guidelines in

Guidelines for Choosing AutacPhase Current and Increment Rate Values (p. 84).

If desired results-are notabtained, or to confirm results, proceed to

Phase Motor Manually (p. 85).
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10.1.2: Auto Phase Example: Stepper Amplifier, No Encoder

1 Verify that the Enable Input is not activated and that HV power is applied.

|
m Click Auto Phase to open the Auto Phase Motor Direction Setup screen.

@ Auto Phase |

Motor Direction Setup

Make sure the matar is free to mave, Mawe matar and observe direction.
Motor direction can be changed by clicking Invert Motor output check box

Yelocity I 20 rpm Ready
Acceleration I 3 rps?
Deceleration I 3 rps?

Move NEG |
[~ Irvert Mokor Cukpok Ok | Cancel |
3 Hold down Move POS to move the motor in the direction considered positive, and

observe the direction of movement.
If the motor does not move see Motor wiring.setup problems (p. 84).

4 If the motor moved opposite the direction that you wish to program as positive, click
Invert Motor Output.

5 Click OK to save the direction setting.
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10.1.3: Auto Phase Example: Stepper Amplifier with Encoder, in Stepper Mode

1 Verify that the Enable Input is not activated and that HV power is applied.

|
Click Auto Phase to open the Auto Phase Motor Direction Setup screen.
@ﬁutu Phase ﬁl

Motor Direction Setup
Move the motar in the direction that you want
to be positive. Press Mextwhen done.

IMokor Actual Position: 578 counts

Skip = | Cancel |

Move the motor in the direction you wish to be considered positive.
Activate the Enable Input.

Click Next to open the Auto Phase Motor Wiring Sétup screen.

O Qul
0

Motor Wiring Setup &Q)
The software will mave the motaor. Make sure the ®~ @
motor is free to move. Press Startwhen ready. @ %
O o
I¥otor Actual n: 0 counts

- e O O
Welocity: 4,39 rpm Ready

¢ O
Stop I \
0% ‘Ktvﬁack | Eimish | Cancel |
D«
6 Click Start to begin motor wiring setup with default values.

After successfulmotor wiring setup, the message “Test Complete” appears.

7 Click Finish)to close the screen and save values to flash memory.
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10.1.4: Auto Phase Example: Stepper Amplifier with Encoder, in Servo Mode

1 Verify that the Enable Input is not activated and that HV power is applied.
]

Click Auto Phase to open the Auto Phase Motor Direction Setup screen.
@ﬁutu Phase ﬁl

Motor Direction Setup

Move the motar in the direction that you want
to be positive. Press Mextwhen done.

IMokor Actual Position: 578 counts

Skip = | Cancel |

Move the motor in the direction you wish to be considered positive.
Activate the Enable Input.

Click Next to open the Auto Phase Motor Wiring Sétup screen.

o O A~ W

’,
Motor Wiring Setup Con}ﬁded Mo‘t.wase Angle
a0

The software will now micra step the matar, \@ 120 &0
Make sure the motar is free to mave. O
Press Startwhen ready. %

*

Eﬁuto Phase T\'j \_C)_\ il

A50 20

. N 180 a
NN ~
Auto Phase Current:l 239 A ® $ 210 30

240 200

270
Increment Rate: I 2250;?)3%: de %Q
0‘0 \u)
s\O& Motor Actual Position: 0 counts

\@ Reay
N

< Back [dext = | Cancel

Continued-..
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...Continued:

7 Click Next to open the Auto Phase Motor Phase Initialize screen:

x|
Motor Phase Initialize

The amplifier will perform phase intialization. Make sure the
maotar is free to mave. Press Initialize Phase when ready.

< Back | Einish | Cancel |

8 Click Initialize Phase to start phase initialization. If successful, this message appears:
“Test Complete. Phasing has been initialized.”

9 Click Finish to close the screen and save values t0-flash memory.

10  After clicking Finish, the following message appéarsif changes were made:
x|

@ Mew configuration will be saved to amplifier flash.

Motor encoder wiring has changed.

.
Data file should be saved again. 5’\\

11  Click OK.
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10.2: Guidelines for Choosing Auto Phase Current and
Increment Rate Values

Here are some considerations in choosing Auto Phase Current and Increment Rate
values:

e [f friction is high, then more current may be required to move the load.

e High static friction may require more current to overcome stiction.

e Transition from static friction to dynamic friction, and back, may produce jerky ‘motion.
o A faster rate will operate in the dynamic friction range.

o A slower rate will operate in the static friction range.

¢ |If the friction is low, as in the case of air bearings, low frequency oscillations may
occur; thus, less current and slower rates may be required. If oscillations persist, then
friction may need to be temporarily added.

10.3: Trouble Shoot the Auto Phase Process

1 Motor direction setup problems

If motor direction setup step failed:

= Check Encoder or resolver power and signals.
= Verify that the encoder is differential. (Centactfactory if encoder is single-ended.)
= Check shielding for proper grounding.

2 Motor wiring setup problems

If motor wiring setup step failed:

= Verify that amplifier is disabled.

= Check for mechanical jamming:

= Check for smooth motion with no mechanical jerking.

= Check for good cennections to the motor power wires.

= Disconnect motorpower wires and measure for proper motor resistance.

3 Phase counttest‘problems

If phase count test'failed, verify that in the Motor/Feedback screen the following
parameters have been set correctly:

= Number-of Poles for rotary motors. See Verify the motor’s pole count (p. 90).
= _“Magnetic Pole Pair Length for linear motors

=~ Encoder Lines or Fundamental Lines for rotary encoders.

= _Encoder Resolution for linear encoders.

4~ . Halls wiring setup problems

If Halls wiring setup step failed:

= Check Halls power and signals.
= Check for smooth motion with no mechanical jerking.
= Check shielding for proper grounding.

If the auto phase procedure fails despite these corrective measures, see
Phase Motor Manually (p. 85).
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10.4: Phase Motor Manually

The CME 2 Manual Phase tool lets the user phase a brushless motor, monitor signals,
check configuration wiring, and control a microstepping current vector.

10.4.1: Manual Phase Example: Motor with Encoder

1 Make sure that no load is attached to the motor.

2 On the Main screen, choose Tools—>Manual Phase to open the window:

x|
~Configurstion————————— [ lonitor
~Hallz Mo faults.
Motor Phase Angle
Invert Input: & Hall Gtate <
Fu Fv Fw Q',
Hall Wiring: |wvu -] Hall States———— .120 BD.
I a0 1] W Wy 1
Hall Offzet: deg . . . .180 \ a .
~Motor Feedback Hi Lo Lo .240 SDD.
IV Irvert Input
Motor Phase Sngle: 116 deg %\/
rhatar——————————————————— Motor Feedback: -10915 counts<\\
v Invert Qutput
ol bt @1 Actugl Current: U 0024 e CO03A W 00 A
ya XN
—Cantral é\% \f.‘ ]
Ihcrement Rate: EID elec d@b ﬂ}é;ﬁaamar. |
DB
Current: A ez (s
" Enable o DISS%O \ ) Feew Pl
REIENNN
| LR
Restaore Defaults 6 @ QK | Cancel
O Cn

3 feldb b bl Ll
© B C o

Verify the Currentsetting and then enable the amp by selecting Enable in the Control
area of the Manual Phase window.

4 v\vv Ve Moto(ov
q =30 il
ON
Torcontrol the current vector rotation, command the motor forward or reverse.
NOTE: Some motors have bearings stiction, so helping the motor with mechanical force
is acceptable. Motors with no friction may need friction added to steady motion.

5 If the motor cannot keep up with the rate of vector rotation, then reduce the Increment
Rate or increase the Current.

6  Verify that pressing forward button moves motor forward.
If the motor moves in the wrong direction, toggle the Motor Invert Output setting.

Continued...
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...Manual Phase Example: Motor with Encoder, continued:

7  Verify actual position count agrees with direction of rotation: increasing counts in
forward direction and decreasing counts in reverse direction. If it does not, toggle the
Motor Feedback Invert Input box setting.

8 If the motor has no Halls, skip to
Phase Initialization Steps for Motor without Halls (p. 87).

9 Monitor the vector rotation through one electrical cycle for proper Hall transitions:

= Verify that the red indicator rotates in the same direction as the motor.phase angle,
and that the transition occurs when the needle is between indicators, (£30 degrees,
as shown below).
Mator Phase Angle & Hall Bate

B an’
120 B0 Wer”
L REN ”~

M0 300

= |f the needle and Hall states do not track properly, use the Hall Wiring list box and/or
Invert Input options (shown below) to swap the ampilifier’'s Hall wire configuration.
~Hall=

Invert Input:
Cu v Tow

Hall Wiring: % LW ‘I

Hall Cffzet: A
=l et Ly o

rhotor Feedhg, o |

[v ey U
v L ¢
bty -

= |f the redindicator’transition leads or lags behind the centered needle by more than
30 degrees, then try adjusting the Hall Offset in +/- 30 degree increments:

Hall ofiset | Y] deg

10  Phasing of @ motor with encoder and Halls is complete. Click OK.
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Phase Initialization Steps for Motor without Halls
The Phase Initialization function is designed to phase a motor with no Halls.

Halls are strongly recommended for safe, redundant system.

Copley strongly recommends the use of Halls or a commutating encoder for
commutation to provide a safe, redundant system. If the application requires
otherwise, the customer accepts responsibility for verifying system performance and

DANGER reliability.

Failure to heed these warnings can cause equipment damage, injury, or death.
The Phase Initialization function uses as little motion as possible (less than 1/3.0f one
electrical cycle) to determine phasing. Phase Initialization drives the motor.in-open loop
current mode, using microstepping of a current vector.

1 This procedure is a continuation of Manual Phase Example: Metor with Encoder (p. 85).
Before proceeding, verify you have completed that procedure. through Step 8 (p. 86).

2  Ensure that the motor is free to move (for instance, makKe sure the brake is OFF).

3 Ensure that no external force, such as gravity, will. cause the motor to move. If it is not
practical to eliminate such forces, it may be necessary to use the Forced Phase
feature later in this procedure.

tizeproce | To phase a motor with-an-encoder and no Halls, click Initialize Phase.

Observe the status messages under Monitor.

5 If the message “Phase Initialized”-appéars, the phasing of a motor with encoder and no
Halls is complete. Click OK to-close:.the Manual Phase window.

6 Phase Initialize C If the phasing function fails (for instance,
Time: | 400 [ message “Phase Initialized” is not displayed,
Cuent: | 1454 & ! or if a phasing fault is indicated) adjust the
(Current set to 0 uses 1Péak) phase initialization settings described below
I~ Farced Phase and try Step 4 (Initialize Phase) again.

[~ Increment Phase 90 deg

[~ Use offser Tnitialize Phase |

Setting Description

Time Used first as a delay, allowing amplifier to ramp up current to drive a small move.
Then used as a settling time. If the value is too low, the settling may not occur in
time, possibly resulting in jerky motion. Default: 400 mS.

Current Use to overcome stiction when rotating current vector. If the current is too large,
motion may not settle; a low value may not provide enough current to drive a move.

Forced Phase When selected, Forced Phase causes the Phase Initialization function to apply
Phase Init Current to alternate pairs of motor wires using the Phase Init Time. Forced
Phasing has been used to overcome various phasing problems, including situations
where gravity introduces unwanted motion. Forced Phasing tends to produce more
jerk and apparent motion.

Increment If set, the amplifier will increase the starting phase angle by 90 degrees after every
Phase 90 deg failed initialization attempt.
Use Offset If set, the amplifier uses the Hall Offset value as the initialization starting angle.
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10.4.2: Manual Phase Example: Motor with Resolver

Make sure that no load is connected to the motor.

On the Main screen, choose Tools>Manual Phase to open the window:

Manual Phase x|
Configurstion rhanitor
Mo faults.
ek Motor Phase angle Black

Besolwver Angle in RFed

Offzet I 150 deg

Reszalver 120 g0

rMator Feedback———————— 180 a
Angle 358 deg
Iv Irwert Ingpot

240 300
Motor Phase Angle: 108 deq

Fositian -240  counts

Actual Current:  L: 0.02 A W 0.01 A gac -0.03 &

Coantral b ]

Increment Rate: I 90 elec degis Set ZeraPostion |
. I 047
U & e hoter

" Enable % Disable Fey | o |

Restare Defaults | QK | Cancel

POTFTR R =TR T -

& Engbld ¢ Disable

Verify the Current setling and-then enable the amp by selecting Enable in the Control
area of the Manual‘Phase window.

Move Motor
Rev Pl

To control the ‘eurrent vector rotation, command the motor forward or reverse.
NOTE: Some motors have bearings stiction, so helping the motor with mechanical force
is_.acceptable. Motors with no friction may need friction added to steady motion.

If the motor cannot keep up with the rate of vector rotation, then reduce the Increment
Rate or increase the Current.

Verify that pressing forward button moves motor forward. If it does not, toggle the Motor
Invert Output box setting.

Verify actual position count agrees with direction of rotation: increasing counts in
forward direction and decreasing counts in reverse direction. If it does not, toggle the
Motor Feedback Invert Input box setting.

Continued...

88
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...Manual Phase Example: Motor with Resolver, continued:

8  Adjust Resolver Offset configuration as required, testing Fwd and Rev, to produce
alignment of Motor Phase Angle with Resolver Angle as shown here.

Motor Phase Angle Elack
Fezolwer Ahgle in Red

120 1]

180 \ a

240 300

T\Iote: Motor manufacturers typically align the resolver in 30 degree.increments, typically
by applying current through a pair of motor power wires.
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10.5: Trouble Shoot Manual Phase w/ Encoder and Halls

90

To perform trapezoidal commutation after power-up or reset, the amplifier must receive
good Hall signals. After the first Hall transition is detected, then sinusoidal commutation
can be performed. In sinusoidal commutation, the amplifier uses the encoder for
commutation while monitoring the Halls to verify proper phase. If the error between the
encoder count and Hall transition is too large, then the Hall phase correction will not be
performed and a phase fault will be triggered.

Test for phase fault problems in the order shown below.

41 Data accuracy test

=  Verify the motor’s pole count:

= Apply a current vector at zero Increment Rate to lock metorvin position.
= Turn the motor shaft and count the number of distinctloeking positions.
= Calculate the number of poles: Poles = number of Jocking positions * 2

=  Verify the encoder line count OR a linear motor's magnetic pair length and the
encoder resolution.

2 Encoder wiring test

= |f the Halls produce good trapezoidal commutation but a phase fault is persistent
in sinusoidal commutation mode, the.encoder is highly suspect. Try this:

Verify the differential encoder/signals:.

Verify proper twisted shielded cable)ywith good grounding.

Disable the amplifier and move/the’motor manually to test for phase fault.
If phase fault only occurs under command of current, make sure the motor
power cable is not.bundled with the encoder cable.

3 Hall signals test

= If you suspectthe Halls’signals are faulty, try this:

= Make sure Halls-change states as the motor moves through one electrical

cycle.

= Some Hall.signals are noisy and require filtering. Check with motor
manufacturer.

= ."Some-Halls are not properly calibrated to the motor manufacturer’s
specification.

4- Hall transition test

=" If you suspect that the location of the Hall transition is not within +/-30 degrees, try
this:

= Adjust Hall offset in smaller increments.
= Verify Hall alignment.
= Make sure motion is smooth.
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CHAPTER

11: CONTROL LOOPS

This chapter shows how to program and tune the control loops. Perform the basic steps
outlined below. Details follow in the chapter.

For each control loop:

T |°,-’ i | or’ o |C|ick the appropriate button to open the l6op’control screen.
2 B % Changel/verify settings as needed.

3 oo | Click Close to close screen and save changes to-amplifier RAM.

4 Click to open the Scope tool.

5

Run a function or profile and’adjust'settings to tune the loop.

1

N o
Trace Status: Readifigiate daizi -

For an overview;of control loop theory, see
Servo/Operating Modes and Control Loops (p. 11).
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11.1: Current Loop Setup and Tuning

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can be
calculated with The Calculate Function (p. 48).

Enter basic Current Loop settings

92

1 v | L .
il Click | Loop to open the Current Loop screen:
=101
Current
Offzet
Commanded + Correcting

o Compenzator Torque |

Current N _//_ =
+ p+Ci

Peak Current Limit:
IT Tirne Lirnik:
Continuous Current Limit:

Current Loop Offset:

x A ctual
Current

& Cp: | i il

meo g | 0 il

) Drive Cuktput
% Maximize Smoothress

" Maximize Speed !
1

Ao Tune | Bandvdet |

Close |

Change/verify Current Loop parameters-as needed.

Parameter

Description

Peak Current Limit

Used.to limitthe peak phase current to the motor. Max value depends upon the
amplifier model; Min value > continuous limit.

I>T Time Limit

Sets I°T Time Limit in mS. See I°T Time Limit Algorithm (p. 155).

Continuous Current
Limit

Used-to limit the Phase Current. Max Value is < Peak Current and depends upon
the amplifier model. Min value: 0

Current Loop ‘Offset

Sets current loop offset. Leave it set to zero until after tuning. For more
information, see Offset (p. 98).

Cp

Current loop proportional gain. Range 0 — 32,767.

Ci

Current loop integral gain. Range 0 — 32,767.

Drive Output

Maximize Smoothness: Amplifier uses circular vector limiting to produce
smooth operation even into the voltage limits.

Maximize Speed: Allows for slightly more of the bus voltage to be used when in
the voltage limit. This may produce a small disturbance at top speed.

Auto Tune

See Current Loop Auto Tune (p. 95).

Bandwidth

Measure bandwidth using the Cp and Ci values now in the amplifier.

Click Close to close screen and save changes to amplifier RAM.
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Manually tune the Current Loop

METHOD: Apply square-wave excitation to the current loop and adjust current loop

proportional gain (Cp) and current loop integral gain (Ci) to obtain a desired waveform.
For instance:
r@C!lst.i]lusmpe

l% Trace Status: Reading trace data from amplifier

0000 0002 0004 00068 0002 0040 0042 00414 0048 0042 0020 0022 : 0.026

Time (zaconds) a
A h

NOTES:
1) During tuning, observe any warnings that appear to the\left of the trace.
2) Some users prefer the Auto Tune feature. See Current'Loop Auto Tune (p. 95).

1 z
Click the Scope Tool.
2 Apply T |C it
ply To: urre
Choose Current from the
Function Generator Apply To: list.
3 W fde S O the Settings tab,“make sure Auto Setup is selected.
Auto Setup automatically sets‘the following parameters:
Function Generator Tab
Parameter Description
Excitation Square/Wave.
Amplitude 10% of continuous current value.
Frequency 100 Hz.
Settings Tab
Channel1 Commanded current (green).
Channel 2 Actual current (white).
4 ’ﬂ\'ml}plitu 047 A ! . . .
.J§ Verify that the Amplitude value is not excessive for the motor.
Continued...
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94

...Continued:

5

7
8

9

_sen| Click Start.

On the Gains tab, adjust current loop proportional gain (Cp):

= Set current loop integral gain (Ci) to zero.

= Raise or lower Cp to obtain desired step response. (Typically, little or‘no-overshoot
with a 100 Hz, low-current square wave.) If the Cp value is too large, ringing may
occur. If the Cp value is too low, bandwidth decreases.

Adjust current loop integral gain (Ci) until desired settling time is_ebtained.

&l Press Stop to stop the function generator.

Iﬂl On the Main screen, click Save to Flash to-avoid losing the changes.
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11.2: Current Loop Auto Tune

Tune the Current Loop with Auto Tune

METHOD: The current loop Auto Tune algorithm applies a square-wave command to the
current loop and adjusts current loop proportional gain (Cp) and current loop integral
gain (Ci) until a desirable waveform is obtained.

Initial current loop proportional gain (Cp) and current loop integral gain (Ci) values can
be calculated with The Calculate Function (p. 48).

1 vl L .
il Click | Loop to open the Current Loop screen:
=il
Current
Offzet
Eoncﬂmandted + L - t Egul_rreu:ling
uren| N _/_ : . Com perls%ior orque
x Actual
Current

Peak Current Limit: I 13.95 & Cpe I 2897 ﬂ C)
I2T Time Lirit: I 1000 ‘ms Cit 285 ﬂ Q
Continuous Current Limit: I 4,68 A |'Drive OutputJ Q,’

*

{* Maximize Smoothne: %

Current Loop OFfset: I oA W il 5 @k \
AN

\Y (GR
Aut-ﬁ@@‘l QQ)" Bandwidth |
%O' N2 |

Close
0&

X%

2 Verify that the amplifier is, hardware enabled.

ot | Click Auto Tune to open screen and start the Current Loop Auto Tune.

@Eurrent Loop Auto Tune ;lglll
N7

O
9

a3

(2

N
Auto Tune Current: I 1 Status: Auto Tune in progress.
cp: 10 cit 0 Start | Stop |

4 To Change the Auto Tune Current, Press Stop, enter the new current in the Auto Tune
Current field, and then press Start.

Continued...
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... Tune the Current Loop with Auto Tune, continued:

5 Observe the Auto Tune process and results. A typical example:
= Sets Cp and Ci to zero and then adjusts Cp and Ci for optimal values.

Eturrent Loop Auto Tune ;lglﬂ

Auto Tune Current: I 1 Status: Auto Tune in progress.
cp 2538 Gi: 0 Start | Stop | i
=\ _J

= Uses a frequency sweep to determine the small signal, current loop bandwidth.

@rurrent Loop Auto Tune =10

LA
AV 4 I

INS™ Y
Auto Tune Current: 1 Status: Auto Tunefinished
\J \ <
Vsznu;o
)
S oF MW

Displays the results: a set of Cp and Ci alternatives, and the bandwidth measured using
the high Cp and Ci values.

Enuto Tune Results

x|
\J

Auto Tune has determin@wvalu& p and Ci along with a

high handwidth meas&@ nt. S%t sired settings.

" High \§ 2458 (b' 167 Bandwidth: 2100 Hg
A

G‘W cp. 481 ¢ 94

>
c’;‘,‘g’w @pe el o o

~
(‘O@a Ccp 1393 g 123

l".o & Save Cp and Cito Flash
\
N
= Keep Cp and Ciin RAM only
Cancel |
Continued...
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... Tune the Current Loop with Auto Tune, continued:

6 Choose an action based on Auto Tune results.

= Choose which set of values to save: High, Medium, Low, or Original.

The Medium values, selected by default, are appropriate for most applications.
= Optionally choose how to save: Save Cp and Ci to Flash

or Keep Cp and Ci in amplifier RAM only.

7 Click OK to save the values as chosen, and close the Auto Tune Results window.

Copley Controls Corp.
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11.3:
11.3.1:

Current Command—{ Current Limiter |Limited Current

Current Offset — _/_\_

11.3.2:

11.3.3:

11.3.4:

98

Notes on the Current Mode and Current Loop

Current Loop Diagram

As shown below, the “front end” of the current loop is a limiting stage. The limiting stage
accepts a current command, applies limits, and passes a limited current command to the
summing junction. The summing junction takes the commanded current, subtracts the
actual current (represented by the feedback signal), and produces an error signal. This
error signal is then processed using the integral and proportional gains to produce a
command. This command is then applied to the amplifier's power stage.

Current Loop AN

Current Integral Gain (Ci) 4] Command

Current Proportional Gain (Cp) :
A

vt
> []
0

—

Limits: Feedback (Actual Current)
o Peak Current

e Continuous Current

o Peak Current Limit Time

Current Loop Inputs

The amplifier's analog or PWM inputs.

A CANopen network via the amplifier’'sc€AN interface.

A Copley Virtual Motion (CVM) control program.

The amplifier's internal function{generatof:

In velocity or position modes, the.current.command is generated by the velocity loop.

Offset

The current loop offset is intended for use in applications where there is a constant force
applied to, or required of; the servomotor and the system must control this force. Typical
applications would be\a’'vertical axis holding against gravity, or web tensioning. This offset
value is summed-with the(Current command before the limiting stage.

Limits
The current command is limited based on the following parameters:
Limiter Description
Peak-Current’{. Maximum current that can be generated by the amplifier for a short duration of time. This
Limit value cannot exceed the peak current rating of the amplifier.
Continuous Maximum current that can be constantly generated by the ampilifier.

Current-Limit

I*T Time Limit | Maximum amount of time that the peak current can be applied to the motor before it must
be reduced to the continuous limit or generate a fault.

For more details, see I°T Time Limit Algorithm (p. 155).

Note: Although the current limits set by the user may exceed the amplifier's internal limits,
the amplifier operates using both sets of limits in parallel, and therefore will not exceed its
own internal limits regardless of the values programmed.

Ramp Rate of change in current command. Used to limit jog moves initiated from the Control
Panel Jog function in current mode, and in advanced Indexer Program functions.
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Control Loops

11.3.5: Current Loop Gains
The current loop uses these gains:

Gain Description
Cp - Current loop The current error (the difference between the actual and the limited commanded
proportional current) is multiplied by this value. The primary effect of this gain is to increase

bandwidth (or decrease the step-response time) as the gain is increased.

Ci - Current loop
integral

The integral of the current error is multiplied by this value. Integral gain reduces‘the
current error to zero over time. It controls the DC accuracy of the loop, or the
flatness of the top of a square wave signal. The error integral is the accumulated
sum of the current error value over time.

11.3.6: Current Loop Output

The output of the current loop is a command that sets the duty cycle of thesPWM output
stage of the amplifier.

Copley Controls Corp.

99




Control Loops

11.4: Velocity Loop Setup and Tuning

CME 2 User Guide

Initial velocity loop proportional gain (Vp) and velocity loop integral gain (Vi) values can be

calculated with The Calculate Function (p. 48).

Enter basic Velocity Loop settings

,_l\, = I Click V Loop (screen contents vary with model and configuration):

100

@\felucity Loop o ] 1
Co\r‘pr?anded I:oncwmanded
elocity - Command Compensator Output urrent
_/_ * % T *  Filter +' = b+% ™ Filter
[ Actual
Welocity

Wel, Limits I 3000 rpm

Fask Stop Ramp: I 1000 rps*

Tracking

‘indow :I 600 rpm

Time: I 100 ms

aecel, Limit I 1000 rps® \-'p:l 14336 Cutput Filker |
Wit

mece], Limit: I 1000 | rps® I 3186

¥ Low Gains Shift

Command Filker | il I -

Close |

Change/verify Velocity Loop parametersias needed.

Parameter

Description

Velocity Limit

Top speed limit.(Max value may depend upon the back EMF & the Encoder value.
Min value: 0.

Acceleration Limit

Maximum.aceeleration rate. Max value may depend upon load, inertia, & peak
currentxMin value:+1. (Does not apply in position mode.)

Deceleration Limit

Maximum deceleration rate. Max value may depend upon load, inertia, & peak
current. Min'value: 1. (Does not apply in position mode.)

Tracking Window

Tracking Time

See.Tracking Window Details (p. 74).

Vp

Velocity loop proportional gain. Range: 0 to 32,767.

Vi

Velocity loop integral gain. Range: 0 to 32,767.

Fast Stop-Ramp.

Deceleration rate used by the velocity loop when the amplifier is hardware
disabled. Range: 0 to 100,000,000. Default: velocity loop Decel. Limit value.
For more information, see Velocity Loop Limits (p. 102).

Low Gains Shift

Increases the resolution of the units used to express Vp and Vi, providing more
precise tuning. For more information, see Velocity Gains Shift (p. 103).

Hi Gains Shift

Decreases the resolution of the units used to express Vp and Vi, providing more
precise tuning. For more information, see Velocity Gains Shift (p. 103).

Vi Drain (integral
bleed)

Vi drain modifies the effect of velocity loop integral gain. The higher the Vi Drain
value, the faster the integral sum is lowered. Range: 0 to 32,000. Default: 0.

Command Filter

Programmable command input filter. Disabled by default. See Velocity Loop
Command and Output Filters (p. 103).

Output Filter

Programmable output filter. Default filter type: Low-Pass, 2-pole Butterworth (Cut
Off Frequency 200 Hz). See Velocity Loop Command and Output Filters (p. 103).

Click Close to close screen.
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Manually Tune the Velocity Loop

METHOD: Apply square-wave excitation to velocity loop and adjust proportional gain
(Vp) and integral gain (Vi) to obtain desired waveform. For instance:
:(Et]sci]luscupe - M= B

Trace Status: Trace Canceled - Ready To Start Mew Trace

300
200

'E 100

2100
-200

=300

0.00 0.08 .10 0.15 0.20 0.26 0.30 0.35 0.40 0.45
Time rseconds) - \

.NOTE: During tuning, observe any warnings that appear to the.eftof the trace.

1 z
Click the Scope Tool.

2 Apply To l\-’ locit

— Choose Velocity from the Function Generator Apply To: list.
3 MidessE On the Settings tab, make sure:- Auto Setup is selected.

Auto Setup automatically sets the following, parameters:

Function Generator Tab

Parameter Description

Excitation Square Wave,

Amplitude 10% of maximum, velocity value.

Frequency 5 Hz.

Settings Tab

Channel 1 Limited velocity (green).

Channel 2 ActuakMotor Velocity (white).
4 Function: EENEGEREETE

J
«u° - Verify that Amplitude value is not excessive for the motor.

S ﬂﬁ Click Start.

6 On the*Gains tab, adjust velocity loop proportional gain (Vp):

= _Set velocity loop integral gain (Vi) to zero.
= ‘Raise or lower proportional gain (Vp) to obtain desired step response. (Typically,
little or no overshoot on a 5 Hz small, slow-speed square wave.)

7 Adjust velocity loop integral gain (Vi) until desired settling time is obtained.

8 &l Press Stop to stop the function generator.

Iﬂl On the Main screen, click Save to Flash to avoid losing the changes.
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11.5:
11.5.1;

Velocity

Notes on the Velocity Mode and Velocity Loop

Velocity Loop Diagram

As shown below, the velocity loop limiting stage accepts a velocity command, applies
limits, and passes a limited velocity command to the input filter. The filter then passes a
velocity command to the summing junction. The summing junction subtracts the actual
velocity, represented by the feedback signal, and produces an error signal. (The velocity
loop feedback signal is always from the motor feedback device even when an additional
encoder is attached to the load.) The error signal is then processed using the integral and
proportional gains to produce a current command. Programmable digital filters are
provided on both the input and output command signals.

Velocity Loop

Velocity Integral Gain (Vi H
Limited y 7e9 Vo b

N ) +
Command™ Velocity Limiter (| Fijter |_Velocity > Z Velocity Proportional Gain (Vp) F:@‘_, Filter | , Current

— /\

Command

Limits: |
e Velocity
o Acceleration* Feedback (Derived Velocity)
e Deceleration*
o Emergency Stop Deceleration®
*Not used w hen velocity loop is controlled by position loop. See "Velocity Loop Limits™for details.

11.5.2:

11.5.3:

102

Inputs

In velocity mode, the velocity command comes.from one of the following:
¢ The amplifier's analog or PWM inputs.

¢ A CANopen network via the amplifier’s 'CAN interface.

o A Copley Virtual Motion (CV¥M) centrol program.

e The amplifier’s internalfunction:generator.

In position mode, the velocity command is generated by the position loop.

Velocity Loop Limits

The velocity command is limited based on the following set of parameters designed to
protect the motor and/or the mechanical system.

Limiter Description

Velocity. Limit | Sets the maximum velocity command input to the velocity loop.

Acceleration Limits the maximum acceleration rate of the commanded velocity input to the velocity loop.
Limit This limit is used in velocity mode only. In position mode, the trajectory generator handles
acceleration limiting.

Deceleration Limits the maximum deceleration rate of the commanded velocity input to the velocity loop.
Limit This limit is used in velocity mode only. In position mode, the trajectory generator handles
deceleration limiting.

Fast Stop Specifies the deceleration rate used by the velocity loop when the amplifier is hardware

Ramp disabled. (Fast stop ramp is not used when amplifier is software disabled.) If the brake
output is active, the fast stop ramp is used to decelerate the motor before applying the
brake.

Note that Fast Stop Ramp is used only in velocity mode. In position mode, the trajectory
generator handles controlled stopping of the motor. There is one exception: if a non-latched
following error occurs in position mode, then the amplifier drops into velocity mode and the
Fast Stop Ramp is used.

For more information, see Following Error Fault Details (p. 73).
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11.5.4:

11.5.5:

11.5.6:

11.5.7:

11.5.8:

Diagram: Effects of Limits on Velocity Command
The following diagram illustrates the effects of the velocity loop limits.

Limited Velocity

Commanded Velocity
>_ —_——

Vel Limit= — =— 1‘ -

e —
|
Accel Limit === = |==— Decel Limit ===
Velocity Loop Gains
The velocity loop uses these gains:
Gain Description
Vp - The velocity error (the difference between the“actual and the limited commanded velocity) is
Velocity loop multiplied by this gain. The primary effect of.this gain is to increase bandwidth (or decrease
proportional the step-response time) as the gain’is increased.
Vi - The integral of the velocity erroris multiplied by this value. Integral gain reduces the velocity
Velocity loop | error to zero over time. ltcontrols thelDC accuracy of the loop, or the flatness of the top of a
integral square wave signal. The error.integral is the accumulated sum of the velocity error value
over time.

Velocity Gains Shift

The Velocity Gains Shift feature adjusts the resolution of the units used to express Vp
and Vi, providing more:precise tuning. If the non-scaled value of Vp or Vi is 64 or less, the
Low Gains Shift option is available to increase the gains adjustment resolution. (Such low
values are likely to.be called for when tuning a linear motor with an encoder resolution
finer than a micrometer.) If the non-scaled value of Vp or Vi is 24001 or higher, the High
Gains Shift option is-available to decrease the gains adjustment resolution.

Velocity Loop Command and Output Filters

Thevelocity loop contains two programmable digital filters. The input filter should be used
toreduce'the effects of a noisy velocity command signal. The output filter can be used to
reduce the excitation of any resonance in the motion system.

Twofilter classes can be programmed: the Low-Pass and the Custom Bi-Quadratic. The
Low-Pass filter class includes the Single-Pole and the Two-Pole Butterworth filter types.
The Custom Bi-Quadratic filter allows advanced users to define their own filters
incorporating two poles and two zeros.

For more information, see Velocity Loop Filters (p.161).

Velocity Loop Outputs
The output of the velocity loop is a current command used as the input to the current loop.
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11.6: Position Loop Setup and Tuning

Initial position loop proportional gain (Pp), velocity feed forward (Vff), and acceleration
feed forward (Aff) values can be calculated with The Calculate Function (p. 48).

Enter basic Position Loop settings

1 ¢ PL .
ﬁl Click P Loop to open the screen:
_icix
Profile
Accelerstion - -
Profile F Commanded
Yelogity ~ Welocit
+
b+
Limited
Position \'
+. - &
- Actual
T Puozition &

N
Pp:l ﬁ Wit | 16384 ﬁ Aff:l 0 i Gains Multlpllerl :

2
100% Yff = 16354 <\\

Following Ervar———————————— Tracking N

Favit: I 4000 cournts Window: 1000 %u@ Q~
Warning:l 2000 counts C)
Time: I @S
A - Close |

[ Disable Faul 0} 03
(,\$ A

2 Changel/verify Position Loop parameters as needed. Click Close when done.

Gain Description
Aff Acceleration feed’forward. Range: 0 to 32,767. See Trajectory Limits (p. 109).
Vff Velacity feed forward. Range: 0 to 32,767. 100% Vff: 16,384.
See)Trajectory Limits (p. 109).
Pp Position‘loop proportional gain. Range: 0 to 32,767. See Trajectory Limits (p. 109).
Gains Multiplier Paosition loop output is multiplied by this value before going to the velocity loop. In dual

encoder systems, the multiplier’s initial value is calculated based on the ratio of motor
encoder turns to position encoder turns. See Feedback Parameters (p. 44).

Following Description
Error
Fault The level (in encoder counts) at which the following error produces a fault, which stops

the servo loop. We recommend raising the fault level before tuning the loop. See
Following Error Fault Details (p. 73).

Warning The level (in counts) at which the following error produces a warning (without stopping
the loop). See Following Error Fault Details (p. 73).

Disable Fault Stops following error from faulting. Following Error Fault Details (p. 73).

Tracking Description

Tracking Window | Width of tracking window in counts. See Tracking Window Details (p. 74).

Tracking Time Position must remain in the tracking window for this amount of time to be considered
tracking. See Tracking Window Details (p. 74).
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Manually tune the position loop

METHOD: Minimize following error and oscillation by running profiles and adjusting

position proportional gain (Pp), velocity feed forward (Vff), acceleration feed forward
(Aff) and other settings. For instance:
:(ﬂt}sci]luscupe

Trace Status: Ready

30

1000

]
[=]
(=]
=
Annml Jauig Eupmogoy

0.0 01 0z 0z 04 05 0g 07 ng 09 10 1.1 il : g

Time (seeonds)

NOTE: During tuning, observe warnings that appear to the left of the trace.

1 z
Click the Scope Tool.

2 rator  Profile |

Select the Profile tab.

3 M edoSet Perform an Auto Setup test:

2 On the Settings tab, make sure-Auto Setup is selected. Auto Setup
automatically sets the following, parameters:

Profile Tab

Parameter Description
Move Relative
Type Trap
Distance 2000-counts

Reverse and repeat {.Not selected

Settings Tab
Channeli Profile velocity (green)

Channel 2 Following error (white)

G-
Di&@e: 2000  counts
~ If the Auto Setup default profile distance is not

appropriate, enter an appropriate short distance.

< 5| Glick Start. The Profile Generator executes a short move.
NOTES:
1) The profile may not reach constant velocity during a short move.
2) If a following error occurs, open the Control Panel and click Clear Faults.

Continued...
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...Continued:

4

Ilaiimum Yelocity:

aximum Acceleration:

tdaximum Deceleration:

flgritrir Jerk:

Settings | Gains  Trajectory Limits I Position F‘aramsl Welocty Par

I 5230 rpm
Im rpe?
Im rps?
I 53340 | rpss

and

CME 2 User Guide

Function Generator Profile

Move: Type:
(v Relative " Trap
" Absolute " s Curve

Distance: | 2000 counts

Set up a trapezoidal profile by setting the trajectory limits and distance:"See table:

Trajectory Limits Tab

Parameter Description
Maximum Velocity
Maximum
Acceleration Set values typical of those expected to be_used in the application.
Maximum
Deceleration
Profile Tab
Distance Set the move distance to produce-a camplete trajectory profile. Be sure
that this distance does not exceed mechanical limits of the system.
Move Relative
Type Trap
S Pp: | 5000 ﬁ
Aff: | 0 ﬁ
T | 16384 ﬁ
Adjust-position proportional gain (Pp) to minimize following error:
= On the Gains;tab, set velocity feed forward (Vff) and acceleration feed forward (Aff)
to zero.
= On the Profile tab, click Start. On the Gains tab, adjust position loop proportional
gain (Pp) until best result is obtained.
= (Click Start after each adjustment to test on a new profile move.
NOTES:
1) Tooymuch position loop proportional gain (Pp) might cause oscillation.
2) If\a following error occurs, open the Control Panel and click Clear Faults.
6 . Adjust velocity feed forward (Vff):
= Velocity feed forward (Vff) reduces following error in the constant velocity portion of
the profile. Often, a velocity feed forward (Vff) value of 16384 (100%) provides best
results.
= Click in the Vfffield and adjust the value.
= Click Start after each adjustment to test on a new profile move.
Continued...
106
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...Continued:

7 Adjust acceleration feed forward (Aff):

= Acceleration feed forward (Aff) reduces following error during profile acceleration
and deceleration.

= Click in the Aff field and adjust the value.

= Click Start after each adjustment to test on a new profile move.

NOTES:

1) If, after tuning the position loop, the motor makes a low frequency audiblenoise
while enabled but not moving, the velocity loop gains (Vp and Vi) may be‘lowered to
reduce the noise. If the gain values are set too low, the response to instantaneous rates
of change might be reduced (i.e., slow correction to disturbances ortransients).

2) If the amplifier is set up to run in position mode under analog input’‘command, and
the analog command signal produces too much noise at the meotor after tuning, the
Velocity Loop Command Filter may be used to reduce the noise further.

See Velocity Loop Filters (p. 161).

8 Tune to multiple sets of profiles representing typicalmoves that might be executed in
the application. Starting with Step 4 (p. 106), repeat.the process as needed.
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Test S-Curve Profile

DISCUSSION: If the amplifier will perform S-Curve profile moves, use this procedure to
tune the level of jerk. (Jerk is the rate of change of acceleration. S-Curve moves reduce

jerk to provide a smooth profile.) Run an S-Curve profile and adjust velocity,
acceleration, deceleration, and jerk levels until the desired profile is obtained. For

instance: _ )
@Dscﬂluscupe M= E3
Trace Status: Ready
1200
4000
'E a00
= 800
3 400
200
1}
0.0 0.1 0.2 0.2 0.4 0.5 0.6 0.7 0.8 0.9 1.0 : 1.3
Time (seconds) —

s Profile I

Type:
= Trap
% 5 Curve

On the Profile tab, click the S-Curve button.

Adjust the following parameters to represent a typical move under normal operation.

Trajectory Limits Tab

Parameter

Description

Maximum Velocity

Maximum speed of the profile.

Maximum Acceleration/
Deceleration

Maximum -acceleration/deceleration of the profile. The deceleration is
set to be'the same as acceleration.

Maximum Jerk

The valte of jerk set during the calculate procedure produces an S-
Curve whose maximum slope is equal to the trajectory profile slope.
This value will produce a maximum acceleration that is not more than
the initial default value of acceleration. Small values will produce less
jerking but will take longer to complete move. Large values will
produce more jerking and a more trapezoidal profile but will complete
the move faster.

Profile'Tab

Distance Increase the move distance to produce a complete trajectory profile.
Use an acceptable value the does not exceed mechanical limits of
the system.

Move Relative

Type S-Curve
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11.7: Notes on the Position Mode and Position Loop

11.7.1: Position Loop Diagram

The amplifier receives position commands from the digital or analog command inputs,
over the CAN interface or serial bus, or from the CVM Control Program. When using
digital or analog inputs, the amplifier's internal trajectory generator calculates a
trapezoidal motion profile based on trajectory limit parameters. When using the CAN bus,
serial bus, or CVM Control Program, a trapezoidal or S-curve profile can be programmed.
The trajectory generator updates the calculated profile in real time as position commands
are received.

The output of the generator is an instantaneous position command (limited position). In
addition, values for the instantaneous profile velocity and acceleration are generated.
These signals, along with the actual position feedback, are processed by the position loop
to generate a velocity command.

To bypass the trajectory generator while in digital or analog position modes, set the
maximum acceleration to zero. The only limits in effect will now.be the velocity loop
velocity limit and the current limits. (Note that leaving the maximum acceleration set to
zero will prevent other position modes from operating correctly.)

The following diagram summarizes the position loop.

Position L
Profile Velocity R . TO3TIon Loop
> \elocity Feed Forw ard (Vff)
Target Trajectory Profi . _ _
N ofile Acceleration 5 Gain
Position Generator » \Acceleration Feed Forw ard (Aff) vattplier T \ég:iri:;{]d
- L .
> _/_\_ Limited Position @—ﬂ Pasition Proportional Gain (Pp) |
Limits: '
e Max velocity P
® Max accel Feedback _O< from motor encoder or resolver
o Max decel Od----------------- from optional position encoder (on load)

® Abort decel

11.7.2: Trajectory Limits
In position mode,-the trajectory generator applies these limits to generate the profile.

Limiter Description
Maximum Velocity Limits the maximum speed of the profile.

Maximum Acceleration Limits the maximum acceleration rate of the profile.

Maximum Decgeleration Limits the maximum deceleration rate of the profile.

Abort Deceleration Specifies the deceleration rate used by the trajectory generator when motion is
aborted.

11.7.3: Position Loop Inputs From the Trajectory Generator
The position loop receives the following inputs from the trajectory generator.

Input Description

Profile Velocity The instantaneous velocity value of the profile. Used to calculate the velocity
feed forward value.

Profile Acceleration The instantaneous acceleration/deceleration value of the profile. Used to

calculate the acceleration feed forward value.

Limited Position The instantaneous commanded position of the profile. Used with the actual
position feedback to generate a position error.
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11.7.4: Position Loop Gains

The following gains are used by the position loop to calculate the velocity command:

Gain Description

Pp - The loop calculates the position error as the difference between the actual and

Position loop limited position values. This error in turn is multiplied by the proportional gain

proportional value. The primary effect of this gain is to reduce the following error.

VIFf - The value of the profile velocity is multiplied by this value. The primary effect of

Velocity feed forward this gain is to decrease following error during constant velocity.

Aff - Acceleration feed The value of the profile acceleration is multiplied by this value. The primary_ effect

forward of this gain is to decrease following error during acceleration and deceleration.

Gain Multiplier The output of the position loop is multiplied by this value before being'passed to
the velocity loop.

11.7.5: Position Loop Feedback

110

Some Copley Controls amplifiers feature dual-sensor position loop feedback, configured

as follows:

¢ Single sensor. Position loop feedback comes from the encCoder or resolver on the
motor.

o Dual sensor. Position loop feedback comes from the encoder attached to the load.

(Note that in either case, velocity loop feedback comeés from the motor encoder or
resolver.) For more information, see Feedback Notes (p 46).

Position Loop Output
The output of the position loop is a velocity.command used as the input to the velocity
loop.
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11.8: Auto Tune all Loops for Linear Motors

The Auto Tune all loops feature is available for use with linear motors.

Make sure motor is mounted firmly and verify accuracy and completeness of
motor data.

Failure to heed this warning can cause equipment damage, injury, or death.

DANGER

Tune All Loops with Auto Tune (Linear Motors)

At any point, use Back to return to the previous screen. Use Skip to tune the velocity loop
without tuning the current loop, or to tune the position loop without tuning the velocity loop.

1 Verify the motor is mounted firmly. Also verify the accuracy and-completeness of the motor
settings. See Motor/Feedback (p. 39).

Current Loop

2 Make sure the amplifier's Basic Setup (p. 31) and-Motor Phasing (p. 75) procedures have
been performed, and that the system is capable of-a 10 mm move.

3
Click Auto Tune to open the Current,Loop Tune screen.
[Auto Tune '\@'\ c ﬁ F

Current Loop Tune
® Ready
Cp: 180 Select~Initial ‘wowve direction, then
ress\ 2tart to tune current loop.
Cir 192
[ Inital Move Positive

Skip | Cancel I

The status indicator is blue when the ampilifier is ready for tuning.

4 Verifythe Initial Move Positive setting. In most cases, this option should be set. If positive
initial motion is not possible, you can specify negative initial motion by clearing this option.
For instance, negative initial motion may be used when a vertical axis is at the bottom of
themotion range and the positive direction is down.

Continued...
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...Continued:

5 Click Start to tune the current loop. During tuning, the status indicator is amber.
Cp and Ci values change as the text in the status box gives progress updates.
When the current loop has been tuned, the status indicator turns green, and the status box

contains instructions for the next step.

Auto Tune 1[
Current Loop Turne
C Done
Cp: 180 andwidth 1200 Hz
Press next to tune velocity loop.
Cii 192
[ Inital Move Positive

Stop | Mext Cancel

Velocity Loop:

6 Click Next to open the Jog screen.
Auto Tune e \) x|
Jog 0 o

Joqg Speed: 50 mmyfs Position your moter_in
the center of ifs rangew

Jog Meg Jog Pos (
| I Actual Cur;l@u (bU ! - A

Curr Off rent 04
&~ | \X
+ b Next Cancel
P —
7 Move the motor to the‘centertof its motion range. To use a jog move:

= Set the Enable Jog option.
= Optionally adjust the{jog speed
= Jog the motor in either direction to move it to the center of its motion range.

Continued...
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...Continued:

8 When the motor is centered, click Next.
If the amplifier must apply current to hold the new position against a force (such as gravity
in a vertical application), the following message appears:

Auto Tune Current offsek required 5[

& current loop offset requirement of 0,49 A&
has been detected. If you are using a verticle

system the current loop offset should be
changed to compensate For gravity,
IMake recommended change?

Cancel

i

If this message appears, click OK.
The Velocity Loop Tune screen opens:

Auto Tune ll
Yelocity Loop Ture 9
Target Bandwidth ® Ready 6
r~
Higher Auto tune will attempt to make s
10nm move., If your system is net
¥p: 18 capable of a lOmm move cancél Hoi.
Wi: 9

Adjust target bandwidch-theh
press start to tune velgcity(loop.

O\,

9 Optionally adjust the Target Bandwidth.
TIP: Increase bandwidth fer-more stiffness in the holding position. Decrease bandwidth to
eliminate buzzing or oscillations. caused when the load is removed.

Continued...
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...Tune All Loops with Auto Tune, Velocity Loop, continued:

10 Click Start to tune the velocity loop. During tuning, the status indicator is amber.
Vp and Vi values change as the text in the status box gives progress updates.
When the velocity loop has been tuned, the status indicator turns green, and the status box
contains instructions for the next :

Auto Tune

Yelocity Loop Tune

Target Bandwidth € Done
_J_ Higher Bandwidth 70 Hz
Press next to tune position loop.
Voo 92
Vi 46

Stop | Back | Mext | Cancel

Position Loop:

11 Click Next to open the Position Loop Tune screef:
Auto Tune ‘ﬁ
Position LOOD Tine .
Maove Type Q\‘% \
5 Curve WiF = 100%: (optinal settling and Fc-llpg{hq) \\
i @ O
% frap Best Settling J_()A Bes ing
&~ _\

N\
.
o ray D 0

Auto tune will abtempt to make a
PR 1750 10wm weye. IE Gpour system is not
capahle of a-l0nm mowe cancel now.

vifr 16384
s Qe \Select wove Type then press start
. C)Q to tune position loop.
¥
Start ) top Q Back | Einish | Cancel |
< \éb

12  Verifythe Move Type setting (S-Curve or Trap).

13 For a-rapezoidal profile, optionally optimize the tuning along the scale between Best
Settling (for quicker settling) and Best Following (for less following error).

Continued...
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...Tune All Loops with Auto Tune, Position Loop, continued:

14 Click Start to tune the position loop. During tuning, the status indicator is amber.
Pp, Vff, and Aff values change as the text in the status box gives progress updates.
When the position loop has been tuned, the status indicator turns green, and the status

box contains instructions for the next step:
Auto Tune 5'
Fosition Loop Tune

Move Type

% 3 Curve WFF = 100% {optimal settling and Following)
Yif

= Trap Best Settling l— Best Fallowing

¢ Done
Press finish to sawve tuning
PR 1200 wvalues and exit.
VFF: 16384
Aff: 4096
ekt Stop | Back, | Einish Cancel |

15 Click Finish. See the reminder:

Tuning values Changed ﬂ

Mews gains must be saved to
flash after wverification

SN

16 Click OK.

-
On the CME 2 Main screen, click Save to Flash.
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CHAPTER

12: STEPPER CONTROLS

This chapter describes set up and tuning steps that are particular to stepper amplifiers.
The basic operations are listed below. Details follow in the chapter.

v Puasition Limnsl Set Position Limits in Stepper Mode (p. 118).

\/ + Encoder Correction . .
w Set Encoder Correction Gain (p. 119).

v o D_lete”t Tune Stepper Detent Gain (p. 120).
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12.1: Stepper Motor Support

CME 2 supports Copley’s stepper amplifier family. Stepper amplifiers can run in stepper
mode or servo mode.

This chapter describes controls that can be used to fine-tune a stepper amplifier in
stepper mode: Encoder Correction (p. 119) and Detent Compensation Gain (p. 120). It
also describes the screen used in stepper mode to set Position Limits (p. 118).

When a stepper amplifier is used in servo mode, it operates as a true, closed loopsservo
amplifier controlling a stepper motor. After putting the stepper amplifier into servo-mode,
set it up and tune it just as you would a servo amplifier.

12.2: Position Limits (Stepper Amplifier)

Perform the following steps to set position limits for a stepper amplifier'connected to an
encoder.

Set Position Limits in Stepper Mode

ﬂ Click to open the stepper Position Limits‘screen.
=151

Followving Error

Fault; I Dl peteps
Wiarning: I 0 psteps

™ Disable Fault

Tracking

Tirme:

Window:l ] psteps
I 0 ms

{

Close |

2 Set values for.thé limits:

Limit Description

Fault The level (in encoder counts) at which the following error produces a fault,
which stops the servo loop. We recommend raising the fault level before
tuning the loop. See Following Error Fault Details (p. 73).

Warning The level (in counts) at which the following error produces a warning (without
stopping the loop). See Following Error Fault Details (p. 73).

Disable Fault Stops following error from faulting. Following Error Fault Details (p. 73).

Window Width of tracking window in counts. See Tracking Window Details (p. 74).

Time Position must remain in the tracking window for this amount of time to be

considered tracking. See Tracking Window Details (p. 74).

3 Click Close to close the window.

b |
On the CME 2 Main screen, click Save to Flash.
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12.3: Encoder Correction

Stepper Controls

For a stepper motor with an encoder, Encoder Correction proportional gain can be used to

compensate for lost microsteps.

Set Encoder Correction Gain

1 v E derC i . .
4| “ "7 1 Click to open the Encoder Correction screen.
I [
ECp:I D| ﬂ

ey Step Rate: I 0 rpm
Close |

2 Set the Encoder Correction parameters:

Parameter

Description

ECp

Proportional gain used to compensate for lost
microsteps. Default: 0.

Max Step Rate

Maximum velocity allowed while using ECp to
correct¢asition errors. Excessive velocity can
result inymore lost microsteps. Default: 0.

Copley Controls Corp.
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12.4: Detent Compensation Gain

Stepper motors are subject to torque detent that can cause undesired velocity fluctuation
between full steps of motion. The Detent gain feature can compensate for this detent.

Tune Stepper Detent Gain

1 r e-en
Ll Click Detent to open the stepper amplifier Advanced Tuning screen. Q
EStepnet Advanced Tuning — |EI|5| ;\§)

N

o

elacity: I—D ﬂ L]} Gain:l—ﬂ ﬁ Q\%

[ auto Scale Lock (b .

\6 QQ
Trace Time:|25 ms i l | K
Close |
(" \Q)q
Screen settings and controls are dq@qbed below:
9 ;f\g :\‘

Setting Description
Velocity T ingd‘@city. Default: 0.
Trace Time \\G‘J Lepg@é? trace interval to be shown on screen. Default: 25 ms.
Gain (Detent Gair\K\V k‘@\Stepper Detent Gain value. Default: 0.
Auto Scale LQ?&)‘ When selected, prevents trace display from rescaling during tuning.

2 Click Sta{t% quZlQIhe tuning.

Adj é\lel y from 0 until the mechanical system begins to resonate. (Using a 1.8
% motor with 200 full steps, this will typically occur at a velocity of 40-70 rpm.)

“Q@Gam until the resonance increases, and then back it down until the resonance is
mi

ized
%6\

Q, C|ICk Stop to stop the tuning.
A

‘0
&&\Q\%

Q6 Click Close to close the window.

.- |
On the CME 2 Main screen, click Save to Flash.
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CHAPTER

13: HOMING

Set homing parameters and run optional homing tests. Perform the steps outlined below.

1 4|H°me On Main screen, click Home to open the Homing screen.

Homing x|
Software Limit:
Positive: I—D counks Deceleration Rate: I—D rps?
Meqgative: I—D counks
Disable |

(=Tl Bl (S e Current Position as Home:

Direction af Motion

% Positive () Megative Offset: I 0 counts
Current Limit: I 257 A
Fast Yelocity: I 150 rpm Current Delay Time: I 250|| ms

Slows Velocity: | 30 rpm Following Warning: 2000 count%\
AccelDecel: | 50 rps? fictual Cutrent: @

$’0
¢x
Horne: | Stop | é | ‘@

2 Select the following homing-parameters:
Parameter Description
Software limits: Positive Position of user-defined travel limits that take effect after homing operation.
Software limits: Negative
Deceleration Rate Deceleration rate used to stop a motor when approaching a software limit.
Software limits:; Bisable Disables the use of software limits by setting both limits to zero.
Method Homing method. See Homing Methods (p. 163).
Direction‘of*Motion Initial direction of motion for the homing method (Pos or Neg).
Fast.Velocity The velocity used to find a limit or home switch. Also used when moving to
an offset position, or a resolver or Servo Tube index position.
Slow Velocity The velocity used to find a switch edge, incremental or analog encoder
index pulse, or hard stop.
Accel/Decel The acceleration and deceleration rate used during homing.
Offset Execute a move of this distance after the reference is found. Set actual
position to 0 and call the new position home.
Current Limit Hard stop home is reached when the amplifier outputs the homing Current
Current Delay Time Limit continuously for the time specified in the Delay Time.
Following Warning Shows the programmed following warning level.
Actual Current Shows actual current being applied to windings during homing.
3 Optionally click Home to begin a homing sequence. To stop immediately, click Stop.
4 Click Save to save the settings to flash memory. Click Exit to close the screen.
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Homing
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CHAPTER

14: CONTROL PANEL

Become familiar with the CME 2 Control Panel and its functions. Perform the steps
outlined below to access the panel and its functions. Details follow in chapter.

1
*21 Click to open the Control Panel: .
A Control Panel V ]
NZ

—~Status ~Monikar O
# Mokor Output: Active ILirnited Pasition ﬁh counts

6 & Hardware Enabled: Enabled /\‘\
i Software Enabled: Enabled =
P ] IActuaI Makar Positian LI _ counts
& Positive Limnit: Mok Active S
' : i Megative Limik: Mok Ackive ‘-k )

% Software Limits: Mot Active |Actual Matar Yélocity ~ | K
Error Lo | i Mokar Phase: 44 \\O
2 4 Motion Abork Inpuk: Mok Active Dsition, Digital Input

<> CWM Contral Program: Mok Funning

<> Haome: Mok Referenced
CaM Status: ’
Gain Scheduling;

[ love

C)\-‘elouty I 75 rprm
Y
(* Acceleration I 100 tps?
)
l&? ‘G> Deceleration I 100 rps?

M\

Set Zera Position

Disable Clear Faults Ri \Q [™ Enable Jog Tavz FEG | ez PO |

|

|+
AQ
oS

“‘ Close
o @ G|

2 See this chapter fora Control Panel Overview (p. 124) and details on:

= Status Indicators and Messages (p. 124)
= Control Panel Manitor Channels (p. 125)
= Control Functions (p. 126)

= Jog Mode (p: 127)
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14.1: Control Panel Overview

Each of the Control Panel features labeled below is described in the following sections.

@Eontrol Panel ¢
Status Maonitar

Monitor real-time amplifier values
and operational mode

Status indicators

Red if fault - v Makor Output: Active ILimited Position

is active _— U & Hardware Enabled: Enabled
# Software Enabled; Enabled Inctual Matar Position LI 35920 iyl I
i Positive Limnit: Mok Active

Yellow if warning [ !\\ & Meqgative Limnit: Mok Ackive

is active o i Software Limits: Mok Active I""Etua| Motor Velocity j - fem

Display error log ——p» Error Log |

& Motar Phase: Ok

& Motion Abort Inpuk: Mok Active Mode: Position, Digital Input
CWM Control Program:  hok Running e
Haorne: Mok Referenced
A Status: Move
&ain Scheduling: Y eloity I 158,98 rpm
Message boxX ———pp Acceleratitg I Z12 rps?
Contral DrecelBRatiBn I 212 rpst
i Enable Set Zero Position |
Control functions——»
Disable Clear Faults | Reset I~ Epable Jog e FEG | ez PO |

Jog mode controls

14.2: Status Indicators and Messages

The Status area includes status indicatorlights-(described below) and a message box.
Any red lights indicate that motion will-be inhibited.

Indicator States/Description

Motor Output State of the PWM output stage. Red if the output stage is inactive (disabled)
Hardware State of the hardware enable input(s). Red if one or more enable inputs are inactive.
Enabled

Software State of the,software-enable. Red if the amplifier is disabled by software.

Enabled

Positive Limit

State of the'positive limit switch input. Red indicates an activated positive limit switch.

Negative Limit

State of.the negative limit switch input. Red indicates an activated negative limit switch.

Software State of the software limits. Red indicates an activated software limit.

Limits

Motor Phase Indicates a motor phasing error. Red indicates a motor phasing error exists.

Metion Abort State of the programmed Motion Abort Input. Red indicates the input is active.

Input

CVM Control Status of the CVM Control Program.

Program

Home Indicates whether the axis has successfully been referenced (homed).

CAN Status Status of the CAN Bus. Yellow indicates CAN warning limit reached. Red indicates bus
error detected. (For DeviceNet, see the Copley DeviceNet Programmer’s Guide.)

Gain Scheduling Indicates whether Gain Scheduling (p. 187) is active.

%)

The fault indicator goes red when a fault is active. Check the status message box for a

description of the most recent fault; Fault: Under tiokage
Check the Error Log for a full history of faults and warnings.

AN

The warning indicator goes yellow when a warning is active. Check the status message

box for a description of the most recent; *aming: Pos Outside f Tracking Window
Check the Error Log for a full history of faults and warnings.

Message Box

Displays status descriptions.

124
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14.3: Control Panel Monitor Channels

The Control Panel Monitor channels can display real-time values on up to three separate

variables. The procedure follows.

Set up a monitor display channel

Manitar

ICommanded Position LI counts
Inctual Matar Pasition LI counts
ILimited Paosition LI counts

Mode: Position, Digital Input

Click in the list box and select a variable from the list. Disabled disables the
display. Other options represent the following amplifiervalues:

e Actual Current ¢ Following Error e Passive Load Position
o Actual Motor Velocity e Commanded Current e Limited Position

¢ Actual Motor Position e Commanded Velogity ¢ Analog Command

e Actual Load Velocity e Commanded Position e Bus Voltage

e Actual Load Position o Profile Velgeity o Amplifier Temperature
¢ Velocity Error ¢ Profile(Acceleration ¢ Motor Phase Angle

Mode: Displays the amplifier’s;present/operating mode. In camming it also
displays the active cam table number:

Copley Controls Corp.
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14.4: Control Functions

The Control area of the screen provides functions related to overall amplifier control. The
screen options vary with model and configuration.

126

Use the Control Panel Control Functions

Contral

Enable |

Set Zera Position |

Disable |

Clear Faults | Reset |

Control the operational state of the amplifier using the buttons as described below.

Control Description
Enable Click to software enable the amplifier.
Disable Click to software disable the amplifier.

Set Zero Position

Click to set the amplifier’s actual position.counter to zero.

Clear Faults

Click to clear all amplifier faults.

Reset

Click to reset the amplifier.

Risk of unexpected or uncontrolled motion.

Using the CME 2 Set Zero Position function'while the amplifier is operating under
external control could cause ungxpected onuncontrolled motion.

Failure to heed this warning can cause equipment damage.

WARNING
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14.5: Jog Mode

Jog mode provides a simple means for generating forward or reverse commands, as

Control Panel

shown in the procedure below.

Run a move in jog mode

1 To put the amplifier in jog mode, set the Enable Jog option.

2 Set up a jog move by setting the following mode-specific parameters:
Mode Parameter Description
Current Current Current applied to the motor. Limited by current loop Contintous

Current.
Warning: Unloaded motors may, depending on torquessetting,
ramp up in speed very quickly.

Velocity | Jog Speed Velocity of the jog move. Limited by velocity loop Vel. Limit.
Position | Velocity Velocity of the jog move. Limited by velocity loop Vel. Limit.
Acceleration Acceleration limit of the jog move.
Deceleration Deceleration limit of the jog move:
3 Command the move:
Mode Steps
Current | « Hold Pos to apply positive currentto the motor or hold down Neg to apply
negative current to the motor.
¢ Release the button to command zero)current.
Velocity |« Hold Jog Pos to commiand a fofward velocity or hold down Jog Neg to command
a negative velocity.
¢ Release the button to commiand zero velocity.
Position

¢ Hold Move Pos to generate a forward move profile or hold Move Neg to
generate a negativeymove profile.

¢ Release the button to stop movement.

NOTE: Positien“mode jog is accomplished by continuously updating the
commandeéd position. If a following error develops with Following Error Fault is
disabled;ymotion will not stop on button release. Instead, it stops when actual
position-= commanded position.

Copley Controls Corp.
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This chapter shows how to use the CME 2 Scope Tool to program and test motion .

CHAPTER

15: ScoPE TooL .
O

Q\

sequences. Perform the steps outlined below to access the Scope Tool. Details fo;gb in

the chapter.

Click

E Oscilloscope

<O

to open the Scope Tool: Q)

=10l x|

apply To: IVeIDcit‘f - I

Function: ISquare Wave vbﬂ
.ﬂmplitude:l 300 rp 6

Function Generator I Prafile |

Trace Status: Ready N

Settings I (%QTraje!@!
&S Trigger Setup |

[~ Auto Setup
[~ single Trace

g ﬂl Jisables

i sl Position Params| Welocity F‘aramsl Measurement'

[~ &uko Scale Lock

.

Trace Time:|1.255

L

Skark |§ at
‘\ \\\v ﬂ Record | Stop Trace | Clear | {Clnse
Q) N
o> Y | ;
\J

:

J
apter for a Scope Tool Overview (p. 130) and details on:

race Channel Variable Parameters (p. 132)

((\(& = @nction Generator and Profile Tabs (p. 131)
&

Trigger

Control

Setup (p. 133)

Trace Time, Sample Rate and Single Trace (p. 134)
Scope Display Parameters (p. 134)

Auto Setup (p. 135)

Measurement Tab (p. 136)

Loop Parameters in Scope Traces (p. 137)

Copley Controls Corp.
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15.1: Scope Tool Overview

130

The Scope Tool can be used to tune the amplifier, monitor performance, and perform
diagnostics. Function Generator and Profile Generator can drive the motor without
external control. Auto Set Up feature sets typical initial values for scope parameters.

-inix]

Trace Status; Trace Canceled - Ready To Start Mew Trace

G000

Scope Trace ==

3 Bumaco 4

Welosity (rpm)

Time

O
Function Generator I Profilel Settings | Gainsl Trajectary Lim\tsl Position Paramsl welocity PamNNsurement |
N

~>
I Tr@er Setup
Apply To: IPosition vl

Auko Sekup

Function/Profile > = single Traceeg Scope settings and
Generation Funiction: ISquara Wlave | [~ Auto Scale Lack control loop parameters
Amplitude: 8000 counts lcElne] 500 ms :lv
Frequency: 1 Hz
Sample Rate: Zms

Start TEon [ S .
Lﬂ __Recard’ o )  Cear | dose | _54—- Scope controls
I %] . | <—— Status message bar
Button Description
Record Begins recording@jfrace.
Stop Trace Stops-recording-a trace.
Clear Clears the‘trace from the screen and trace data from buffer.
Close Closes-the scope tool.

NOTE: When Actual Current is-displayed, the Scope Tool status message displays the
true rms current measured during the trace period. To calculate the rms value for a
portion of the displayed waveform, zoom in to that portion of the waveform by selecting it.

Run a move with the Function Generator or Profile Tool

Click on'the Function Generator or Profile tab.

Adjust Furiction Generator or Profile settings, scope tool settings, gains, limits, and
parameters (as described later in this chapter).

Cliek-Start to begin move and trace. Click Stop to stop the move.

Monitor externally controlled motion

As required, adjust scope tool settings.
Click Record to begin trace.

Begin move with external controller. Click Stop Trace to stop the trace recording.
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Scope Tool

15.2: Function Generator and Profile Tabs

The Function and Profile generators can provide inputs to the different control loops for
tuning and diagnostics purposes without using an external control source.

Function Generator | profils |

Apply Tor [Current -

Function:  (SeE s

Amplitucle: 047 &
10 ms

Start Stop

Perinc!

Function Generator  Profile |

Move:
1+ Relative
" Apsalute

Type:
& Trap
' Scurve

Distance: 2000 courts

I™ Reverse and Repest

Start | Stop

The Start button starts the function or profile generator. The Stop button stops the
generator and aborts any profiles in progress.

15.2.1: Function Generator Tab

15.2.2:

Parameter | Description
Apply To Control loop to which the Excitation will be applied: Current (available in all modes), Velocity
(available in velocity or position mode), or Position (available in position mode only).
Excitation Excitation (motion function) that will be applied to thejcontrol loop selected in the Apply To
list box. The choices vary with the control loop,selected:
Selected Control Loop  Excitations Available
Current Sine Wave,Square, Wave, Step Forward, Step Forward and
Reverse,cand Impulse
Velocity Sine Wave, Square Wave, Step Forward, Step Forward and
Reverse
Position Sine Wave; Square Wave
Amplitude Amplitude of the command, Units.vary depending on the value chosen in the
Apply To field.
Frequency (Sine Wave and Sguare Wave only.) Frequency of input command cycle.
Period (Step Forward, Step Forward and Reverse, and Impulse only.) Duration of each input pulse.
Profile Tab
Parameter | Description
Move Relative: Moves axis a specified distance from the starting position.
Absolute: Moves axis to a specific position.
Type Trap ©r.S-Curve.
Distance Distance for Relative move.
Position Target position for Absolute move.
Reverseand | (Relative move only.) When selected, will continuously generate forward and reverse moves
Repeat of the distance specified until Stop is pressed.

Copley Controls Corp.
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15.3: Trace Channel Variable Parameters

Choose a trace variable for display in a Scope channel

Click the channel button.

Channel 3 Trace Yariables |
Category Trace Yariable
Disabled Analog command
Current Bus voltage
Welocity Analog sin input
Paosition Analog cos input
Acceleration Terminal Yolkage Stepper
Yoltage Terminal Yoltage Serva
Miscellaneous
Digital Inputs
Digital Cutputs
Event Status Faulks
Event Skatus Warnings
Event Skatus Misc,
o] | Cancel |
2 Choose a category and a trace variable.
Category | Trace Variable Category | Trace Variable
Disabled | <Channel disabled, no Misc. | Motor Phase Angle, Amplifier
associated variable> Temperature, Hall States
Current | Commanded Current, Actual Digital Inputs | Digital input line states
Current, Limited Current
Velocity | Profile Velocity, Digital | Digital output line states
Commanded Velocity, Outputs
Limited Velocity,.Actual
Motor Velocity;(Actual Load
Velocity, Unfiltered Motor
Velocity, Velocity Error
Position | Commanded Position, Event Status | Short Circuit, Amp Over

Limited Position, Actual
ltoad Position, Actual Motor
Position; Following Error,
Passive Load Position

Faults

See Fault
Configuration
Parameters

(p. 70).

Temperature, Over Voltage, Under
Voltage, Motor Over Temperature,
Feedback Error, Motor Phasing
Error, Following Error, Command
Input Fault, Amplifier Fault (a
latched fault is active).

Acceleration

Profile Acceleration

Event Status
Warnings
See Custom
Event
Functions

(p. 54).

Current Limited, Voltage Limited,
Positive Limit Switch, Negative Limit
Switch, Following Warning, Velocity
Limited, Acceleration Limited,
Positive Software Limit, Negative
Software Limit, Pos Outside of
Tracking Window, Vel Outside of
Tracking Window.

Voltage | Analog Command Event Status | Amp Disabled by Hardware,
Bus Voltage Misc. | Amp Disabled by Software,
Analog sin Input See Custom | Attempting to Stop Motor, Motor
Analog cos Input Event | Brake Active, PWM Outputs
Terminal Voltage Stepper Functions | Disabled, Position Has Wrapped,
Terminal Voltage Servo (P-54). | Home Switch Active, In Motion,

Phase Not Initialized.
3 Click OK.
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Scope Tool

15.4: Trigger Setup

Set up Scope trace trigger (manual setup)

1 . Trigger Setup |
ntdoi ool Click Trigger Setup to open the screen:

Trigger Tvpe:

Trigger O

Position:

Lewvel;

Trigger Settings

x|

IEvent Skatus Rising Edge LI

IChanneI 1 > l
ILeFt hd I

Event Skatus Bit: Current Limited

[o]4 | Cancel |
2 Choose from the settings described below:
Setting Description
Trigger Type Selects trigger type.
¢ Immediate Trigger: Trace begins as)soon-as Record is pressed.
¢ Rising Edge: Trace triggers when (afterRecord is pressed) the trigger signal rises
though the trigger level setting.
o Falling Edge: Trace triggers when/(after Record is pressed) the trigger signal falls
though the trigger levelsetting!
¢ Above Level: Trace-triggers when the trigger signal is greater than or equal to the
trigger level setting.
¢ Below Level: Trace triggers when the trigger signal is less than or equal to the trigger
level setting.
* Function-Generator: Trace begins in synchronization with the Function Generator.
o Move Start(position mode only): Trace begins in synchronization with the trajectory
generator.
« Event Status Rising Edge/Event Status Falling Edge: trigger on the rising or falling
edge of changes to events chosen in the Event Status Bit setting (below).
< Input Level High/Input Level Low: trigger when specified input is high or low.
o Output Active/lnactive: trigger when specified output is active or inactive (note that
outputs can be configured to be active when high or low). (Not available on Accelus or
Junus.)
Trigger,On Selects which channel will be used as the trigger signal: 1, 2, 3, 4, 5, or 6.
Position Selects placement of the trigger event on the screen. (Value is not configurable for
Immediate, Function Generator, or Move Start trigger types.).
o [eft for optimal viewing of events following the trigger.
e Middle for optimal viewing of events preceding and following the trigger.
* Right for optimal viewing of events preceding the trigger.
Level Sets the trigger level, in units appropriate to the channel selected.
Event Status With an event status trigger type selected, choose the event status word bit that will
Bit trigger the trace. For descriptions of the event status word bits,
see Custom Event Functions (p. 54).
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15.4.1: Auto Trigger

The Auto Trigger option automatically sets the trigger type to Function Generator or Move
Start, depending on which generator is being used. Note that Auto Trigger is automatically
selected when Auto Setup is set.

15.5: Trace Time, Sample Rate and Single Trace

Trace Time sets the length of the recorded trace.

Sample Rate is the rate at which the signals are sampled. The rate depends on the'trace
time, the number of channels selected, and which variables are being traced.

Single Trace puts the scope in a single trace mode of operation. In this mode,-the trigger
is not re-armed after a trace until the user presses the Record button. Single‘Trace is
automatically set by the generators in certain cases.

15.6: Scope Display Parameters

The user can set the line style and other scope screen preferences. Right-click on the
scope screen to display the menus, as shown below.

' Yol

Trace Status: Waiting for trigger position delay to expire

1500
1000
S00

u]

500 }‘Iine

eferences plus

Position (counts)

-1000
connected plus
-1500 S e L

0.0 a.1 0z 0.z 0.4 0.5 D.ﬁxﬂ 0. B 1.0 1.1 1.2 132
Time fsedonds) £
~ y ]

~J L4

The Scope display parameterscare described below.

Menu Parameter Description
Line Style line A’line connects the plotted data points.
plus The Scope plots data points as plus signs, with no connecting line.

connected plus | Data points are plotted as plus signs and are connected with a line.

Preferences anti-aliasing When anti-aliasing is selected, the Scope smoothes out any screen-
related jaggedness in the displayed trace. Use of this feature may slow
down the refreshing of traces on slow computers.

grid When selected a grid is displayed on the scope screen.

15.6.1: Auto Scale,and Auto Scale Lock
The Scope’/automatically scales the display axes to optimally display all channels.
WithAuto Scale Lock selected, the y-axis locks its scale for all subsequent traces.
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15.6.2: Zoom

Zoom in on a Trace Segment
1 Hold the left mouse button down while dragging a box around the area of interest.

Trace Status: Trace Canceled - Ready To Start Mew Trace

|iL|uP|. I|||"'IhIP'I'I'JhI'"rl.lpr'lnlllwfhvllll|ﬁl‘ |h If N F |”|||| l‘fllll ﬁ,lir ll"
| |

| ‘ | ‘
| \ |

| | |
I'a""i“w!ﬁ"‘m"'ﬁ'ﬂ" ’7 1" '1| .I'|J u.H,J |LJ1\ 7 L, Wr LY ﬁ*'IJ'lFLF{lINh A

L

2 Release the button to let the display zoom in on the selected area.

Trace Status: Trace Canceled - Ready To Start Mlew: Trace

3 To restore the normal zoom level immediately, left-click anywhere on the trace.
(Normal zoom levelis-also restored when the next trigger event occurs.)

15.7: Auto Setup

With Auto Set Up selected, if the function generator tab is active, CME 2 automatically
sets the scope settings and the function generator's amplitude and frequency/period to
best suitthe function generator's Apply To and Excitation mode settings. If the Profile tab
is active, CME 2 automatically sets the scope settings and sets a standard move into the
profile generator. Changing any of the preset settings de-selects the Auto Set Up feature.
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15.8: Measurement Tab

The Measurement tab allows you to measure and analyze data from up to three
parameters during an interval defined by adjustable cursors. The Cursor Data area
displays a parameter’s values at the left and right cursor locations, and the difference
between the two values. The Analysis area displays the minimum, maximum, average,
and root mean square of the parameters during the cursor period.

Cursors
@
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0.00 0.05 0.10 0.15 0.z0 0.25 0.30 0.35 0.40 0.45 0.50
Time rseconth

Function Generator I ProFiIel Settlngsl Galnsl Trajectary lelﬂﬂNﬁ'Paramsl Velacity Params  Measurement I Cursor data

Cursor raw data P CursorDa Analysis <
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Apply To: IPosition VI .

Function:  [Sauare Wave = T T T M counts

Amplitude: I B000  counts

Start

Frequency:l
I

Stop |

Q ' Record | Stop Trace | Clear | Close |
O

| \r\\" SN |

XN

When Show Cursors is:not set,4he Cursor Data fields are inactive and the Analysis fields
show calculations based on data from the entire trace cycle.

Basic Measurement Operations

1 g CurSD'STO display cursors and activate the Cursor Data fields, set Show Cursors.
2 To move a_cursor, click on the cursor and hold the left button while dragging the cursor
toithe desired location. Release the left button to place the cursor in the new location.
3 To select a parameter to measure and analyze within the cursors, choose a channel in
one of the three channel lists on the Measurement tab:
Cone:
ICHl vl
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15.9:

15.9.1:

15.9.2:

Control Loop Parameters in Scope Traces

The Scope tool provides convenient access to all of the control loop parameters that
might be used in tuning and diagnosing an amplifier. The user can adjust these
parameters and see the results immediately on the scope. Control loop parameters are
accessed through a set of tabs, shown below.

Settings  Gains I Trajectory Limitsl Position Paramsl Welocity F‘aramsl Measurementl
Position Welocity Current

Pp: [ 1000 il vp: [ 14336 il e [ 1310 i’
AfF: I u] ﬂ Wit I 3lse ﬂ it I 166 ﬂ
. Iﬁ ﬂ Output Filker Fe:

200

Note that the parameters represented on these tabs can also be accessed through the
screens used to configure the control loops and the digital position input. Changing a
value in the Scope tool automatically updates the value onthe other screens where it
appears, and vice versa.

Control loop parameter tab descriptions follow.

Gains Tab

The Gains tab provides access to all of the gains appropriate to the operating mode, as
described below.

Modes Gains Description For More Information
- Pp Position loop_proportional gain.
Eﬁ@ltlon mode Aff Acceleration feed forward. Trajectory Limits (p. 109).
Vif Velocity feed forward.
- Vp Velocity loop proportional gain. Velocity Loop Gains (p.
Position or v Velocitvi int [ qai 103).
velocity mode i elocity loop integral gain.
only Output Velocity Loop Output Filter cut-off frequency. | Velocity Loop Filters (p.
FilterFc 161).
Cp Current loop proportional gain. .
All modes - - - Current Loop Gains (p. 99).
Ci Current loop integral gain.

Trajectory Limits Tab
In position mode, the Trajectory Limits tab can be used to set trajectory limits.

Settirigs | Gains /Trajectory Limits | Pasition Params | Yelarity Paramsl Measurernznt |

Maiimurn Yelocity: W rpm
Mazximum Acceleration: I 500 pps?
Mazximum Deceleration: I 500 pps?
Iaszimnum Jerk IW rps®

For more information on the velocity and acceleration limits, see Trajectory Limits (p.
109). For more information on the Maximum Jerk setting, see Test S-Curve Profile (p.
108).
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15.9.3: Position Loop Parameters
In position mode, the Position Params tab can be used to set position loop parameters.

Settingsl Fains | Trajectary Limiks  Position Params | Velocity Params | Measurementl

N "
Pasition Tracking Actual Position: 21319728 counts

Window:l 1000 counts
Set Zera Position
Time: I 10 ms —I
Following Error: I 4000 counts

[~ Cisable Following Errar Fault

Set Zero Position sets the amplifier's actual position count to zero. For more information
on the other settings, see Position and Velocity Error Notes (p. 72).

15.9.4: Velocity Loop Parameters

In position and velocity modes, the Velocity Params tab can be used to set velocity loop
parameters.

Settingsl Gainsl Trajectory Limits | Fosition Params  ¥elocity Params | Measurementl

Welocity Tracking

Window;l £00 rpm Bceel Limik: I Looo tps?
Time: I 100 ms Decel Linnit: I 1600 Fhis?

For information on the Velocity Tracking parameters, see
Position and Velocity Error Naotes (p.:72). For information on the limits, see
Velocity Loop Limits (p. 102).
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15.10: Scope Files

The Scope Tool can save trace data in Copley Controls scope files (.sco files) that can be
opened later with the CME 2 Trace Viewer. Simultaneously, a version of the same trace is
stored in a comma-separated text file (.csv) and a tab delimited file (.txt), either of which
can be opened with a spreadsheet application such as Microsoft Excel (or other
programs) for mathematical analysis. The format of the .csv and the .txt file is the same:

Column 1: time

Column 2: Trace Channel 1

Column 3: Trace Channel 2 (if used)

Column n: Trace Channel n (if used)
NOTE: By default, scope files are saved in the ScopeData folder in the CME 2 installation
folder. For instance, c:\Program Files\Copley Motion\CME 2\ScopeData. Use these
procedures to save and view trace files:

Save trace data:

1 Generate the trace you wish to save.

ﬂ In the Oscilloscope window, click the Save to.Disk icon.

3 When prompted, enter a File Name. If needed, navigate from the default ScopeData
folder to another folder where you wish to store the file.

4 Click Save to save the .sco, .txt, and .¢sy files'in, the same folder and close the screen.
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View a trace file:

1 On the Main screen, choose Tools>View Scope Files to open the window.
2 Click Open File. When prompted, select the name of the file you wish to open.
Then, click Open to display the file in the Trace Viewer window.

@Trace Yiewer (square_wave_sample.sco) ;lglﬁl

Settings Measurementl
*
~Function Generatar ~Trigger
Type: Function Generator

apply Ta:  Position

Excikation: Square Wave Apply To: MfA

Amplitude; 2000 counts Position: M

Period: 2 Hz Level: MIA

o Close |

The Measurement tab allows you to measure and analyze data from up to three
parameters during andnterval defined by adjustable cursors. See Measurement Tab (p.
136).
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CHAPTER

16: DATA, FIRMWARE, AND LOGS

This chapter describes how CME 2 manages amplifier data and firmware, how to
download firmware, and use the amplifier logs.

. Amplifier RAM and Flash Memory (p. 142)

. Disk Storage of Amplifier and Motor Data Files (p. 142)
. Data Management Tools (p. 143)

. Amplifier Firmware (p. 144)

. Error Log (p. 146)

. Communications Log (p. 147)

Copley Controls Corp. 141



Data, Firmware, and Logs

CME 2 User Guide

16.1: Amplifier RAM and Flash Memory

Amplifier RAM holds status data and certain user-entered data during operation. Its

contents are flushed when the amplifier i

s reset or powered off. Flash memory

permanently stores the data. The contents of flash are loaded into amplifier RAM at

power-up or reset, as described below.

Amplifier RAM

Flash

Contents erased when amplifier is reset or
powered off.

Permanent. Contents retained when the amplifier is reset
or powered off.

Initial contents read from flash on power-up.
Contents then updated in real time to reflect
certain operational conditions and changes
entered with CME 2 software. At any time, the
user can use CME 2 to restore data from flash
into amplifier RAM.

Modified only by using a Save to Flash tool or/by-closing
certain screens (Motor/Feedback, Basic Setup,"Homing, or
CAN Configuration), whose contents are automatically
saved to flash upon closing of the screen.

As described below, some data resides i

n flash only, some in amplifier RAM only, and

some in both.
Data Resides In Data
Flash only This category includes all data represented on the

Motor/Feedback screen, Basic Setup screen, and CAN
Configuration‘screen. This data is automatically saved to
flash as spon ‘as its entry is confirmed (when the user
clicks the appropriate Save to Flash button, or closes the
screen).

Flash and amplifier RAM

Includes all user-entered data represented on other
screens, such as gains, limits, and I/O, faults, and regen
settings:Initial values for this data are factory-set in flash.
They.are loaded from flash to amplifier RAM with each
power-up or amplifier reset. This data is saved to flash only
when a user clicks the appropriate Save to Flash button. It
is flushed from amplifier RAM with each power-down or
amplifier reset.

Amplifier RAM only

Includes operating status data such as actual position,
actual current, and amplifier temperature. Such data is
never stored in flash. It is flushed from amplifier RAM with
each power-down or amplifier reset.

16.2: Disk Storage-of Amplifi

er and Motor Data Files

At any time, the usercan save certain data from amplifier RAM and flash memory to a file

on disk. From the Main screen, the user

can save all user-entered data represented on all

screens - (the-data described as Flash only and Flash and amplifier RAM on p. 142). This
data'is saved’in a Copley Controls amplifier data file with a .ccx filename extension.

From the-Motor/Feedback screen, the user can save all data represented on the
Motor/Feedback screen. This data is saved in a Copley Controls motor data file with a

.ccm filename extension.

A .ccx file can be restored to return the amplifier to a previous state or to copy settings
from one amplifier to another, as described in Copy Amplifier Data (p. 151).

142

Copley Controls Corp.




CME 2 User Guide Data, Firmware, and Logs

16.3:
16.3.1:

16.3.2:

Data Management Tools

Amplifier Data Management Tools
Operations performed using the amplifier data management tools at the top of the Main
screen (shown below) affect amplifier settings, including motor/feedback data. (CVM
Control Program data is not saved by these operations.)

Fila  amplifier Tools Help

Oy e B VEE Bl el o N

Amplifier Data Management Tools

The amplifier data management tools are described below.

Icon Name Description
ﬂ Save amplifier | Saves all data represented on all screens to a disk fileywith a .ccx filename
data to disk extension.
Restores amplifier and motor data from a .ccx file to the PC and amplifier RAM
Restore and flash memory. Note that only certain data‘is saved to flash by this operation
ﬂ amplifier data (the data described as Flash only on p. 142). To assure that all data (including
from disk the data described as Flash and amplifier RAM) is stored in flash, use the Save

amplifier data to flash tool.

Save amplifier | Saves contents of amplifier RAM to amplifier flash memory.
data to flash

amplifier data

ﬂ] Restore Restores contents of amplifier flash‘memory to amplifier RAM.
from flash

To use a data management tool, click-the iconrand respond to prompts.

Motor Data Management T.ools
Operations performed using theodatasmanagement tools at the bottom of the

Motor/Feedback screen (shown below) affect only user-entered data that is represented
on the Motor/Feedback sereen,

Motor/Feedback 5 | ﬂ ﬂ m

Data Management Tools !

4- Calculatel Ok | Cancel |‘

The motor data management tools are described below.

Icon Name Description

Saves only motor/feedback data from the PC to a disk file with a .ccm filename
extension. Amplifier data that is not represented on the Motor/Feedback screen
is not saved in this file, and this operation does not affect any .ccx files.

Save-motor
data’to disk

Restores only motor data from a disk file with a .ccm filename extension to the

Restore motor PC. Amplifier data that is not represented on the Motor/Feedback screen is not

data from disk

affected.

Saves the contents of the Motor/Feedback screen from PC to amplifier flash
Save motor memory. Amplifier data that is not represented on the Motor/Feedback screen is
data to flash not saved. Can be used to assure that all changes are saved to flash without

closing the Motor/Feedback screen.

Restores only motor data from amplifier flash memory to the PC. Amplifier data
Restore motor | that is not represented on the Motor/Feedback screen is not affected. Can be
data from flash | used before closing the Motor/Data screen to restore settings to the previously
saved values.

B aE

To use a data management tool, click the icon and respond to prompts.

Copley Controls Corp. 143



Data, Firmware, and Logs CME 2 User Guide

16.4: Amplifier Firmware

The amplifier’'s flash memory holds the amplifier’s firmware. As needed, perform the
following steps to obtain new firmware and download it to amplifier flash memory.

NOTE: Firmware can only be downloaded to an amplifier via a direct serial port
connection between the amplifier and the PC. CME 2 does not support downloading
firmware to a node amplifier via a multi-drop gateway amplifier.

NOTE: To check the firmware version currently loaded, click the Amplifier Properties
button or choose Help>About.
WARNING: Do not power down or disconnect the amplifier during firmware download.

Download Firmware to the Amplifier

1 On the Main screen choose Tools>Download Firmware to opentheDownload
Firmware window.

Download Firmware x|

@ Do vou want to save your data before
downloading new firmware?

1] | Cancel |

2 To download new firmware without saving-amplifier and motor data, click No
and then proceed to Step 4.

3 To save amplifier and motor data for backup purposes before downloading firmware,
click Yes.

Save Amplifier Data s&\ﬁ[

[v Save Data To Disk
[v Save Data To Flash

Zancel |

= .~Chooselwhether to save to disk, flash, both, or neither.

= Click‘OK to save data and continue to select a firmware image,
oriclick Cancel to continue without saving data.

= If Save Data to Disk was selected, use the Save Amplifier Data to Disk screen to
browse to the folder where you want to save the .ccx file. Then enter a name in the
Name field. Then click Save.
When the Firmware Images window appears, proceed to Step 4.

Continued...
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...Download Firmware to the Amplifier, continued:

4 Use the Firmware Images window to locate and select a firmware image file.

5I
Look in: IE] Firmwarelnage LI I '_5' E

N
File hatne: IAcceInet_4.32.u:ff ..) Open |

A8

Files of type: IFirmware Image Files (*.cff) ﬂ Cancel |

N

5 Click Open to begin the download. A message window displays a series of progress

messages:
riting news firmware image
L 0%

When the message window. closes,.the firmware download is complete.

Data, Firmware, and Logs
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16.5: Error Log

Copley amplifiers track faults and warnings in a log in flash memory.

2

146

View the CME 2 Error Log

Click the Error Log tool on the Main screen.

Click a tab to view a section of the log:

Tab Contents

Active Type and description of each active fault and warning. The contents.of this tab are
automatically refreshed as new events occur.

History Type, description, and time of occurrence of each fault and most warnings since the log
was last cleared. The contents of this tab are not refreshed automatically as new
events occur. The contents are refreshed only when thetabis displayed or when
Refresh is clicked.

Frequency Type, description, and frequency of each fault and’'warning that has occurred since the
log was last cleared. The contents are refreshed only when the tab is displayed or
when Refresh is clicked.

CAN Network | (Under CAN control only.) Status of CAN<bus.*Lists warnings and errors.

To update the contents of the History or Frequency tabs, click Refresh.

Sl

To save the log to a disk file, click¢he Save 4o Disk icon on the log screen.
Then navigate to the appropriatefolder,@nter a File Name for the log, and click Save.

To clear the log if needed,.press Clear Log. (Contents cannot be recovered.)

To close the log screen;, click-Close.
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16.6: Communications Log

The communications log tracks all communications between CME 2 and the amplifier. The log is
maintained in the PC’s RAM. Typically it is used only on request of customer service for
troubleshooting purposes. When required, perform the following steps to manage the tracking and
storage of these messages.

NOTE: Do not leave the Enable Logging control selected for any longer than necessary. Leaving/it
enabled for long periods can affect the PC’s performance.

View the CME 2 Communications Log

1 On the Main screen, choose Tools->»Communications Log to open the‘screen:
=
16:35:33.678 COML Send: Get Latched Evwent 3tatus 00 £6 01 Oc 0C=
16:35:33.741 COM1 Recw: Get Latched Ewvent Status 00 Sa 02 00 3:Z

16:35:33.756 COM1 Z2end: Get Event 3tatus 00 £7 01 Oc 00 a0
16:35:33.756 COM1 Recw: Get Event Status 00 53 02 00 20 00 £0 C
16:35:33.772 COML Send: Get 3ticky Ewvent 3tatus 00 £b 01 Oc 00
16:358:33.772 COM1 Recw: Get 3ticky Event Status 00 85 0Z 00 Z0
16:35:33.772 COML Zend: Get Fault Latch 00 £3 01 Oc 00 ad
16:358:33.772 COM1 Recw: Get Fault Latch 00 58 02 00 00 00 00 Q&
16:38:33.772 COM1 3end: Get CAN network status 00 54 01 Oes0L1°C
16:358:33.772 COM1 Recw: Get CAN network status 00 54 01 0@ @4 C
16:38:353.772 COM1 3end: Get Trajectory Status 00 %e 01 Dc 00 ct
16:358:33.787 COM1 Recw: Get Trajectory Status 00 Sbo01 00 OO0 OC
16:35:33.991 COM1 Zend: Get Latched Event Status 00\Eo 010 Oc)OC
lEI:38:33.991 COM1 Recw: Get Latched Event Status 00 9a 02800 3z«
4 3

[v Enable Logging

[ Enable Event Status Logging

ﬂ Clear | ﬂl

2 Select the logging options described below.

Option

Description

Enable Logging

When selected, logging is enabled and all communications, with the exception
of status messages, are recorded in the log

Enable Event\Status
Logging

When selected, status messages are included in the log.

Filter “Get Variable”
Cmds

When selected, “Get Variable” commands are not added to the log.

3 To clearthe log contents from the PC’s RAM, press Clear.
NOTE: The log is limited to 2000 lines. When it reaches that limit, CME 2 automatically
clears the oldest 1000 lines.

40 ol
To save the log contents from the PC’s RAM to a disk file, click the Save to Disk icon.

When prompted, enter a File name.
Then, click Save to save the log file and close the window.
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CHAPTER

17: VIRTUAL AMPLIFIER

Virtual amplifiers can be used for training and for creating motor data files off line.

A new virtual amplifier can be created based on a virtual amplifier template file (.ccy)-
CME 2 includes a set of .ccv files representing Copley Controls amplifiers. Perform these
steps to create a virtual amplifier:

Start CME 2 (p. 15).

2

File Amplifier Tools Help

A7 & B [V]E

[=}+4 Copley Meighbarhood
fo B Wfirtual Ampli
;

Choose Virtual Amplifier from the Copley Neighborhood tree to open the Open Virtual

Amplifier screen:
x|

Choose the method you want to use to create the
virtual amplifier.

= Create new amplifier file C
" Open existing amplifier file

9
S8 |
Cancel {}.o Help

3 (To open a virtual.amplifier from an existing amplifier file, skip to Step 4 now.)
To create a new virtual amplifier file based on a virtual amplifier template file:

= Select Create new amplifier.

=  When prompted, highlight the virtual amplifier template filename (.ccv) that
representsihe type of virtual amplifier you wish to create.

= _.Click Open to open the file and the Basic Setup screen.

Motor and amplifier values may now be viewed, entered, and adjusted.

4 Alternately, to open an existing amplifier file:

= Select Open existing amplifier file.
=  When prompted, highlight the name of the file you wish to open.
= Click Open.

Motor and amplifier values may now be viewed, entered, and adjusted.
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Virtual Amplifier
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APPENDIX

A:CoPY AMPLIFIER DATA

Perform steps 1-5 to configure an amplifier/motor pair by copying a .ccx file that was
prepared for the amplifier/motor combination.

To load a CVM Program file as well, also perform step 6,
and to load a Cam Table file, also perform step 7.

Make sure the amplifier is connected to the PC using the serial or’CAN connector.

Start CME 2 (p. 15).

3 Use the command appropriate for your starting point:

ﬂ Starting from the Main screen, click Restore amplifier data from disk.

d il
OR M Starting from the Basic'Setupscreen, click Load ccx File.

4 When prompted, navigate to the folder-containing the appropriate .ccx file.
Highlight the file name and then click-Open to load the file data into amplifier RAM.

ﬂ] On the Main screen, click Save to Flash to save the new settings to flash memory.

6 If you do not needto load a CVM Control Program, skip to Step 7.
To load a CVM ContrelProgram, choose File->Restore CVM Control Program.
When prompted; navigate to the folder containing the appropriate .ccp file.
Highlight the filesname and then click Open to load the file data into flash memory.

This_procedure also results in the setting of the Indexer 2 Program option Enable Control
Program _on Startup. This configures the program to auto start when the amplifier is
powered up or reset.

7 - If.you do not need to load a set of Cam Tables, the process is complete.
To load a set of Cam Tables, choose File->Restore Cam Tables.
When prompted, navigate to the folder containing the appropriate .cct file.
Highlight the file name and then click Open to load the file data into flash memory.

TIP: When copying amplifier data to multiple amplifiers in a production environment,
consider locking CME 2 to prevent accidental changes to settings.
See Lock/Unlock CME 2 Controls (p. 153).
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Copy Amplifier Data
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APPENDIX

B: LOCK/UNLOCK CME 2 CONTROLS

Optionally lock CME 2 to prevent changes to amplifier settings.
TIP: Lock CME 2 to prevent accidental changes to settings when copying amplifier-files.

1 On the Main screen choose Tools>CME 2 Lock/Unlock.

2 | Set a new password in the Password and Verify Password fields.

CME 2 LOCK,/UNLOCK x|

Enter password to lock CMWE 2.

Passwiard: Il
“erify Pazsword: I
Ok | Cancel |

3 Click OK to lock out amplifier setting controls:

2N WHEN CME 2 IS LOCKED:
Input/ Dutput $ ®O
—— & S

CWi| Control Frogram User can nOt Change any

| | %‘O ,L{Q\ amplifier or motor settings.
N\ \

EAN Confi i P “&\'I—} MotorFeedback | g
e I_’ - l_’ "’@‘I_’% ’ R User can download amplifier and

_ 0 K < motor files and Cam Tables, jog

\\}‘O &\) the motor, run scope functions

<O and profiles, and monitor

| > \J . | ’

Home ‘\C)( Confl’&qe Fegen Configure Faults amp“fler performanCe W|th the

§ sQ\-e scope and control panel.

< ACME Locked
«O (9N

4 To'unlock;choose Tools=>CME 2 Lock/Unlock.
im x|
| Em@word to unlock CME 2.
:gsword: I

¥ Unlock for this session ohly.

Ok | Cancel |

5 Enter the password. Unlock for this session or until locked again. Click OK.
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APPENDIX

C: I°T TIME LIMIT ALGORITHM

The current loop I°T limit specifies the maximum amount of time that the peak currentcan
be applied to the motor before it must be reduced to the continuous limit or generate.a
fault. This chapter describes the algorithm used to implement the I°T limit.
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C.1: I’T Algorithm

C.1.1: I’T Overview

The I°T current I|m|t algorithm continuously monitors the energy belng delivered to the
motor using the I°T Accumulator Variable. The value stored in the I°T Accumulator
Variable is compared with the I°T setpoint that is calculated from the user-entered Peak
Current Limit, 1°T Time Limit, and Contlnuous Current Limit. Whenever the energy
delivered to the motor exceeds the I°T setpoint, the algorithm protects the motor by
limiting the output current or generates a fault.

C.1.2: I’T Formulas and Algorithm Operation

Calculating the I’T Setpoint Value

The I°T setpoint value has units of Amperes*-seconds (A’S) and is caléulated from
programmed motor data. The setpoint is calculated from the Peak Current Limit, the 1°T
Time Limit, and the Continuous Current Limit as follows:

I°T setpoint =
(Peak Current Limit* — Continuous Current Limit®) *4*T. Time Limit

1T Algorithm Operation

During amplifier operation, the 1°T algorithm periodically updates the I°T Accumulator
Variable at a rate related to the output current Sampling Frequency. The value of the I°T
Accumulator Variable is incrementally increased for output currents greater than the
Continuous Current Limit and is mcrementally decreased for output currents less than the
Continuous Current Limit. The I°T Accumulator Variable is not allowed to have a value
less than zero and is initialized to zero_upon reset or +24 Vdc logic supply power-cycle.

Accumulator Increment Formula
At each update, a new value for the I°T.Accumulator Variable is calculated as follows:

I°T Accumulator Variable .1 =

I°T Accumulator Variable ,

+(Actual Output-Current «1- — Continuous Current Limitz) * Update period
After each sample, the updated value of the I°T Accumulator Variable is compared with
the I°T setpoint. [fthe I*T Accumulator Variable value is greater than the I°T Setpoint
value, then the-amplifien limits the output current to the Continuous Current Limit. When
current limiting is active, the output current will be equal to the Continuous Current Limit if
the commanded current is greater than the Continuous Current Limit. If instead the
commanded current is less than or equal to the Continuous Current Limit, the output
current'will berequal to the commanded current.
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C.1.3: I’T Current Limit Algorithm — Application Example
I*T Example: Parameters

Operation of the I°T current limit algorithm is best understood through an example. For
this example, a motor with the following characteristics is used:

e Peak Current Limit— 12 A
e I°T Time Limit—1S
e Continuous Current Limit — 6 A
From this information, the 1>T setpoint is:
I°T setpoint = (12 A>~6 A%) * 1 S = 108 A’S
See the example plot diagrams on the next page.
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I’T Example: Plot Diagrams

The plots that follow show the response of an amplifier (configured w/ I°T setpoint = 108
AZS) to a given current command. For this example, DC output currents are shown in
order to simplify the waveforms. The algorithm essentially calculates the RMS value of the
output current, and thus operates the same way regardless of the output current
frequency and wave shape.

I’T current limit
16
144 . |_commanded K
_ 12 Trrpmmeeeee 5 I_actual
< 10 - B
5 6
° 4, \
5 \
0 T T
0 1 2 3 4 5 6 7
Time (S)
A)
?T. Accumulator
120
@ 100 - No [/
< 80
5 50 "2T Setpoint
% 20 "2T Accumulator
E 20 -
0 ‘
0 1 2 3 4 5 6 7
Time (S)
B)

At time 0, plot diagram A shows that the actual output current follows the commanded
current. Note that the current is higher than the continuous current limit setting of 6 A.
Under this condition, the I°T Accumulator Variable begins increasing from its initial value
of zero. Initially, the output current linearly increases from 6 A up to 12 A over the course
of 1.2 seconds. During this same period, the I°T Accumulator Variable increases in a non-
linear fashion because of its dependence on the square of the current.

At about 1.6 seconds, the I°T Accumulator Variable reaches a values equal to the I°T
setpoint. At this time, the amplifier limits the output current to the continuous current limit
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even though the commanded current remains at 12 A. The I°T Accumulator Variable value
remains constant during the next 2 seconds since the difference between the actual
output current and the continuous current limit is zero.

At approximately 3.5 seconds, the commanded current falls below the continuous current
limit and once again the output current follows the commanded current. Because the
actual current is less than the continuous current, the I°T Accumulator Variable value
begins to fall incrementally.

The I°T Accumulator Variable value continues to fall until at approximately 5.0 seconds
when the commanded current goes above the continuous current limit again. The actual
output current follows the current command until the I°T Accumulator Variable value
reaches the I°T setpoint and current limiting is invoked.
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I°T Time Limit Algorithm
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APPENDIX

D: VELOCITY LOOP FILTERS

CME 2 supports 2 classes of filters on the Velocity Loop command and output: the Low-
Pass and the Custom Bi-Quad. The Low-Pass filter class includes the Single-Pole and the
Two-Pole Butterworth filter types.

Set Velocity Loop Filter Parameters:

1 + VLo
M Click V Loop to open the Velocity Loop screen.

2 Cotnmand Fitter | | Ot Fitter

| Click Command Filter or Output Filter to open the
Command Filter or Output Filter screen (Output Filter shown below):

velocity Loop Dutput Filter x|

Butterwwarth Lowe Pass Fitter

-3db ~
©
db -40db
Cut Off Frequency: I 200 Hz dacade

<
log
N\
\

R ~
LA\ X il}o
S~ @
*0)
Fiter Type:  [Low-Pass, 2 Pole Butterworth H ‘5\{'0
R

~
Q’I Detault | Close |
LN

3 Adjust the filter settings described below.

=

Filter Description
Class/Type
Low-Pass/ The’single-pole low pass filter is the simplest filter. The value entered in the Cut-off

Single Pole Frequency field provides the -3 db point. The filter will attenuate at -20 db/decade past
the cut-off frequency, reducing excitation of high frequency resonance.

Low-Pass/ The Butterworth filter is a maximally flat low pass filter. This second order two-pole filter
2)Pole has a damping ratio of 0.707 and produces no peaking in the Bode plot. The value
Butterworth entered in the Cut off Frequency field provides the -3 db point. The filter attenuates at
-40 db/decade past the cut off frequency. The phase-lag at lower frequencies is greater
than the phase lag of other second order filters that exhibit more peaking.

Custom The Bi-Quadratic filter has two quadratic terms: one in the numerator, and one in the
Bi-Quad denominator. The numerator affects the filter's two zeros and the denominator affects
the filter's two poles. Many filter classes and types can be expressed in the Bi-Quad
form by entering the coefficients. The coefficients can be calculated using any
commercially available math software package and entered as floating point numbers.
However, due to the fixed-point representation, the numbers may be rounded.
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Velocity Loop Filters
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APPENDIX

E: HOMING METHODS

This appendix describes the homing methods that can be chosen using the CME 2
homing controls described in Homing (p. 121).

Contents include:

Section
E.1: HOMING METhOAS OVEIVIEW ...ttt ettt e e e e e ettt e e e e e e s aaaeeeeeaeaaansbeeeeaeeaeaneeeeee ieannneeeeaeeaannrnneen
E.2: Legend to Homing Method Descriptions...
E.3: Homing Method Descriptions ...................
E.3.1: Set current position as home
E.3.2: Next IndeX.......cccouveeeeeeinnnas
E.3.3: Limit Switch.......ccccceevieen.
E.3.4: Limit SWIitCh OUL 10 INAEX.....ceiiiiiiiiiiiii e e e e e Bttt e e e e e ettt e e e e e e s nnbeeeeaeeeanne
R TR Tl o = o ] (o] o S SRR
E.3.6: Hardstop Out to Index ....
E.3.7: Home Switch..........c..........
E.3.8: Home SWitCh OUt t0 INAEX....cciiiiiiiiiiiie e s et e e e e e e e
E.3.9: HOMeE SWItCh IN 0 INAEX .. .eiiiiiiiiiiei 850 R T ettt et e et e et s
E.3.10: Lower Home
E.3.11: Upper Home
E.3.12: Lower Home Outside Index
E.3.13: Lower Home INSide INAEX.........ociiieiiriiieiiiiieiieeeee Sl e
E.3.14: Upper Home Outside Index
E.3.15: Upper HOME INSIAE INAEX.....cciiiiiiiiiiieeciiiieie st be e eeeeeeecma b eeeeeeessnssaeeeaeesasssssaeaeeassasssseseaeeaaansssseaeesssassssnenaeesnnnnes
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E.1: Homing Methods Overview

There are several homing methods. Each method establishes the:

o Home reference (limit or home switch transition or encoder index pulse)

¢ Direction of motion and, where appropriate, the relationship of the index pulse to limit
or home switches.

E.2: Legend to Homing Method Descriptions

As highlighted in the example below, each homing method diagram shows the starting
position on a mechanical stage. The arrow line indicates direction of motion, and-the
circled H indicates the home position. Solid line stems on the index pulse lingjindicate
index pulse locations. Longer dashed lines overlay these stems as a visualaid. Finally,
the relevant limit switch is represented, showing the active and inactive:zones and
transition.

Mechanical IStage Limits

v o Axis v

[ [

Starting positien 9!

7 <— Direction of motion
Home position

T ( :k—' <— Starting position
Index pulse location —_ T
Index Pulse | I I

Positive Limit
Switch AT
Swi itch inactive T Sw itch active

Sw itch transition

Note that in the homing’method descriptions, negative motion is leftward and positive
motion is rightward.
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E.3: Homing Method Descriptions

E.3.1: Set current position as home
The current position is the home position.

E.3.2: Next Index

Direction of Motion: Positive

Home is the first index pulse found in the positive direction. Direction of motion is positive.
If a positive limit switch is activated before the index pulse, an error is generated.

Index Pulse

Homing Methods

[

@

Direction of Motion: Negative

Home is the first index pulse found in negative direction. Direction of motion is negative. If
a negative limit switch is activated before the index pulse, an error is generated.

Copley Controls Corp.
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CME 2 User Guide
E.3.3: Limit Switch

Direction of Motion: Positive

Home is the transition of the positive limit switch. Initial direction of motion is positive if the
positive limit switch is inactive.

: ]

—@
.ﬁ

Positive Limit
Switch

Direction of Motion: Negative

Home is the transition of negative limit switch. Initial direction of motion is negative if the
negative limit switch is inactive.

A |

Negative Limit |
Switch |
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E.3.4: Limit Switch Out to Index
Direction of Motion: Positive
Home is the first index pulse to the negative side of the positive limit switch transition.

Initial direction of motion is positive if the positive limit switch is inactive (shown here as
low).

Positive Limit
Switch

Index Pulse

Direction of Motion: Negative

Home is the first index pulse to the positive side'of the,negative limit switch transition.

Initial direction of motion is negative if the negative/limit switch is inactive (shown here as
low).

Negative-Limit } @

Switch

Index Pulse |
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E.3.5: Hardstop

168

Direction of Motion: Positive

Home is the positive hard stop. Direction of motion is positive. The hard stop is reached
when the amplifier outputs the homing Current Limit continuously for the amount of time
specified in the Delay Time. If a positive limit switch is activated before the hard stop, an

error is generated.

| -®

Direction of Motion: Negative

Home is the negative hard stop. Direction of motion is negative. The hard stop is reached
when the amplifier outputs the homing Current Limit continuously for'the amount of time
specified in the Delay Time. If a negative limit switch is activated.before the hard stop, an

error is generated.
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E.3.6: Hardstop Out to Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the positive hard stop. Initial direction
of motion is positive. The hard stop is reached when the amplifier outputs the homing
Current Limit continuously for the amount of time specified in the Delay Time. If a positive
limit switch is activated before the hard stop, an error is generated.

[ (il

Index Pulse |

Direction of Motion: Negative

Home is the first index pulse on the positive side of the negative hard stop. Initial direction
of motion is negative. The hard stop is reached when the ‘amplifier outputs the homing
Current Limit continuously for the amount of time specified in the Delay Time. If a
negative limit switch is activated before the hard stop;an error is generated.

= ]
C%g

Index Pulse | |
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E.3.7: Home Switch
Direction of Motion: Positive
Home is the home switch transition. Initial direction of motion is positive if the home switch

is inactive. If a limit switch is activated before the home switch transition, an error is
generated.

Home Switch |

Direction of Motion: Negative

Home is the home switch transition. Initial direction of motion:is\negative if the home

switch is inactive. If a limit switch is activated before the home switch transition, an error is
generated.

Home Switch
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E.3.8: Home Switch Out to Index

Direction of Motion: Positive

Home is the first index pulse to the negative side of the home switch transition. Initial
direction of motion is positive if the home switch is inactive. If a limit switch is activated
before the home switch transition, an error is generated.

| = |

Home Switch |

Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse to the positive side of the home switch transition.
Initial direction of motion is negative if the home switch ‘is inactive. If a limit switch is
activated before the home switch transition, an erroris-generated.

[ — ]

Home Switch

Index Pulse l l
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E.3.9: Home Switch In to Index

172

Direction of Motion: Positive

Home is the first index pulse to the positive side of the home switch transition. Initial
direction of motion is positive if the home switch is inactive. If a limit switch is activated
before the home switch transition, an error is generated.

[ —0——

Home Switch |

Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse to the negative side of the home switch transition. Initial
direction of motion is negative if the home switch is inactive. If a limit switch is activated
before the home switch transition, an error is generated.

[ = ]

Home Switch

Index Pulse |
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E.3.10: Lower Home

Direction of Motion: Positive

Home is the negative edge of a momentary home switch. Initial direction of motion is
positive if the home switch is inactive. Motion will reverse if a positive limit switch is
activated before the home switch; then, if a negative limit switch is activated before the
home switch, an error is generated.

| = / S

Home Switch
Positive Limit
Switch // // |

Direction of Motion: Negative

Home is the negative edge of a momentary homerswitch. Initial direction of motion is
negative. If the initial motion leads away from.the home switch, the axis reverses on
encountering the negative limit switch; then,if a positive limit switch is activated before the
home switch, an error is generated.

[5 = / ]
€ F5—

| o
Home Switch |_/ /_‘

Negative Limit '
Switch _l // //
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E.3.11: Upper Home

Direction of Motion: Positive

Home is the positive edge of a momentary home switch. Initial direction of motion is
positive. If the initial motion leads away from the home switch, the axis reverses on
encountering the positive limit switch; then, if a negative limit switch is activated before the
home switch, an error is generated.

| / H] =3
~®
: Co 01
!_//_?

Home Switch
Positive Limit
Switch // // |

Direction of Motion: Negative

Home is the positive edge of momentary home switchs, Initial direction of motion is
negative if the home switch is inactive. If the initial motion leads away from the home
switch, the axis reverses on encountering the negative limit switch; then, if a positive limit
switch is activated before the home switch, anerror is generated.

S
Home Switch ’_/ /_l

Negative Limit '
Switch _l // //
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E.3.12: Lower Home Outside Index

Direction of Motion: Positive

Home is the first index pulse on the negative side of the negative edge of a momentary
home switch. Initial direction of motion is positive if the home switch is inactive. If the initial
motion leads away from the home switch, the axis reverses on encountering the positive
limit switch; then, if a negative limit switch is activated before the home switch, an error.is
generated.

Home Switch i_/ /_‘

Positive Limit : / |—
Switch E 7/
Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse on the«negative side of the negative edge of a momentary
home switch. Initial direction of motion is negative. If the initial motion leads away from the
home switch, the axis reverses.on‘encountering the negative limit switch; then, if a
negative limit switch is activated before the home switch, an error is generated.

" |

Home Switch E ; Y
Negative Limit : :

I

Index Pulse |
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E.3.13: Lower Home Inside Index

176

Direction of Motion: Positive

Home is the first index pulse on the positive side of the negative edge of a momentary
home switch. Initial direction of motion is positive if the home switch is inactive. If the initial
motion leads away from the home switch, the axis reverses on encountering the positive
limit switch; then, if a negative limit switch is activated before the home switch, an error.is
generated.

Home Switch
Positive Llimit Loy
Switch ' [/
Index Pulse |

Direction of Motion: Negative

Home is the first index pulse on the-positive side of the negative edge of a momentary
home switch. Initial direction of-motioncis negative. If the initial motion leads away from the
home switch, the axis reverseés on encountering the negative limit switch; then, if a
negative limit switch is activated before the home switch, an error is generated.

[ —

. -0
Home Switch ’_'_/ /L|

Negative Limit : !
Switch | a—y

Index Pulse |
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E.3.14: Upper Home Outside Index

Direction of Motion: Positive
Home is the first index pulse on the positive side of the positive edge of a momentary
home switch. Initial direction of motion is positive. If the initial motion leads away from the
home switch, the axis reverses on encountering the positive limit switch; then, if a
negative limit switch is activated before the home switch, an error is generated.

Home Switch

Positive Limit
Switch

Index Pulse

Homing Methods

[

/
] L
A L :]

C o

e

Y [

7/ !

Direction of Motion: Negative
Home is the first index pulse on the‘positive'side of the positive edge of a momentary
home switch. Initial direction of metion is.negative if the home switch is inactive. If the
initial position is right of the home position, the axis reverses on encountering the home

switch.

Home Switch
Negative Limit
Switch

Index Pulse
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E.3.15: Upper Home Inside Index

178

Direction of Motion: Positive

Home is the first index pulse on the negative side of the positive edge of momentary
home switch. Initial direction of motion is positive. If initial motion leads away from the
home switch, the axis reverses on encountering the positive limit switch; then, if a
negative limit switch is activated before the home switch, an error is generated.

[ /A ]

5
- a
Home Switch |7/ /—_|

Positive Llimit Iy |
Switch ] [
Index Pulse | |

Direction of Motion: Negative

Home is the first index pulse on the‘negative,side of the positive edge of a momentary
home switch. Initial direction of motion is.negative if the home switch is inactive. If initial
motion leads away from the home switch, the axis reverses on encountering the negative
limit; then, if a negative limit'switch is activated before the home switch, an error is

G @

Home Switch |7/ !
Negative Limit '

Switch _l //E

VA
Index Pulse | |

Copley Controls Corp.



APPENDIX

F: REGEN RESISTOR CONFIGURATION

Optionally configure a regen resistor. Details follow in the chapter.

Incorrect values may damage amplifier or external regen resistor.

For the regen I°T algorithms to work correctly, the values entered in the following
steps must be correct. Damage to the external regen resistor may result from
incorrect values entered. Damage to the amplifier may result if an incorrect
resistance value is entered.

WARNING

Failure to heed this warning can cause equipment damage.
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Configure a Custom Regen Resistor

1 &l Click Configure Regen to open the Regen Resistor screen.

Regen Resistor 5[

= WTL-RA-O3
i~ KTL-RA-O4

" Custom Resistor  Configure

i

yiew settns | ok | cancel |

2 If configuring a standard Copley Controls regen resistor, select the model number and
click Finish to save the configuration and close the screen. Otherwise, continue.

3 Select Custom Resistor and click Configure to open Custom Regen Configuration:

Custom Regen Configuration

Step 1:

Resistance:

Continuous Eower: I 200 4
| 10000 Wy
Titme at Feak Power: I 1000 hiS

Enter the resistance in Ohms.

The minimum value is: 150
Feal: Fower:

The maximum value is: 3000 0

= Brey | Mest =

@

|\.
9]
i)
£ L ) 3

4 Enter a Resistance within the range descrlbed on the screen. Click Next for Step 2.

Custom Regen Configuration

-

«
Step 2:

.

HEesistances

13

W

%The minimum value is: 200
Fealk Pawer: I i ®

Thaumaximum value is: 42500
Tirre at FeakBower | o C 99 s
N>~
= Prey |
fa

Continuous Power:

‘Enterthe continaus poweer rating in Watts.

Cancel |

X

5 Enteria Continuous Power within the range described. Click Next for Step 3.

.
\ U
‘27’ Step 3:
\ -
B Hes @ I
%tmuous Emyer: I 200 4
" Peak Power: I m

Enter the peak power rating in Watts.
The minimum value is: 200

The maximum value is: 100000
Titme at Feak Povwer:

= Prey I

Mext =

Cancel |

X

Continued...

180
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...Continued:

6 Enter a Peak Power within the range described. Click Next for Step 4.

Custom Regen Configuration 5[

Resistance: |—15 G Step 4:

Continuous Fower: IW yy  Enterthe peak power duration in milliseconds.
Feak Fower: m W The minimum valug is: 50 mS

Titme at Peak Power: I_m s The maximurm value is: 5000 mS

i

= Prey | Mext = Cancel |

7 Click Next for Step 5.
X

Step 5:
HEesistances I 18|
L i
Continunus Power m W Customn regen configuration is complete!
I— Fress Finish to accept the wvalues entered and
Pz Poer 450/ save themn to the amplifier's RAM and flash. =

Tifre st Beak Boyer: I 50|HES, change any of the values press Prev

< Pray | i Finish

9 (
zﬁncel
£ A

8 Review the configuration.

9 Click Finish to save the configuration and close the screen.

Regen Resistor Configuration
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Regen Resistor Configuration
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APPENDIX

G: ASCIl COMMANDS/SERIAL CONTROL

This chapter describes how to configure and operate an amplifier by sending ASCI|I
commands over the serial bus. Contents include:

The Copley ASCI!I Interface (p. 184).
CME 2 ASCII Command Line Interface Tool (p. 184).
Single-Axis Serial Connection (p. 185).

Multi-Drop Serial Connection (p. 185).

COMPATIBILITY: This chapter applies to Accelnet, Xenus, and Stepnet amplifiers only.
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G.1: Copley ASCII Interface

An amplifier's RS-232 serial bus can be used by an external control application (HMI,
PLC, PC, etc.) for setup and direct serial control of the amplifier. The control application
can issue amplifier commands from the set of ASCII format commands that make up the
Copley Controls ASCII Interface.

For more information, see the Copley ASCII Interface Programmer’s Guide.

G.2: CME 2 ASCIl Command Line Interface Tool

As described below, the CME 2 ASCII Command Line Interface tool provides a-simple
way to enter Copley ASCIl commands.

Use the ASCIl Command Line Interface to Enter Commands

1 From the Main screen, choose Tools->ASCIl Command Line to opéen the tool.

RS

Commancd: Il

Response:
! i
Help I Close é\
L ¢

2 Enter an ASCII Command in the Command-field.

3 Press the Enter key to send the command to the amplifier. Observe the Response field.
If a value is returned, it is preceded by the letter “v.” In the following example, the get
command was used to retrieve the amplifier RAM value of variable 0x32 (actual
position). { (%

V =101 x|
OO ©
Commarck Ig erSZl
Responsey 39
N
\ C) 6@ Help: | Clase |
Yl

An error code would be preceded by the letter “e.”
TIB: To view an error definition, hold the mouse pointer over the error number.

For more information, see the Copley ASCII Interface Programmer’s Guide and the
Copley Amplifier Parameter Dictionary.
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ASCII Commands/Serial Control

G.3: Single-Axis Serial Connection

For RS-232 serial bus control of a single axis, set the CAN node address of that axis to
zero (0). Note that if the CAN node address is switched to zero after power-up, the
amplifier must be reset or power cycled to make the new address setting take effect.

Serial

PC, PLC, or HMI COM port
for ASCII Control for

RS-232

vQari ” Copley Amplifier
ER-CK "Serial Cable Kit
9pin D-sub SER-CK "Serial Cable with ASCII CAN
RS-232 :
ADDRESS MUST BE SET
TO ZERO BEFORE

POWER-UP OR RESET-

G.4: Multi-Drop Serial Connection

A serially connected amplifier can be used as a multi-drop gateway.for access to other
amplifiers linked in a series of CAN bus connections. Set the CAN node address of the
serially connected amplifier (gateway) to zero (0). Assign each additional amplifier in the
chain a unique CAN node address value between 1 and-127. For more information on

CAN node address assignment, see CAN Network Configuration (p. 67). Use 120 Ohms
termination on the first and last amplifier.

Serial
PC, PLC, or HMI
for ASCII Control | COM port

TERMINATION MUST BE 120 Ohm
USED ON FIRST AND LAST Terminator
NODE

for RS-232

SER-CK "Serial\Cable Kit" Copley Amplifier

, CAN
9pin D-sub with ASCIIRS-232  ADDR 2ol
0

CAN
ADDR

CAN Network Cable UTP CAT.5E Gigabit Ethernet

@ CAN Port

2

Copley Controls Corp.

ADDRESSES MUST BE 120 Ohm
SET BEFORE POWER-UP Terminator

OR RESET.
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APPENDIX

H: GAIN SCHEDULING

The Gain Scheduling feature allows you to schedule gain adjustments based on changes

to a key parameter. For instance, Pp, Vp, and Vi could be adjusted based on changes to
commanded velocity.

Gain adjustments are specified in a Gain Scheduling Table. Each table row contains a key
parameter value and the corresponding gain settings. The amplifier uses4inear
interpolation to make smooth gain adjustments between the programmed settings.

Gain scheduling involves the basic steps outlined below. Details follew/in the chapter.

Configure Gain Scheduling (p. 188)

Set Up the Gain Scheduling Table(s) (p. 189), observing the Gain Scheduling Table
Guidelines(p. 193)
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H.1: Configure Gain Scheduling

-_—

188

Use this procedure to select basic Gain Scheduling options.

If necessary, Start CME 2 Software (p. 15).

On the Main screen, choose Amplifier->Gain Scheduling.
Eﬁain Scheduling : ;Iglil

File Edit

Key Parameter: IDisabIe Gain Scheduling ;I

[~ Use Absaolute Yalus of Key Parameter
[~ Disable Gain Scheduling Unkil &xis is Referenced
Select Gains
[~ Pasition Loop Pp
[ welodity Loop Yp
[ welocity Loop i

| < =d] <

Choose the Key Parameter:

Key Parameter Description
Disable Gain Scheduling. Disable gainischeduling.
Use Written Parameter. An external controller can write to this parameter using any of several

protocols and corresponding parameter IDs: Copley ASCII Interface or the
Copley Indexer 2 Program (ID 0x128), CANopen and EtherCat (Index
0x2371), DeviceNet (object ID 0x2372), and MACRO |-variable (0x528).
See the Copley ASCII Interface Programmer’s Guide, the Copley Indexer 2
Program User Guide, the Copley CANopen Programmer’s Guide, and the
Copley DeviceNet Programmer’s Guide.

Use Commanded. \elocity. Schedule gain adjustments based on changes to commanded velocity.
Use Actual Velocity. Schedule gain adjustments based on changes to actual velocity.
Use Commanded Position. Schedule gain adjustments based on changes to commanded position.
Use Actual Position, Schedule gain adjustments based on changes to actual position.

Optionally set controls:

Control Description

Use Absolute Value of Key If a velocity or position value is chosen for the Key Parameter and this option
Parameter is set, the Key Parameter is interpreted as an absolute value.

Disable Gain Scheduling When this option is set, the scheduled gain adjustments do not take place
Until Axis is Referenced until the axis is referenced (homed).

Select the gains that you wish to adjust by schedule. The choices are Pp, Vp, and Vi. For
each gain you select, a column will be enabled in the Gain Scheduling Table.

Continue with Set Up the Gain Scheduling Table(s) (p. 189).
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H2: Set Up the Gain Scheduling Table(s)
H.2.1: Create a Gain Scheduling Table

1 If necessary, Start CME 2 Software (p. 15).
2 On the Main screen, choose Amplifier->Gain Scheduling.

3 On the Gain Scheduling screen, open the Table tab:

@Gain Scheduling o ] 1
File Edic
Config Table I
I Key Yalue (0.1 counts/s) I F Loop Pp W Loop Vp Y Loop Wi
e
&
A\u
CYM memnory usage: 0% [:;é | m | %
Vd

EEFEESES

If there is a table stored in amplifier flash, the.screen will show them as in this sample:

SRETE:
Fle Edit ~0O \@
o [TaE8] -2

. N
. A\J KA
p Lmﬁ @gp Yp Y Loop Wi
7 o 10 20 el
1 500000] 2 e 2
O 0&0
RS
&N
CVM memory usage; 1o [:?(_ m
L.\\ % _| _|

O ¥ maalal -

4 'g If there is already a stored in flash:
Optionally Save Settings and Table Data to Disk (p. 191).

m | Then click the Delete tool to delete the gain scheduling table data from
amplifier flash and PC RAM.
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5 &' Click the Create a new gain scheduling table tool. See the prompt:
:@New Table 3 |

Enter Mumber of Lines: I 2
oK | Cancel |

6 Enter the number of lines (the number of gain adjustment specifications).
Click OK.

7 Enter the Key Parameter and gain adjustment values. All values must be integer, and
each Key Parameter value must be greater than the previous as described in Gain
Scheduling Table Guidelines (p. 193). Click in a field to enter or modify a value.
Standard mouse and keyboard editing techniques are available.

8 <cfj| Click Save gain scheduling table and setup to amplifier flash memory before
attempting to run the new table. This saves the Table tab data and all Config tab
settings.

9 Close the screen.
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H.2.2:

6

H.2.3:

1

2

3

Edit Gain Scheduling Table Values

If necessary, Start CME 2 Software (p. 15).
On the Main screen, choose Amplifier> Gain Scheduling.

On the Gain Scheduling screen, open the Table tab:
=102

File  Edit

Config Table I

Key Yalue {counts) F Loop Pp W Loop Vp Y Loop ¥i
10000 10 10 20
450000 40 40 60
100000 30 30 700
200000 100 100011 nnl

[N SRl ]

WM memory usage: 1% &l El
| &l =] <A o |

Edit using standard keyboard and mouse(techniques. Note that if you begin typing
immediately, the digits you enter will b€’inserted,in front of any existing digits.

All values must be integer, and each Key-Parameter value must be greater than the
previous as described in Gain Scheduling Table Guidelines (p. 193).

ﬂ' Click Save gain scheduling table and setup to amplifier flash memory
before attempting toaun the new table. This saves the Table tab data and all
Config tab_settings:

Close the screen.

Save and-Restore Gain Scheduling Tables and Settings

The Config tabsettings and Table tab data can be saved to a Copley Controls gains file
(filename extension .ccg) on disk. A .ccg file can be restored and then saved to flash.

Save Settings and Table Data to Disk

ﬂ On the Gain Scheduling screen, click the Save gain scheduling table and
setup to disk tool to open the Save Table to Disk screen. Enter a name for the
file, and click Save. Config tab settings and Table tab data are saved to the file.

= | | Click Save gain scheduling table and setup to amplifier flash memory
before attempting to run the new table. This saves the Table tab data and all
Config tab settings to amplifier flash.

Close the screen.
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Restore Settings and Table Data from Disk

1 Set Up the Gain Scheduling Table(s) (p. 189) or
Edit Gain Scheduling Table Values (p. 191).
Observe the Gain Scheduling Table Guidelines (p. 193).

2 On the Gain Scheduling screen, click the Restore gain scheduling table and
setup from disk tool to open the Restore Gain Scheduling Table from Disk
screen. Highlight the name of the file containing the settings and data you;wish
to restore, and click Open. The settings and data are restored to the Config and
Table tabs.

3 ﬂ' Click Save gain scheduling table and setup to amplifier flash memory
before attempting to run the new table with the new settings’ This saves all
Config tab settings and Table tab data to amplifier flash.

4 Close the screen.
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H.3: Gain Scheduling Table Guidelines

A Gain Scheduling Table contains a progression of Key Parameter values and
corresponding gain adjustment values.

H.3.1: Gain Schedule Table Storage Limits

The maximum number of lines (gain adjustment specifications) that can be stored in the
Gain Scheduling Table is 1000. A typical Gain Schedule Table will contain far fewer lines.

The number of Gain Scheduling Table lines is limited by the amount of CVM memory.
space available in the amplifier. A Gain Scheduling Table loaded into the amplifier.shares
that space with Copley Virtual Machine (CVM) programs and Camming Tables.Fherefore,
the maximum number of Gain Schedule Table lines will decrease if CVM programs or
Camming Tables are stored in the amplifier.

The Gain Scheduling screen Tables tab displays the percentage of amplifier memory
used:

VM memory usage: 1% [25

H.3.2: Gain Schedule Data Rules

e All must be whole numbers (no fractional values).
o All Key Values must be increasing.
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